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Chapter 1: Installation and Configuration 1
 Chapter 1:
 Installation and Configuration
 Files and DirectoriesFile Naming ConventionsThe following file naming conventions have been adopted for the various files dis-tributed with and used by Dyalog APL/W.
 Extension Description
 .DWS Dyalog APL Workspace
 .DSE Dyalog APL Session
 .DCF1 Dyalog APL Component File
 .DXV Dyalog APL External Variable
 .DIN Dyalog APL Input Table
 .DOT Dyalog APL Output Table
 .DFT Dyalog APL Format File
 .DXF Dyalog APL Transfer File
 .DLF Dyalog APL Session Log File
 .dyalog Dyalog APL SALT file
 .dyapp Dyalog APL SALT application file
 1Note that DCF has become associated with a certain type of media file and is recognised as suchby Windows.
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Chapter 1: Installation and Configuration 2
 Unicode and Classic EditionsDyalog APL continues to be available in two separate editions; Unicode andClassic.
 l The Unicode edition is intended for users who need to develop Unicodeapplications now, and are prepared to make the necessary (usually small)changes to existing applications in order to support new Unicode charactertypes.
 l The Classic edition is intended for customers who want to take advantageof other product enhancements, but do not wish to use Unicode at this time.
 The two different editions are maintained from the same source code, and every effortwill be made to ensure that they are identical except for the handling of characterarrays, and the transfer of data into and out of the workspace.
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Chapter 1: Installation and Configuration 3
 APL FontsUnicode EditionThe default font for the Unicode Edition is APL385 Unicode1 which is a TrueTypefont and is installed as part of Dyalog APL. APL385 Unicode is the font used to printAPL characters in this manual. In principle, you may use any other Unicode font thatincludes the APL symbols, such as Arial Unicode MS (available fromMicrosoft).
 Classic EditionIn the Classic Edition, there are two types of APL font provided; bitmap (screen) andTrueType. There are also two different layouts, which referred to as Std and Alt.
 The bitmap fonts are designed for the screen alone and are named Dyalog Std andDyalog Alt. The TrueType fonts have a traditional 2741-style italic appearance andare named Dyalog Std TT and Dyalog Alt TT1.
 The Std layout, which was the standard layout for Versions of Dyalog APL up to Ver-sion 10.1 contains the APL underscored alphabet Ⓐ-Ⓩ. The underscored alphabet isa deprecated feature and is only supported in this Version of Dyalog APL for back-wards compatibility.
 The Alt layout, which replaced the Std layout as the standard layout for Version 12.0Classic Edition onwards, does not have the underscored alphabet, but contains addi-tional National Language characters in their place. Note that the extra National Lan-guage symbols share the same ⎕AV positions with the underscored alphabet. If, forexample, you switch from the Std font layout to the alternative one, you will see thesymbol Á (A-acute) instead of the symbol Ⓐ (A-underscore).
 You may use either a bitmap font or a TrueType font in your APL session (see "Ses-sion Operations " on page 124 for details). You MUST use a TrueType font for print-ing APL functions.
 1The Dyalog Std TT, Dyalog Alt TT, and APL385 Unicode fonts are the copyright ofAdrian Smith.
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Chapter 1: Installation and Configuration 4
 InteroperabilityIntroductionWorkspaces and component files are stored on disk in a binary format (illegible totext editors). This format differs between machine architectures and among versionsof Dyalog. For example a file component written by a PC may well have an internalformat that is different from one written by a UNIX machine. Similarly, a workspacesaved fromDyalog Version 13.2 will differ internally from one saved by a previousversion of Dyalog APL.
 It is convenient for versions of Dyalog APL running on different platforms to be ableto interoperate by sharing workspaces and component files. FromVersion 11.0, com-ponent files and workspaces can generally be shared between Dyalog interpreters run-ning on different platforms. However, this is not always possible, for example:
 l Component files created by Version 10.1 can often not be shared across plat-forms, even when used by later versions.
 l Small-span (32-bit) component files become read-only when opened on adifferent architecture from that on which they were created.
 Note however that the system function ⎕FCOPY can be used to make a logically iden-tical copy of an old file, which is fully inter-operable. 
 The following sections describe other limitations in inter-operability:
 CodeCode which is saved in workspaces, or embedded within ⎕ORs stored in componentfiles, can generally only be read by the version which saved them and later versionsof the interpreter. In the case of workspaces, a load (or copy) into an older versionwould fail with the message:
 this WS requires a later version of the interpreter.
 Every time a ⎕OR object is read by a Version later than that which created it, timemay be spent in converting the internal representation into the latest form. Dyalogrecommends that ⎕OR should not be used as a mechanism for sharing code or objectsbetween different versions of APL
 "Ordinary" ArraysWith the exception of the Unicode restrictions described in the following par-agraphs, Dyalog APL provides inter-operability for arrays which only contain(nested) character and numeric data. Such arrays can be stored in component files - ortransmitted using TCPSocket objects and Conga connections, and shared betweenall versions and across all platforms.
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Chapter 1: Installation and Configuration 5
 As mentioned in the introduction, full cross-platform interoperability of componentfiles is only available for large-span component files (see the following section), andfor small-span component files created by Version 11.0 or later.
 32 vs. 64-bit Component FilesLarge-span (64-bit-addressing) component files are inaccessible to versions of theinterpreter that pre-dated their introduction (versions earlier than 10.1).
 The second item in the right argument of ⎕FCREATE determines the addressing typeof the file.
 'small'⎕fcreate 1 32 ⍝ create small-span file.'large'⎕fcreate 1 64 ⍝ create large-span file.
 If the second item is missing, the file type defaults to 64-bit-addressing. In versionsprior to 12.0, the default was 32-bit-addressing.
 Note that small-span (32-bit-addressing) component files cannot contain Unicodedata. Unicode editions of Dyalog APL can only write character data which would bereadable by a Classic edition (consisting of elements of ⎕AV).
 External VariablesExternal variables are implemented as small-span (32-bit-addressing) componentfiles, and subject to the same restrictions as these files. External variables are unlikelyto be developed further; Dyalog recommends that applications which use themshould switch to using mapped files or traditional component files. Please contactDyalog if you need further advice on this topic.
 32 vs. 64-bit InterpretersFromDyalog APL Version 11.0 onwards, there are two separate versions of programsfor 32-bit and 64-bit machine architectures (the 32-bit versions will also run on 64-bit machines running 64-bit operating systems). There is complete inter-operabilitybetween 32- and 64-bit interpreters, except that 32-bit interpreters are unable to workwith arrays or workspaces greater than 2GB in size.
 Unicode vs. Classic EditionsFromVersion 12.0 onwards, a Unicode edition is available, which is able to workwith the entire Unicode character set. Classic editions (a term which includes ver-sions prior to 12.0) are limited to the 256 characters defined in the atomic vector,⎕AV). 
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Chapter 1: Installation and Configuration 6
 Component files have a Unicode property. When this is enabled, all characters willbe written as Unicode data to the file. The Unicode property is always off for small-span (32-bit addressing) files, which may not contain Unicode data. For large-span(64-bit addressing) component files, the Unicode property is set on by Unicode Edi-tions and off by Classic Editions, by default. The Unicode property can subsequentlybe toggled on and off using ⎕FPROPS.
 When a Unicode edition writes to a component file which may not contain Unicodedata, character data is mapped using ⎕AVU, and can therefore be read without prob-lems by Classic editions.
 A TRANSLATION ERROR will occur if a Unicode edition writes to a non-Unicodecomponent (that is either a 32-bit file, or a 64-bit file when the Unicode property iscurrently off) if the data being written contains characters which are not in ⎕AVU. 
 Likewise, a Classic edition (Version 12.0 or later) will issue a TRANSLATIONERROR if it attempts to read a component containing Unicode data not in ⎕AVU froma component file. Version 11.0 cannot read components containing Unicode dataand issues a NONCE ERROR.
 A TRANSLATION ERROR will also be issued when a Classic edition )LOADs or )COPYs a workspace containing Unicode data which cannot be mapped to ⎕AV usingthe ⎕AVU in the recipient workspace.
 TCPSocket objects have an APL property which corresponds to the Unicode prop-erty of a file, if this is set to Classic (the default) the data in the socket will berestricted to ⎕AV, if Unicode it will contain Unicode character data. As a result,TRANSLATION ERRORs can occur on transmission or reception in the same way aswhen updating or reading a file component.
 AVU changesThe implementation of the function Right in Version 13.0 led to the discovery that⎕AVU incorrectly defined ⎕AV[59+⎕IO] as ¤ (⎕UCS 164) rather than ⊢ (RightTack, ⎕UCS 8866). This error has been corrected in the default ⎕AVU and in work-space AVU.dws. If you are operating in a mixed Unicode/Classic environment, thiserror will have caused earlier Classic editions to map ⎕AV[59+⎕IO] to the wrongUnicode character (¤). This may cause TRANSLATION ERRORs when a Version13.0 Classic system attempts to read the data, as it will not be able to represent ¤ inthe Atomic Vector.
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Chapter 1: Installation and Configuration 7
 DECFs and Complex numbersVersion 13.0 introduced two new data types; DECFs and Complex numbers.Attempts to read components of these types in earlier interpreters will result in aDOMAIN ERROR.
 Very large array componentsThe maximum size (in bytes) of a component written by Version 12.1 and prior is2GB. This is the size of the component as held on disk which may be different thanthe size reported by ⎕SIZE. In Version 13.0 the maximum size of a componentwritten by a 64-bit interpreter is 4GB. FromVersion 13.2 onwards, the limit on thesize of arrays or components is so large that for most practical purposes, there is effec-tively no limit.
 An attempt to read a component greater than 2GB in 32-bit interpreters will result ina WS FULL. An attempt to read such a component in 64-bit Versions 12.0 and 12.1patched after 1st April 2011 will result in a NONCE ERROR; earlier patches generatea FILE COMPONENT DAMAGED error.
 File JournalingVersion 12.0 introduced File Journaling (level 1), and 12.1 added journaling levels 2and 3 and checksumming. Versions earlier than 12.0 cannot tie files which have anyform of journaling or checksumming enabled. Version 12.0 cannot tie files with jour-naling levels greater than 1, or checksumming enabled. Attempting to tie such fileswill result in a FILE NAME ERROR. Files can be shared with earlier versions byusing ⎕FPROPS to amend the journaling and checksumming levels.
 TCPSocketsTCPSockets used to communicate between differing versions of Dyalog APL are sub-ject to similar limitations to those described above for component files. In particularTCPSockets with 'Style' 'APL' will only be able to pass arrays that are sup-ported by both versions.
 Auxiliary ProcessorsA Dyalog APL process is restricted to starting an AP of exactly the same architecture.In other words, the APmust share the same word-width and byte-ordering as its inter-preter process.
 Session FilesSession (.dse) files may only be used on the platform on which they were created andsaved.
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Chapter 1: Installation and Configuration 8
 The APL Command LineThe command line for Dyalog APL is as follows:
 dyalog [ options ] [ debug ] [ file ] [param] [param] [param]...
 where:
 [options]
 -x No ⎕LX execution on workspace loads.-a Start in USER mode.-b Suppress the banner in the Session..-Fxx Default to creating xx-bit files (where xx is 32 or 64).
 -s Disable the Session. This option is ignored in Windowsversions.
 -q Don't quit APL on error (used when piping input intoAPL).
 -c Signifies a command-line comment. All characters to theright are ignored.
 [debug]
 -Dc Check workspace integrity after every callback function.-Dw Check workspace integrity on return to session input.
 -DW Check workspace integrity after every line of APL(application will run slowly as a result)
 -DK Log session keystrokes in (binary) file APLLOG.
 [file]
 The name of a Dyalog APL workspace to be loaded. Unlessspecified, the file extension .DWS is assumed.
 [param]
 A parameter name followed by an equals sign (=) and a value.Note that the parameter name may be one of the standard APLparameters described below, or a name and value of your ownchoosing (see Object Reference, GetEnvironment method).
 Examples:c:\program files\…\dyalog.exe myapp maxws=64000
 c:\program files\…\dyalog.exe session_file=special.dse
 c:\program files\…\dyalog.exe myapp aplt=mytrans.dot myparam=42
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Chapter 1: Installation and Configuration 9
 APL Exit CodesWhen APL or a bound .EXE terminates, it returns an exit code to the calling envi-ronment. If APL is started from a desktop icon, the return code is ignored. However, ifAPL is started from a script (UNIX) or a command processor, the exit code is avail-able and may be used to determine whether or not to continue with other processingtasks. The return codes are:
 0 successful ⎕OFF, )OFF, )CONTINUE, graphical exit from GUI
 1APL failed tostart. This will occur if there was a failure to read atranslate file, there is insufficient memory, or a critical parameter isincorrectly specified or missing.
 2 APL was terminated by SIGHUP or SIGTERM (UNIX) or in responseto a QUIT WINDOWS request. APL has done a clean exit.
 3 APL issued a syserror.
 4Runtime violation. This occurs if a runtime application attempts toread input from the Session. Only a development version has aSession.
 Notes:
 Under UNIX exit codes greater than 127 indicates (127+signal number) of theuntrapped signal which caused the process to terminate.
 APL applications can generate a custom return code by specifying an integer value tothe right of ⎕OFF. Dyalog recommends using values greater than 10 for this purpose.
 Configuration ParametersIntroductionDyalog APL/W is customised using a set of configuration parameters which aredefined in a registry folder.
 In addition, parameters may be specified as environment variables or may be spec-ified on the APL command line.
 Furthermore, you are not limited to the set of parameters employed by APL itself asyou may add parameters of your own choosing.
 Although for clarity parameter names are given here in mixed case, they are case-inde-pendent underWindows. Under Unix and Linux, Dyalog parameters must be spec-ified as environment variables and must be named entirely in upper-case.
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Chapter 1: Installation and Configuration 10
 Setting Parameter ValuesYou can change the parameters in 4 ways:
 l Using the Configuration dialog box that is obtained by selecting Configurefrom the Options menu on the Dyalog APL/W session. See "The Con-figuration Dialog Box" on page 127 for details.
 l By directly editing the Windows Registry using REGEDIT.EXE orREGEDIT32.EXE.
 l By defining the parameters as environment variables.l By defining the parameters on the APL command line.
 This scheme provides a great deal of flexibility, and a system whereby you can over-ride one setting with another. For example, you can define your normal workspacesize (maxws) in your .INI file or Registry, but override it with a new value specifiedon the APL command line. The way this is done is described in the following sec-tion.
 How APL Obtains Parameter ValuesWhen Dyalog APL/W requires the value of a parameter, it uses the following rules.
 1. If the parameter is defined on the APL command line, this value is used.2. Otherwise, APL looks for an environment variable of the same name and
 uses this value.3. Otherwise, if the parameter in question is inifile, the default value of
 Software\Dyalog\Dyalog APL/W 13.0 Unicode (Unicode Edi-tion) or Software\Dyalog\Dyalog APL/W 13.0 Classic (ClassicEdition) is assumed.
 4. Otherwise, if the parameter in question is dyalog, the name of the directoryfrom which the Dyalog APL program was loaded is assumed.
 5. The value of any other parameter is obtained from the registry folder definedby the value of inifile.
 Note that the value of a parameter obtained by the GetEnvironment method (seeObject Reference) uses exactly the same set of rules.
 The following section details those parameters that are implemented by RegistryValues in the top-level folder identified by inifile. Values that are implemented insub-folders are mainly internal and are not described in detail here. However, anyValue that is maintained via a configuration dialog box will be named anddescribed  in the documentation  for that dialog box in Chapter 2.
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Chapter 1: Installation and Configuration 11
 APL_CODE_E_MAGNITUDEVersion 13.0 introduced decimal floating point numbers which have greater pre-cision than IEEE floating point numbers. This increased the maximum allowableprint precision from 17 to 34 and this had the side effect of changing the waynumbers in function bodies are descanned1. For example, the number one sextillion(1021) in a function is descanned by Version 12.1 as 1E21 and by Version 13.0 as1000000000000000000000.
 Note that only numbers X in the range (10*17) ≤ X <(10*34) are affected.
 Whilst this change has no other deleterious effect, it means that code that containssuch numbers is harder to read, and the result of ⎕CR (and other character rep-resentations) of the same function may have changed between Version 12.1 and Ver-sion 13.0 causing undesired affects in code management systems.
 The APL_CODE_E_MAGNITUDE parameter allows the user to choose betweencurrent (Version 13.0 and onwards) and earlier behaviour.
 If the APL_CODE_E_MAGNITUDE parameter is undefined or set to 0 (thedefault), numbers are descanned and displayed as normal.
 IfAPL_CODE_E_MAGNITUDE is ¯1, numbers greater than or equal to 1017 willbe displayed using exponential format, as in Version 12.1.
 The effect of setting this parameter to any other value is undefined.
 1Descanning refers to the internal process used to convert the internal representation of APL codeinto a character array. For numbers in function statements, this process uses the maximum value ofPrint Precision.

Page 16
                        

Chapter 1: Installation and Configuration 12
 APL_COMPLEX_AS_V12Support for Complex Numbers means that some functions produce different resultsfrom previous Versions of Dyalog APL. IfAPL_COMPLEX_AS_V12 is set to 1 thebehaviour of code developed using Version 12.1 or earlier will be unchanged; in par-ticular:
 l Power (*) and logarithm (⍟) do not produce Complex Numbers as resultsfrom non-complex arguments.
 l ⎕VFI will not honour "J" or "j" as part of a number.l ¯4○Y will be evaluated as (̄1+Y*2)*0.5, which is positive for negative
 real arguments.
 IfAPL_COMPLEX_AS_V12 is set to any other value or is not set at all then codedeveloped using version 12.1 or earlier may now generate Complex Numbers.
 Note that this feature is provided to simplify the transition of older code to Version13.0. It does not prevent the generation and use of Complex Numbers using featuresnew to 13.0 (such as explicitly specifying a Complex Number literal), and it will beremoved in a future release of Dyalog APL.
 APL_FCREATE_PROPS_CThis parameter specifies the default chksum level for newly-created component files.If unspecified, the default checksum level is 1.
 APL_FCREATE_PROPS_JThis parameter specifies the default journaling level for newly-created componentfiles. If unspecified, the default journaling level is 1.
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Chapter 1: Installation and Configuration 13
 APL_FAST_FCHKThis parameter specifies whether Dyalog APL should optimise ⎕FCHK by allowing itto reliably determine whether a component file had been properly untied and there-fore does not need to be checked (this is overridable using the ⎕FCHK option 'force').
 Optimising ⎕FCHK in this way has a performance impact on ⎕FUNTIE and it is rec-ommended this optimisation is switched off if your application frequently ties andunties files. 
 Note: this only affects component files with journaling enabled. 
 The values of the parameter are:
 0 Do not optimise ⎕FCHK (optimise ⎕FUNTIE instead)
 1 Optimise ⎕FCHK
 The default values of the parameter reflect the existing behaviour in Version 12.1: 0on Windows and 1 on Linux / AIX. On Windows, setting the value 1 has no effect.
 APL_EXTERN_DECFBy default, arrays of type DECF (128-bit decimal) will be passed unchanged to Aux-iliary Processors, and to DLLs using A or Z argument types. However, ifAPL_EXTERN_DECF is set to 0, DECF arrays will be converted to DOUBLE beforethey are passed to AP's and DLL's. This will allow user-written Auxiliary Processorsand DLLs to continue to work at least temporarily while users determine how tochange their code to cater for the new data type. This parameter will not be supportedbeyond Version 13.0.
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Chapter 1: Installation and Configuration 14
 AplCoreNameThis parameter may be a string or a Boolean value. If it is a string, it specifies thedirectory and name of the file in which the aplcore should be saved. The optionalwild-card character (*) is replaced by a unique string when the file is written. Forexample:
 APLCORENAME=C:\mycores\aplcore*.dat
 IfAplCoreName is set to Boolean 0, the generation of an aplcore file is suppressedand the application simply terminates with an exit code of 3.
 aplk (Classic Edition Only)This parameter specifies the name of your Input Translate Table, which defines yourkeyboard layout. The keyboard combo in the Configure dialog box displays all thefiles with the .DIN extension in the APLKEYS sub-directory. You may choose anyone of the supplied tables, and you may add your own to the directory. Note that theFILE.DIN table is intended for input from file, and should not normally be chosen asa keyboard table. Classic Edition only
 aplkeys (Classic Edition Only)This parameter specifies a search path for the Input Translate Table and is useful forconfiguring a run-time application. It consists of a string of directories separated bythe semicolon (;) character. Its default value is the APLKEYS sub-directory of thedirectory in which Dyalog APL/W is installed (defined by dyalog)
 aplnidUnderWindows, this parameter specifies the user number that is used by the com-ponent file system to control file sharing and security. If you wish to share com-ponent files and/or external variables in a network it is essential that each user has aunique aplnid parameter. It may be any integer in the range 0 to 65535. Note that anaplnid value of 0 causes the user to bypass APL’s access control matrix mechanism.
 Under UNIX, the user number is obtained from the Operating System (UID) andaplnid is not used. If the user is "root", APL's access control mechanism is ignored.
 When a user creates a component file, his user number is recorded in the file to iden-tify him as its owner.
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Chapter 1: Installation and Configuration 15
 apltThis parameter specifies the name of the Output Translate Table. The default isWIN.DOT and there is rarely a need to alter it.
 apltransThis parameter specifies a search path for the Output Translate Table and is useful forconfiguring a run-time application. It consists of a string of directories separated bythe semicolon (;) character. Its default value is the sub-directory APLTRANS in thedirectory in which Dyalog APL/W is installed.
 auto_pwThis parameter specifies whether or not the value of ⎕PW is derived automaticallyfrom the current width of the Session Window. If auto_pw is 1, the value of ⎕PWchanges whenever the Session Window is resized and reflects the number of char-acters that can be displayed on a single line. If auto_pw is 0 (the default) ⎕PW is inde-pendent of the Session Window size.
 AutoFormatThis parameter specifies whether or not you want automatic formatting of ControlStructures in functions. The default value is 1 which means that formatting is doneautomatically for you when a function is opened for editing or converted to text by⎕CR, ⎕NR and ⎕VR. Automatic formatting first discards all leading spaces in the func-tion body. It then prefixes all lines with a single space except those beginning with alabel or a comment symbol (this has the effect of making labels and comments standout). The third step is to indent Control Structures. The size of the indent dependsupon the TabStops parameter. To turn off automatic formatting, set AutoFormat to0.
 AutoIndentThis parameter specifies whether or not you want semi-automatic indenting duringediting. The default value is 1. This means that when you enter a new line in a func-tion, it is automatically indented by the same amount as the previous line. Thisoption simplifies the entry of indented Control Structures.
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Chapter 1: Installation and Configuration 16
 ClassicModeThis parameter specifies whether or not the Session operates in Dyalog Classic mode.The default is 0. If this parameter is set to 1, the Editor and Tracer behave in a mannerthat is consistent with previous versions of Dyalog APL.
 CMD_PREFIX and CMD_POSTFIXThese parameters defines strings within which operating system commands specifiedas the arguments to ⎕CMD and ⎕SH, and )CMD and )SH, are wrapped. Its purpose isto run the command arguments under a non-standard command shell.
 See Language Reference for implementation details.
 confirm_abortThis parameter specifies whether or not you will be prompted for confirmation whenyou attempt to abort an edit session after making changes to the object being edited.Its value is either 1 (confirmation is required) or 0. The default is 0.
 confirm_closeThis parameter specifies whether or not you will be prompted for confirmation whenyou close an edit window after making changes to the object being edited. Its valueis either 1 (confirmation is required) or 0. The default is 0.
 confirm_fixThis parameter specifies whether or not you will be prompted for confirmation whenyou attempt to fix an object in the workspace after making changes in the editor. Itsvalue is either 1 (confirmation is required) or 0. The default is 0.
 confirm_session_deleteThis parameter specifies whether or not you will be prompted for confirmation whenyou attempt to delete lines from the Session Log. Its value is either 1 (confirmation isrequired) or 0. The default is 1.
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Chapter 1: Installation and Configuration 17
 CreateAplCoreOnSyserrorThis parameter specifies whether or not an aplcore file is generated when APL exitswith a system error.
 default_divThis parameter specifies the value of ⎕DIV in a clear workspace. Its default value is0.
 DefaultHelpCollectionIfUseDefaultHelpCollection is 1, Dyalog attempts to use the Microsoft DocumentExplorer and online help, for example fromVisual Studio (if installed), to displayhelp for external objects, such as .Net Types. In most cases the default settings of "ms-help://ms.mscc.v80" will be sufficient. On some configurations it may be necessaryto change this. See " UseDefaultHelpCollection" on page 28
 default_ioThis parameter specifies the value of ⎕IO in a clear workspace. Its default value is 1.
 default_mlThis parameter specifies the value of ⎕ML in a clear workspace. Its default value is 0.
 default_ppThis parameter specifies the value of ⎕PP in a clear workspace. Its default value is 10.
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 default_pwThis parameter specifies the value of ⎕PW in a clear workspace. Its default value is 76.Note that ⎕PW is a property of the Session and the value of default_pw is overriddenwhen a Session file is loaded.
 default_rlThis parameter specifies the value of ⎕RL in a clear workspace. It must be a scalar andits default value is 16807.
 default_rtlThis parameter specifies the value of ⎕RTL in a clear workspace. Its default value is0.
 default_wxThis parameter specifies the value of ⎕WX in a clear workspace. This in turn deter-mines whether or not the names of properties, methods and events of GUI objects areexposed. If set (⎕WX is 1), you may query/set properties and invoke methods directlyas if they were variables and functions respectively. As a consequence, these namesmay not be used for global variables in GUI objects.
 DMXOUTPUTONERRORThis parameter specifies in which windows DMX error messages are displayed. It isan integer whose value is the sum of the sspecified windows where 1 = Status Win-dow and 2 = Session Window.
 DockableEditWindowsThis parameter specifies whether or not individual edit windows can be undockedfrom (and docked back into) the (MDI) Editor window. Its default value is 0. Thisparameter does not apply ifClassicMode is set to 1.
 DoubleClickEditThis parameter specifies whether or not double-clicking over a name invokes theeditor. Its default is 1. If DoubleClickEdit is set to 0, double-clicking selects a wordand triple-clicking selects the entire line.
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 dyalogThis parameter specifies the name of the directory in which Dyalog APL/W isinstalled.
 DyalogEmailAddressThis parameter specifies the contact email address for Dyalog Limited.
 DyalogHelpDirThis parameter specifies the full pathname of the directory that contains the DyalogAPL help file (dyalog.chm).
 DyalogInstallDirThis parameter specifies the full pathname of the directory in which Dyalog APL isinstalled.
 DyalogWebSiteThis parameter specifies the URL for the Dyalog web site.
 edit_cols, edit_rowsThese parameters specify the initial size of an edit window in character units.
 edit_first_x, edit_first_yThese parameters specify the initial position on the screen of the first edit window incharacter units. Subsequent edit windows will be staggered. These parameters onlyapply ifClassicMode is 1.
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 edit_offset_x, edit_offset_yThese parameters specify the amount by which an edit window is staggered from theprevious one.
 ErrorOnExternalExceptionThis is a Boolean parameter that specifies the behaviour when a System Exceptionoccurs in an external DLL. If this parameter is set to 1, and an exception occurs in acall on an external DLL. APL generates an EXTERNAL DLL EXCEPTION error(91), instead of terminating with a System Error. This error may be trapped.
 EditorStateThis is an internal parameter that remembers the state of the last edit window (normalor maximised). This is used to create the next edit window in the appropriate state.
 greet_bitmapThis parameter specifies the filename of a bitmap to be displayed during initialisationof the Dyalog APL application. It is used typically to display a product logo from aruntime application. The bitmap will remain until either an error occurs, or it isremoved using the GreetBitmap method of the Root object.
 greet_bitmap=c:\myapp\logo.bmp
 history_sizeThis parameter specifies the size of the buffer in Kb used to store previously entered(input) lines in the Session.
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 inifileThis parameter specifies the name of the Windows Registry folder that contains theconfiguration parameters described in this section. For example,
 INIFILE=Software\Dyalog\mysettings
 If the parameter is not defined, inifile defaults to the current directory.
 InitialKeyboardLayout (Unicode Edition Only)This parameter specifies the name of the keyboard to be selected on startup. Whenyou start an APL session, this layout will automatically be selected as the current key-board layout if the value of InitialKeyboardLayoutInUse is 1.
 InitialKeyboardLayoutInUse (Unicode Edition Only)This Boolean parameter specifies whether or not the keyboard specified by Initial-KeyboardLayout is selected as the current keyboard layout when you start an APLsession.
 InitialKeyboardLayoutShowAll (Unicode Edition Only)This Boolean parameter specifies whether or not all installed keyboards are listed inthe choice of keyboards in the Configuration dialog box (Unicode Input tab) .
 input_sizeThis parameter specifies the size of the buffer in Kb used to store marked lines (linesawaiting execution) in the Session.
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 KeyboardInputDelayThis parameter specifies the delay (in milliseconds) before the system reacts to a userkeystroke by:
 l updating the name of the Current Object in the Session statusbar. See "TheCurrent Object" on page 65
 l offering a list of names for auto-completion. See "Auto Complete Tab" onpage 149
 lines_on_functionsThis parameter specifies whether or not line numbers are displayed in edit and tracewindows. It is either 0 (the default) or 1.
 Note that this parameter determines your overall preference for line numbering, andthis setting persists between APL sessions. You can however still toggle line num-bering on and off dynamically as required by clicking Line Numbers in the Optionsmenu on the Session Window. These temporary settings are not saved between APLsessions
 localdyalogdirThis parameter specifies the name of the directory in which Dyalog APL/W isinstalled on the client, in a client/server installation
 log_fileThis parameter specifies the full pathname of the Session log file.
 log_file_inuseThis parameter specifies whether or not the Session log is saved in a session log file.
 log_sizeThis parameter specifies the size of the Session log buffer in Kb.
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 mapchars (Classic Edition Only)In previous versions of Dyalog APL, certain pairs of characters in ⎕AV were mappedto a single font glyph through the output translate table. For example, the ASCII pipe¦ and the APL style | were both mapped to the APL style |. FromVersion 7.0onwards, it has been a requirement that the mapping between ⎕AV and the font isstrictly one-to-one (this is a consequence of the new native file system). Originally,the mapping of the ASCII pipe and the APL style, the APL and ASCII quotes, and theASCII ^ and the APL ^ were hard-coded. The mapping is defined by themapcharsparameter.
 mapchars is a string containing pairs of hexadecimal values which refer to 0-originindices in ⎕AV. The first character in each pair is mapped to the second on output.The default value ofmapchars is DB0DEBA7EEC00BE0 which defines the fol-lowing mappings.
 From To
 Hex Decimal Symbol Hex Decimal Symbol
 DB 219 ‘ 0D 13 '
 EB 235 ^ A7 167 ^
 EE 238 ⌷ C0 192 |
 0B 11 . E0 224 .
 To clear all mappings, set MAPCHARS=0000.
 maxwsThis parameter determines your workspace size in kilobytes and is the amount ofWindows memory allocated to the workspace at APL start-up.MAXWS is specifiedas an integer number followed optionally by the letter k, m or g (in upper or lowercase) to indicate kilobytes, megabytes or gigabytes. If omitted, the default is kil-obytes.
 The default value is 16384 (16 Mb). If you want a larger (or smaller) workspace youmust change this value. For example, to get a 64 MB workspace:
 MAXWS=64m
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 Dyalog APL places no implicit restriction on workspace size, and the virtual memorycapability of MS-Windows allows you to access more memory than you have phys-ically installed. However if you use a workspace that greatly exceeds your physicalmemory you will encounter excessive paging and your APL programs will runslowly.
 Note that the memory used for the workspace must be contiguousmemory, and,underWindows, this is typically limited to a maximum of 1.6GB. This is a Windowsrestriction, and not one that is imposed by Dyalog APL.
 OverstrikesPopup (Unicode Edition Only)This is a Boolean parameter that specifies whether or not the Overstrikes popup isenabled.
 PassExceptionsToOpSysThis is a Boolean parameter that specifies the default state of the Pass Exceptioncheck box in the System Error dialog box.
 pfkey_sizeThis parameter specifies the size of the buffer in Kb that is used to store pro-grammable function key definitions. See ⎕PFKEY.
 ProgramFolderThis parameter specifies the name of the folder in which the Dyalog APL programicons are installed.
 PropertyExposeRootThis parameter specifies whether or the names of properties, methods and events ofthe Root object are exposed. If set, you may query/set the properties of Root andinvoke the Root methods directly as if they were variables and functions respec-tively. As a consequence, these names may not be used for global variables in yourworkspace.
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 PropertyExposeSEThis parameter specifies whether or the names of properties, methods and events ofthe Session object are exposed. If set, you may query/set the properties of ⎕SE andinvoke ⎕SEmethods directly as if they were variables and functions respectively. Asa consequence, these names may not be used for global variables in the ⎕SE names-pace.
 qcmd_timeoutThis parameter specifies the length of time in milliseconds that APL will wait for theexecution of a Windows command to start. Its default value is 5000 milliseconds.
 ResolveOverstrikes (Unicode Edition Only)Specifies whether or not the user may enter an APL composite symbol using over-strikes.
 RunAsServiceWhen RunAsService is set to 1 (the default is 0) Dyalog APL will not prompt for con-firmation when the user logs off, and the interpreter will continue to run across thelogoff logon process
 SaveContinueOnExitSpecifies whether or not your current workspace is saved as CONTINUE.DWS beforeAPL terminates.
 SaveLogOnExitSpecifies whether or not your Session log is saved before APL terminates.
 SaveSessionOnExitSpecifies whether or not your current Session is saved in your Session file before APLterminates.
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 SerialSpecifies your Dyalog APL/W Serial Number.
 session_fileThis parameter specifies the name of the file from which the APL session (⎕SE) is tobe loaded when APL starts. If not specified, a .DSE extension is assumed. This ses-sion file contains the ⎕SE object that was last saved in it. This object defines theappearance and behaviour of the Session menu bar, tool bar(s) and status bar, togetherwith any functions and variables stored in the ⎕SE namespace.
 SessionOnTopSpecifies whether or not the Session may appear on top of Edit and Trace Windowsin Classic Dyalog mode. See " ClassicMode" on page 16.
 ShowStatusOnErrorSpecifies whether or not the Status window is automatically displayed (if required)when APL attempts to write output to it.
 SingleTraceSpecifies whether there is a single Trace window, or one Trace window per function.This applies only ifClassicMode is 1.
 StatusOnEditSpecifies whether or not a status bar is displayed at the bottom of an Edit window.
 sm_cols, sm_rowsThese parameters specify the size of the window used to display ⎕SM when it is usedstand-alone. They are not used if the window is specified using the SM object.
 TabStopsThis parameter specifies the number of spaces inserted by pressing the Tab key in theeditor. Its default value is 4.
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 trace_cols, trace_rowsThese parameters specify the initial size of a trace window in character units.
 trace_first_x, trace_first_yThese parameters specify the initial position on the screen of the first trace windowin character units. Subsequent trace windows will be staggered. This applies only ifClassicMode is 1.
 trace_offset_x, trace_offset_yThese parameters specify the amount by which a trace window is staggered from theprevious one. These apply only ifClassicMode is 1 and SingleTrace is 0.
 Trace_level_warnThis parameter specifies the maximum number of Trace windows that will be dis-played when an error occurs and Trace_on_error is set to 1.  If there are a largenumber of functions in the state indicator, the display of their Trace windows maytake several seconds. This parameter allows you to restrict the potential delay to a rea-sonable value and its default is 16. If the number of Trace windows would exceedthis number, the system instead displays a warning message box. This parameter isignored if you invoke the Tracer explicitly. This parameter applies only ifClas-sicMode is 1 and SingleTrace is 0.
 Trace_on_errorThis parameter is either 0 (the default) or 1. If set to 1, Trace_on_error specifies thatthe Tracer is automatically deployed when execution of a defined function halts withan error. A stack of Trace windows is immediately displayed, with the top Trace win-dow receiving the input focus.
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 TraceStopMonitorThis parameter specifies which of the ⎕TRACE (1), ⎕STOP (2) and ⎕MONITOR (4) col-umns are displayed in Trace and Edit windows. Its value is the sum of the cor-responding values.
 UnicodeToClipboardThis parameter specifies whether or not text that is transferred to and from the Win-dows clipboard is treated as Unicode text. IfUnicodeToClipboard is 0 (the default),the symbols in ⎕AV are mapped to ASCII text (0-255). In particular, the APL symbolsare mapped to ASCII symbols according to their positions in the Dyalog APL font. IfUnicodeToClipboard is 1, the symbols in ⎕AV are mapped to Unicode text and theAPL symbols are mapped to their genuine Unicode equivalent values.
 UseDefaultHelpCollectionThis parameter specifies whether or not Dyalog attempts to use the Microsoft Doc-ument Explorer and online help to display help for external objects, such as .NetTypes. See "DefaultHelpCollection " on page 17.
 WantsSpecialKeys (Unicode Edition Only)This parameter specifies a list of applications (e.g. "putty.exe") that use the commandstrings in the Input Translate Tables.
 wspathThis parameter defines the workspace path. This is a list of directories that aresearched in the order specified when you )LOAD or )COPY a workspace and whenyou start an Auxiliary Processor. The directory paths are specified using OperatingSystem specific conventions and separated by ";" (Windows) or ":" (UNIX).
 The following Windows example causes )COPY, )LOAD and )LIB to look first inthe current directory, then in D:\MYWS, and then in the (normal) installation work-space directory.
 wspath=.;D:\MYWS;C:\Program Files\Dyalog\Dyalog APL 13.2Unicode\ws
 XPLookAndFeelThis parameter specifies whether or not Native Look and Feel is used. This affects theappearance of user-interface controls such as Buttons. The default is 1. See "The Con-figuration Dialog Box" on page 127.
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 XPLookAndFeelDockerThis parameter specifies whether or not the title bars in docked windows honourNative Look and Feel, if this is enabled at the Windows level. If unspecified, thedefault is 0.
 yy_windowThis parameter defines how Dyalog APL is to interpret a 2-digit year number. If yy_window is not set (the default) then underWindows, Version 13.2 onwards willadhere to the rules specified in the Windows Region and Language 2-digit year set-tings.
 Dyalog allows a choice of input date formats for ⎕SM and GUI edit fields. If you havechosen a 2-digit year format such as MM/DD/YY, then an input of 02/01/00 will bydefault be interpreted as 1st February 1900 - not 1st February 2000.
 If your application uses a 4-digit year format such as YYYY-MM-DD, the problemwill not arise.
 You can use the yy_window parameter to cause your application to interpret 2-digitdates in as required without changing any APL code.
 Sliding versus Fixed WindowTwo schemes are in common use within the industry: Sliding or Fixed date windows.
 Use a Fixed window if there is a specific year, for example 1970, before which, datesare meaningless to your application. Note that with a fixed window, this date (say1970) will still be the limit if your application is running in a hundred years time.
 Use a Sliding window if there is a time period, for example 30 years, before whichdates are considered too old for your application. With a sliding window, you willalways be able to enter dates up to (say) 30 years old, but after a while, specific yearsin the past (for example 1970) will become inaccessible.
 Setting a Fixed WindowTo make a fixed window, set parameter yy_window to the 4-DIGIT year which isthe earliest acceptable date. For example:
 YY_WINDOW=1970
 This will cause the interpreter to convert any 2-digit input date into a year in therange 1970, 1971 ... 2069
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 Setting a Sliding WindowTo make a sliding window, set parameter yy_window to the 1- or 2-DIGIT yearwhich determines the oldest acceptable date. This will typically be negative.
 YY_WINDOW=-30
 Conversion of dates now depends on the current year:
 If the current year is 1999, the earliest accepted date is 1999-30 = 1969.
 This will cause the interpreter to convert any 2-digit input date into a year in therange 1969, 1970 ... 2068.
 However if your application is still running in the year 2010, the earliest accepteddate then will be 2010-30 = 1980. So in the year 2010, a 2-digit year will be inter-preted in the range 1980, 1981 ... 2079.
 Advanced SettingsYou can further restrict date windows by setting an upper as well as lower year limit.
 YY_WINDOW=1970,1999
 This causes 2-digit years to be converted only into the range 1970, 1971 ... 1999.Any 2-digit year (for example, 54) not convertible to a year in this range will cause aDOMAIN ERROR.
 The sliding window equivalent is:
 YY_WINDOW=-10,10
 This would establish a valid date window, ten years either side of the current year.For example, if the current year is 1998, the valid range would be (1998-10) –(1998+10), in other words: 1988, 1989, → 2008.
 One way of looking at the yy_window variable is that it specifies a 2-element vector.If you supply only the first element, the second one defaults to the first element + 99.
 Note that the system uses only the number of digits in the year specification to deter-mine whether it refers to a fixed (4-digits) or sliding (1-, or 2-digits) window. In factyou can have a fixed lower limit and a sliding upper limit, or vice versa.
 YY_WINDOW=1990,10
 Allows dates as early as 1990, but not more than 10 years hence.
 YY_WINDOW=0,1999
 Allows dates from the current year to the end of the century.
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 If the second date is before, or more that 99 years after the first date, then any date con-version will result in a DOMAIN ERROR. This might be useful in an applicationwhere the end-user has control over the input date format and you want to disallowany 2-digit date input.
 YY_WINDOW=1,0
 Registry Sub-FoldersA large amount of configuration information is maintained in the Windows Registryin sub-folders of the main folder identified by inifile.
 Many of these values are dynamic, for example the position of the various Sessionwindows, is maintained in a Registry sub-folder so that their appearance is main-tained from one invocation of APL to the next. These type of Registry values are con-sidered to be internal and are therefore not described herein.
 However, and Registry Value that is maintained via a configuration dialog box willbe named and described in the documentation for that dialog box in Chapter 2.
 AutoCompleteThis contains registry entries that describe your personal AutoComplete options. See"Auto Complete Tab" on page 149.
 ChartsThis contains entries that control the way charts are produced and displayed whenyou click one of the chart buttons. See " Object Operations" on page 122.
 ColoursThis contains entries that describe the colour schemes you have and your personalpreferences. See "Colour Selection Dialog" on page 157.
 Event ViewerThis contains entries that describe your settings for the Event Viewer. See "The EventViewer" on page 258.
 ExplorerThis contains entries that describe your settings for the Workspace Explorer. See"The Workspace Explorer Tool" on page 168.
 files
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 This contains the size of your recently used file list (see "General Tab" on page 127)and the list of your most recently loaded workspaces.
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 KeyboardShortcutsThis contains the definitions of your Keyboard Shortcuts (Unicode Edition only).See "Keyboard Shortcuts Tab" on page 135.
 LanguageBarThis contains the definitions of the symbols, tips, and help for the symbols in the Lan-guageBar.
 PrintingThis contains the entries for your Printer Setup options. See "Print ConfigurationDialog Box" on page 160.
 SALTThis contains entries for SALT. See "SALT" on page 151.
 SearchThis contains dynamic entries for the Find Objects Tool. See "Find Objects Tool" onpage 202.
 ThreadsThis contains entries to remember your preferences for Threads. See "The ThreadsMenu" on page 116.
 UnicodeIMEThis contains entries for the Dyalog Unicode IME.
 ValueTipsThis contains entries for your Value Tips preferences. See "Value Tips" on page 93.
 WindowRectsThis contains entries to maintain the position of various Session tool windows sothat they remain consistent between successive invocations of APL.
 Array EditorThe Array Editor stores its settings in the following registry sub-folder:
 HKEY_CURRENT_USER\Software\DavidLiebtag.com\ArrayEditor\1.1\Options
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 Workspace ManagementWorkspace Size and CompactionThe maximum amount of memory allocated to a Dyalog APL workspace is definedby themaxws parameter.
 Upon )LOAD and )CLEAR, APL allocates an amount of memory corresponding tothe size of the workspace being loaded (which is zero for a clear ws) plus the work-space delta.
 The workspace delta is 1/16th of maxws, except if there is less than 1/16th ofmaxwsin use, delta is 1/64th ofmaxws. This may also be expressed as follows:
 delta←maxws{⌈⍺÷⊃(⍵>⍺÷16)⌽64 16}ws
 where maxws is the value of themaxws parameter and ws is the currently allocatedamount of workspace. Ifmaxws is 16384KB, the workspace delta is either 256KB or1024 KB, and when you start with a clear ws the workspace occupies 256KB.
 When you erase objects or release symbols, areas of memory become free. APL man-ages these free areas, and tries to reuse them for new objects. If an operation requires acontiguous amount of workspace larger than any of the available free areas, APL reor-ganises the workspace and amalgamates all the free areas into one contiguous blockas follows:
 1. Any un-referenced memory is discarded. This process, known as garbagecollection, is required because whole cycles of refs can become un-ref-erenced.
 2. Numeric arrays are demoted to their tightest form. For example, a simplenumeric array that happens to contain only values 0 or 1, is demoted orsqueezed to have a ⎕DR type of 11 (Boolean).
 3. All remaining used memory blocks are copied to the low-address end of theworkspace, leaving a single free block at the high-address end. This processis known as compaction.
 4. In addition to any extra memory required to satisfy the original request, anadditional amount of memory, equal to the workspace delta, is allocated.This will always cause the process size to increase (up to the maxws limit)but means that an application will typically achieve its working processsize with at most 4+15 memory reorganisations.
 5. However, if after compaction, the amount of used workspace is less than1/16 of the Maximum workspace size (maxws), the amount reserved forworking memory is reduced to 1/64th maxws. This means that workspacesthat are operating within 1/16th of maxws will be more frugal with memory
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 Note that if you try to create an object which is larger than free space, APL reports WSFULL.
 The following system function and commands force a workspace reorganisation asdescribed above:
 ⎕WA, )RESET, )SAVE, )LOAD, )CLEAR
 However, in contrast to the above, any spare workspace above the workspace deltais returned to the Operating System. On a Windows system, you can see the processsize changing by using Task Manager.
 The system function ⎕WAmay therefore be used judiciously (workspace reor-ganisation takes time) to reduce the process size after a particularly memory-hungryoperation.
 Note that in Dyalog APL, the SYMBOL TABLE is entirely dynamic and grows andshrinks in size automatically. There is no SYMBOL TABLE FULL condition.
 Interface with WindowsWindows Command Processor commands may be executed directly from APL usingthe system command )CMD or the system function ⎕CMD. This system function is alsoused to start otherWindows programs. For further details, see the appropriate sectionsin Language Reference.
 Auxiliary ProcessorsIntroductionAuxiliary Processors (APs) are non-APL programs which provide Dyalog APL userswith additional facilities. They run under the control of Dyalog APL.
 Typically, APs are used where speed of execution is critical, for utility libraries, or asinterfaces to other products. APs may be written in any compiled language, althoughC is preferred and is directly supported.
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 Starting an APAn Auxiliary Processor is invoked using the dyadic form of ⎕CMD. The left argumentto ⎕CMD is the name of the program to be executed; the value of the wspath param-eter is used to find the named file. In Dyalog APL/W, the right argument to ⎕CMD isignored.
 'xutils' ⎕CMD ''
 On locating the specified program, Dyalog APL starts the AP and initialises a mem-ory segment for communication between the workspace and the AP. This com-munication segment allows data to be passed from the workspace to the otherprocess, and for results to be passed back. The AP then sends APL some informationabout its external functions (names, code numbers and calling syntax), which APLenters in the symbol table. APL then continues processing while the AP waits forinstructions.
 Using the APOnce established, an AP is used by making a reference to one of its external func-tions. An external function behaves as if it was a locked defined function, but it is ineffect an entry point to the AP.When an external function is referenced, APL trans-mits a code number to the AP, followed by any arguments. The AP then takes overand performs the desired processing before posting the result back.
 Terminating the APAn AP is terminated when all of its external functions are expunged from the activeworkspace. This could occur with the use of )CLEAR, )LOAD, )ERASE, ⎕EX, )OFF,)CONTINUE or ⎕OFF.
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 Example:Start an Auxiliary Processor called EXAMPLE. This fixes two external functionscalled DATE_TO_IDN and IDN_TO_DATE which deal with the conversion of Inter-national Day Numbers to Julian Dates.
 .------------------------.| APL PROCESS ||------------------------|| )CLEAR ||clear ws || | start AP .--------------.| 'EXAMPLE' ⎕CMD '' |------------>| AP EXAMPLE || | |--------------|| | info about |Send info on || |<------------|external fns || | functions | || )FNS | | wait ... ||DATE_TO_IDN IDN_TO_DATE | | || |function code| || IDN_TO_DATE 19407 |------------>|call relevant || | 19407 | subroutine || wait ... | | || |<-18 Feb 53--| send result ||18 Feb 53 | | || | terminate | || )CLEAR |------------>| EXIT ||clear ws | and stop .--------------.| |.------------------------.
 Access Control for External VariablesExternal variables may be EXCLUSIVE or SHARED. An exclusive variable canonly be accessed by the owner of the file. If you are on a Local Area Network (LAN)a shared external variable may be accessed (concurrently) by other users. The exclu-sive or shared status of an external variable is set by the XVAR function in the UTILworkspace.
 Access to an external variable is faster if it has exclusive status than if it is shared.This is because if several users are accessing the file data must always be read andwritten directly to disk. If it has exclusive status, the system uses buffering andavoids disk accesses where possible.
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 Creating ExecutablesDyalog APL provides the facility to package an APL workspace as a Windowsexecutable (EXE). This may be done by selecting Export … from the Filemenu of theAPL Session window.
 The system provides the following options:
 l You may bind your EXE as a Dyalog APL run-time application, or as a Dya-log APL developer application. The second option will allow you to debugthe application should it encounter an APL error.
 l You may bind your EXE as a console-mode application. A console appli-cation does not have a graphical user interface, but runs as a backgroundtask using files or TCP/IP to perform input and output.
 l You may specify whether or not your .EXE will honour Native Look andFeel if this is enabled at the Windows level.
 You can package the workspace as a stand-alone executable or as a .EXE file thatmust be accompanied by the Dyalog APL Dynamic Link Library (dyalog132.dllor dyalog132rt.dll), in which case the DLL should be installed in the samedirectory (as the EXE) or in the Windows System directory.
 The following example illustrates how you can package the supplied workspacecalc.dws as an executable. Before making the executable, it is essential to set upthe latent expression to run the program using ⎕LX as shown. Notice that in this caseit is not necessary to execute ⎕OFF; the calc.exe program will terminate normallywhen the user closes the calculator window and the system returns to Session input.
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 Then, when you select Export… from the Filemenu, the following dialog box is dis-played.
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 In the example shown, the program is to be saved in ws, the (supplied workspaces)directory fromwhich the workspace was loaded (the default).
 The Save as Type option has been set to Standalone Executable (includes interpreterexe)which means that a single .EXE will be created containing the Dyalog APLexecutable and the CALC workspace.
 The Runtime application checkbox is checked, indicating that calc.exe is toincorporate the runtime version of Dyalog APL..
 As this is a GUI application, the Console application checkbox is left unset.
 The Enable Native Look and Feel checkbox has been set so that calc.exe will hon-ourNative Look and Feel if it is enabled at the Windows level.
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 Note that if you enter the name of a file containing an icon (use the Browse button tobrowse for it) that icon will be bound with your executable and be use instead of thestandard Dyalog APL icon.
 The Command Line box allows you to enter parameters and values that are to bepassed to your executable when it is invoked.
 On clicking Save, the following message box is displayed to confirm success.
 Version InformationYou may embed version information into your .exe by clicking the Version buttonand then completing the Version Informationn dialog box that is illustrated below.
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 Run-Time Applications and ComponentsUsing Dyalog APL you may create different types of run-time applications and com-ponents. Note that the distribution of run-time applications and components requiresa Dyalog APL Run-Time Agreement. Please contact Dyalog or your distributor, orsee the Dyalog web page for more information.
 The following table shows a list of distributable components for the two Editions.These are referred to in the remainder of this Chapter by the name shown in the firstcolumn of the table. It is essential that you distribute the components that are appro-priate for the Edition you are using.
 Name File
 32-bit Unicode Dyalog APL 13.2 Unicode\
 Run-Time EXE dyalogrt.exe
 Run-Time DLL dyalog132rt_unicode.dll
 Bridge DLL bridge132_unicode.dll
 Dyalog DLL dyalog32 dll
 DyalogProvider DLL dyalogprovider.dll
 DyalogNet DLL dyalognet.dll
 APLScript Compiler dyalogc_unicode-exe
 32-bit Classic Dyalog APL 13.2 Classic\
 Run-Time EXE dyalogrt.exe
 Run-Time DLL dyalog132rt.dll
 Bridge DLL bridge132.dll
 Dyalog DLL dyalog32 dll
 DyalogProvider DLL dyalogprovider.dll
 DyalogNet DLL dyalognet.dll
 APLScript Compiler dyalogc-exe
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 Name File
 64-bit Unicode Dyalog APL-64 13.2 Unicode\
 Run-Time EXE dyalogrt.exe
 Run-Time DLL dyalog132_64rt_unicode.dll
 Bridge DLL bridge132-64_unicode.dll
 Dyalog DLL dyalog64 dll
 DyalogProvider DLL dyalogprovider.dll
 DyalogNet DLL dyalognet.dll
 APLScript Compiler dyalogc64_unicode-exe
 64-bit Classic Dyalog APL-64 13.2 Classic\
 Run-Time EXE dyalogrt.exe
 Run-Time DLL dyalog132_64rt.dll
 Bridge DLL bridge132-64.dll
 Dyalog DLL dyalog64 dll
 DyalogProvider DLL dyalogprovider.dll
 DyalogNet DLL dyalognet.dll
 APLScript Compiler dyalogc64-exe
 Stand-alone run-timeThis is the simplest type of run-time to install. Using the File/Export menu item onthe Session window, you can create a standard Windows executable program file(EXE) which contains your workspace and the Run-Time version of the Dyalog APLinterpreter. To distribute your application, you need to supply and install:
 1. Your bound executable (EXE)2. whatever additional files that may be required by your application
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 The command-line for your application should simply invoke your EXE, with what-ever start-up parameters it may require. Note that your application icon and any start-up parameters for the Run-Time Interpreter are specified and bound with the EXEwhen you make it.
 If your application uses any component of the Microsoft .Net Framework, you mustdistribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on thesystem path or placed in the same directory as your EXE. If you are going to use yourapplication with ASP.NET, the DLLs must also be installed in the global assemblycache (GAC) using the gacutil.exe utility program.
 Bound run-timeThis option requires the separate installation of the Run-Time DLL, but comparedwith the stand-alone executable option, may save disk space and memory if your cus-tomer installs and runs several different Dyalog applications. Using the File/Exportmenu item on the Session window, you can create a standard Windows executableprogram file (EXE) which contains your workspace bound to the Run-Time DLL. Todistribute your application, you need to supply and install:
 1. Your bound executable (EXE)2. The Run-Time DLL
 whatever additional files that may be required by your application
 The command-line for your application should simply invoke your EXE, with what-ever start-up parameters it may require. Note that your application icon and any start-up parameters for the Run-Time DLL are specified and bound with the EXE whenyou make it.
 If your application uses any component of the Microsoft .Net Framework, you mustdistribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on thesystem path or placed in the same directory as your EXE. If you are going to use yourapplication with ASP.NET, the DLLs must also be installed in the global assemblycache (GAC) using the gacutil.exe utility program.
 Workspace based run-timeA workspace based run-time application consists of the Dyalog APL Run-Time Pro-gram (Run-Time EXE) and a separate workspace. To distribute your application, youneed to supply and install:
 1. Your workspace2. The Run-Time EXE3. whatever additional files that may be required by your application
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 The command-line for your application invokes the Run-Time EXE, passing it start-up parameters required for the Run-Time EXE itself (such as MAXWS) and any start-up parameters that may be required by your application. You will need to associateyour own icon with your application during its installation.
 If your application uses any component of the Microsoft .Net Framework, you mustdistribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on thesystem path or placed in the same directory as your EXE. If you are going to use yourapplication with ASP.NET, the DLLs must also be installed in the global assemblycache (GAC) using the gacutil.exe utility program.
 Out-of-process COM ServerTo make an out-of-process COM Server, you must:
 1. Establish one or more OLEServer namespaces in your workspace, populatedwith functions and variables that you wish to export as methods, propertiesand events.
 2. Use the File/Export … menu item on the Session window to register theCOM Server on your computer so that it is ready for use.
 The command-line for your COM Server invokes the Run-Time EXE, passing it start-up parameters required for the Run-Time EXE itself (such as MAXWS) and any start-up parameters that may be required by your application.
 To distribute an out-of-process COM Server, you need to supply and install the fol-lowing files:
 1. Your workspace2. The associated Type Library (.tlb) file (created by File/Export)3. The Run-Time EXE4. whatever additional files that may be required by your application
 To install an out-of-process COM Server you must set up the appropriate Windowsregistry entries. See Interface Guide for details.
 In-process COM ServerTo make an in-process COM Server, you must:
 1. Establish one or more OLEServer namespaces in your workspace, populatedwith functions and variables that you wish to export as methods, propertiesand events.
 2. Use the File/Export … menu item on the Session window to create an in-process COM Server (DLL) which contains your workspace bound to theRun-Time DLL. This operation also registers the COM Server on your com-puter so that it is ready for use.
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 To distribute your component, you need to supply and install
 Your COM Server file (DLL)
 1. The Run-Time DLL2. Whatever additional files that may be required by your COM Server.
 Note that you must register your COM Server on the target computer using theregsvr32.exe utility.
 ActiveX ControlTo make an ActiveX Control, you must:
 1. Establish an ActiveXControl namespaces in your workspace, populatedwith functions and variables that you wish to export as methods, propertiesand events.
 2. Use the File/Export … menu item on the Session window to create an Acti-veX Control file (OCX) which contains your workspace bound to the Run-Time DLL. This operation also registers the ActiveX Control on your com-puter so that it is ready for use.
 To distribute your component, you need to supply and install
 Your ActiveX Control file (OCX)
 1. The Run-Time DLL2. Whatever additional files that may be required by your ActiveX Control.
 Note that you must register your ActiveX Control on the target computer using theregsvr32.exe utility.
 Microsoft .Net AssemblyA Microsoft .Net Assembly contains one or more .Net Classes. To make a Microsoft.Net Assembly, you must:
 1. Establish one or more NetType namespaces in your workspace, populatedwith functions and variables that you wish to export as methods, propertiesand events.
 2. Use the File/Export … menu item on the Session window to create a Micro-soft .Net Assembly (DLL) which contains your workspace bound tothe Run-Time DLL.
 To distribute your .Net Classes, you need to supply and install
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 Your Assembly file (DLL)
 1. The Run-Time DLL2. The Bridge DLL3. The DyalogNet DLL4. Whatever additional files that may be required by your .Net Assembly.5. The Bridge DLL and DyalogNet DLLs must either be on the system path or
 placed in the same directory as your EXE. If you are going to use yourAssembly with ASP.NET, the DLLs must also be installed in the globalassembly cache (GAC) using the gacutil.exe utility program.
 Additional Files for SQAPLIf your application uses the SQAPL/EL ODBC interface, you must distribute andinstall four additional files, according to the Edition you are using, as shown in thetables below.
 Name File
 32-bit Unicode Dyalog APL 13.2 Unicode\
 SQAPL INI sqapl.ini
 SQAPL ERR sqapl.err
 SQAPL DLL cndya61Uni.dll
 APLUNICD INI aplunicd.ini
 32-bit Classic Dyalog APL 13.2 Classic\
 SQAPL INI sqapl.ini
 SQAPL ERR sqapl.err
 SQAPL DLL cndya61.dll
 APLUNICD INI aplunicd.ini
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 Name File
 64-bit Unicode Dyalog APL-64 13.2 Unicode\
 SQAPL INI sqapl.ini
 SQAPL ERR sqapl.err
 SQAPL DLL cndya61x64Uni.dll
 APLUNICD INI aplunicd.ini
 64-bit Classic Dyalog APL-64 13.2 Classic\
 SQAPL INI sqapl.ini
 SQAPL ERR sqapl.err
 SQAPL DLL cndya61x64.dll
 APLUNICD INI aplunicd.ini
 The SQAPL DLL must be installed in the user’s Windows directory or be on theuser’s path.
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 Miscellaneous Other FilesAUXILIARY PROCESSORSIf you use any of the Auxiliary Processors (APs) included in the sub-directoryXUTILS, you must include these with your application. Note that, like workspaces,Dyalog APL searches for APs using the wspath parameter. If your application usesAPs, you must ensure that you specify wspath or that the default wspath is adequatefor your application..
 DYALOG32 and/or DYALOG64This DLL is used by some of the functions provided in the QUADNA.DWS workspace.If you include any of these in your application this DLL must be installed in theuser’s Windows directory or be on the user’s path.
 Registry Entries for Run-Time ApplicationsThe Run-Time DLL does not obtain any parameter values from the Windows reg-istry. If you need to specify any Dyalog APL parameter values, they must be definedin the command line when you create an EXE.
 The Run-Time EXE does obtain parameter values for the Windows registry, but doesnot require them to be present. If the default values of certain parameters are inap-propriate, you may specify their values on the command line. There is normally norequirement to install registry entries for a run-time application that uses the Run-Time EXE.
 For example, your application may requires a greater or lessermaxws parameter(workspace size) than the default value. This may be done by adding the phraseMAXWS=nnnn (where nnnn is the required workspace size in kilobytes) after thename of your application workspace on the command line, for example:
 dyalogrt.exe MYAPP.DWS MAXWS=8096
 Note that the default value of the DYALOG parameter (which specifies where itlooks for various other files and sub-directories) is the directory fromwhich the appli-cation (dyalogrt.exe) is loaded.
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 Nevertheless, registry entries will be required in the following circumstances.
 1. If your Classic Edition run-time application requires that the user inputsAPL characters, you will need to specify input/output tables (parametersAPLK, APLT, APLKEYS and APLTRANS).
 2. If your application uses the NFILES Auxiliary Processor (now supersededby the ⎕Nxxx system functions), you must specify a registry entry for theAPLKEYS parameter. This is required so that NFILES can find any trans-late tables you may use. Note that NFILES cannot see the values of param-eters specified on the APL command line, so you must specify APLKEYSin the registry.
 Installing Registry EntriesTo specify parameters using the Registry, you must install a suitable registry folderfor each user of your application. By default, Version 13.2 will use the registryfolder:
 HKEY_CURRENT_USER\Software\Dyalog\Dyalog APL/W 13.2 Unicode
 or
 HKEY_CURRENT_USER\Software\Dyalog\Dyalog APL/W 13.2
 You may choose a different name for your registry folder if you wish. If so, you musttell Dyalog APL the name of this folder by specifying the INIFILE parameter on thecommand line. For example:
 dyalogrt.exe MYAPP.DWS INIFILE=Software\MyCo\MyApplication
 You may install entries into the registry folder in one of two ways:
 1. Using a proprietary installation program such as InstallShield2. Using the REGEDIT utility. This utility program installs registry entries
 defined in a text file that is specified as the argument to the program. Forexample, if your file is called APLAPP.REG, you would install it on youruser’s system by executing the command:
 REGEDIT APLAPP.REG
 An example 5-line file that specifies the APLNID andMAXWSparameters might be as follows:
 Windows Registry Editor Version 5.00
 [HKEY_CURRENT_USER\Software\Dyalog\Dyalog APL/W 13.0]"aplnid"="42""maxws"="8096"
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 COM Objects and the Dyalog APL DLLIntroductionIn each Edition, there are two versions of the Dyalog APL Dynamic Link Library,named dyalog132_unicode.dll and dyalog132rt_unicode.dll (Uni-code Edition) and dyalog132.dll and dyalog132rt.dll (Classic Edition).
 dyalog132_unicode.dll and dyalog132.dll are complete Dyalog APLdevelopment systems packaged as Dynamic Link Libraries.
 dyalog132_unicode.dll and dyalog132rt_unicode.dll anddyalog132rt.dll are the run-time versions of dyalog132.dll.
 In the remainder of this section, the term the Dyalog APL DLL is used to refer to anyone of these DLLs. The termCOM object is used to refer to a Dyalog APL in-processOLE Server (OLEServer object) or a Dyalog APL ActiveX Control (ActiveXControlobject).
 The Dyalog APL DLL is used to host COM objects and .Net objects written in Dya-log APL. Although this section describes how it operates with COM objects, muchof this also applies when it hosts .Net objects. Further information is provided in the.Net Interface Guide.
 Classes, Instances and NameSpace CloningA COM object, whether written in Dyalog APL or not, represents a class. When ahost application loads a COM object, it actually creates an instance of that class.
 When a host application creates an instance of a Dyalog APL COM object, the cor-responding OLEServer or ActiveXControl namespace is cloned. If the host creates asecond instance, the original namespace is cloned a second time.
 Cloned OLEServer and ActiveXControl namespaces are created in almost exactly thesame way as those that you can make yourself using ⎕OR and ⎕WC except that theydo not have separate names. In fact, each clone believes itself to be the one and onlyoriginal OLEServer or ActiveXControl namespace, with the same name, and is com-pletely unaware of the existence of other clones.
 Notice that cloning does not initially replicate all the objects within the OLEServeror ActiveXControl namespace. Instead, the objects inside the cloned namespaces areactually represented by pointers to the original objects in the original namespace.Only when an object is changed does any information get replicated. Typically, theonly objects likely to differ from one instance to another are variables, so only onecopy of the functions will exist in the workspace. This design enables manyinstances of a Dyalog APL COM object to exist without overloading the workspace.
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 Workspace ManagementBy default, the Dyalog APL DLL does not use a fixed maximumworkspace size, butautomatically increases the size of its active workspace as required. If you write arun-away COM object, or if there is insufficient computer memory available to load anew control, it is left to the host application or to Windows itself to deal with the sit-uation.
 Nevertheless, it is possible to specify a value forMAXWS for the application inwhich the Dyalog APL DLL is embedded. This is achieved by defining a Registrykey named:
 HKLM\Software\Dyalog\Embedded\<appname>
 where <appname> is the name of the application, containing a String Value namedmaxws set to the desired size (in kb). If you were running an APL in-process serverfromMicrosoft Excel, the application name would be excel.exe.
 When an application loads its first Dyalog APL COM object, it starts the DyalogAPL DLL which initialises a CLEAR WS. It then copies the namespace tree for theappropriate OLEServer or ActiveXControl object into its active workspace.
 This namespace tree comprises the OLEServer or ActiveXControl namespace itself,together with all its parent namespaces with the exception of the root workspaceitself. Note that for an ActiveXControl, there is at least one parent namespace that rep-resents a Form.
 For example, if an ActiveXControl namespace is called #.F.Dual, the Dyalog APLDLL will copy the contents of #.F into its active workspace when the first instanceof the control is loaded by the host application.
 If the same host application creates a second instance of the same OLEServer orActiveXControl, the original namespace is cloned as described above and there is nofurther impact on the workspace
 If the same host application creates an instance of a different Dyalog APL COMobject, the namespace tree for this second object is copied from its DLL or OCX fileinto the active workspace. For example, if the second control was namedX.Y.MyControl, the entire namespace X would be copied.
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 This design raises a number of points:
 1. Unless you are in total control of the user environment, you should design aDyalog APL COM object so that it can operate in the same workspace asanother Dyalog APL COM object supplied by another author. You cannotmake any assumptions about file ties or other resources that are properties ofthe workspace itself.
 2. If you write an ActiveXControl whose ultimate parent namespace is calledF, a host application could not use your control at the same time as anotherActiveXControl (perhaps supplied by a different author) whose ultimate par-ent namespace is also called F.
 3. Dyalog APL COM objects must not rely on variables or utility functionsthat were present in the root workspace when they were saved. These func-tions and variables will not be there when the object is run by the DyalogAPL DLL.
 4. A Dyalog APL COM object may create and subsequently use functions andvariables in the root workspace, but if two different COM objects were toadopt the same policy, there is a danger that they would interfere with oneanother. The same is true for ⎕SE.
 Multiple COM Objects in a Single WorkspaceIf your workspace contains several OLEServer or ActiveXControl objects whichhave the same ultimate parent namespace, the Dyalog APL DLL will copy them allinto the active workspace at the time when the first one is instanced. If the host appli-cation requests a second COM object that is already in the workspace, the namespacetree is not copied again.
 If the workspace contains several OLEServer or ActiveXControl objects which havedifferent ultimate parents, their namespace trees will be copied in separately.
 ParametersWith the exception ofmaxws (see above) the Dyalog APL DLL does not read param-eters from the registry, command-line or environment variables. This means that allsuch parameters will have their default values.
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 System ErrorsIntroductionDyalog APL will display a System Error Dialog and (normally) terminate in one oftwo circumstances:
 l As a result of the failure of a workspace integrity checkl As a result of a System Exception
 aplcore fileIn these circumstances, APL saves an aplcore file which may be sent to Dyalog fordiagnosis. The default name and location of the aplcore file may be specified by theAplCoreName parameter. This parameter may also be used to suppress generation ofthe aplcore file.
 Workspace IntegrityWhen you )SAVE your workspace, Dyalog APL first performs a workspace integritycheck. If it detects any discrepancy or violation in the internal structure of your work-space, APL does not overwrite your existing workspace on disk. Instead, it displaysthe System Error dialog box and saves the workspace, together with diagnostic infor-mation, in an aplcore file before terminating.
 A System Error code is displayed in the dialog box and should be reported to Dyalogfor diagnosis.
 Note that the internal error that caused the discrepancy could have occurred at anytime prior to the execution of )SAVE and it may not be possible for Dyalog to iden-tify the cause from this aplcore file.
 If APL is started in debug mode with the –Dc, -Dw or –DW flags, the WorkspaceIntegrity check is performed more frequently, and it is more likely that the resultingaplcore file will contain information that will allow the problem to be identified andcorrected.
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 System ExceptionsNon-specific System Errors are the result of Operating System exceptions that canoccur due to a fault in Dyalog APL itself, an error in a Windows or other DLL, oreven as a result of a hardware fault. The following system exceptions are separatelyidentified.
 Code Description Suggested Action
 900 A Paging Fault hasoccurred
 As the most likely cause is a temporarynetwork fault, recommended course ofaction is to restart your program.
 990&991
 An exception has occurredin the Development or Run-Time DLL.
 995An exception has occurredin a DLL function calledvia ⎕NA
 Carefully check your ⎕NA statement andthe arguments that you have passed tothe DLL function
 996An exception has occurredin a DLL function calledvia a threaded ⎕NA call
 As above
 997An exception has occurredwhile processing anincoming OLE call
 999An exception has beencaused by Dyalog APL orby the Operating System
 Recovering Data from aplcore filesObjects may often (but not always) be recovered from aplcore using )COPY. Notethat because (by default) the aplcore file has no extension, it is necessary to explicitlyadd a dot, or APL will attempt to find the non-existent file aplcore.DWS, i.e.
 )COPY aplcore.
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 Reporting Errors to DyalogIf APL crashes and saves an aplcore file, please email the following information [email protected]:
 1. a brief description of the circumstances surrounding the error2. details of your version of Dyalog APL: the full version number, whether it
 is Unicode or Classic Edition, and the BuildID.  This information appears inthe Help->About box; the Copy button copies this information into the clip-board, from where it can be pasted into an email etc.
 3. the aplcore file itself
 If the problem is reproducible, i.e. can be easily repeated, please also send the appro-priate description, workspace, and other files required to do so.
 System Error Dialog BoxThe System Error Dialog illustrated below was produced by deliberately inducing asystem exception in the Windows DLL function memcpy(). The functions usedwere:
 ∇ foo[1] goo
 ∇∇ goo
 [1] hoo∇∇ hoo
 [1] crash∇
 ∇ crash[1] ⎕NA'dyalog32|MEMCPY u u u'[2] MEMCPY 255 255 255
 ∇
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 OptionsItem Parameter Description
 Generatecompleteimagecore
 CreateAplCoreonSyserrorDumps a complete core image with theUser Mode Process Dumper (aMicrosoft tool) - see below.
 CreateTrappableError
 If you check this box (only enabled onSystem Error codes 995 and 996), APLwill not terminate but will insteadgenerate an error 91 (EXTERNAL DLLEXCEPTION) when you press Dismiss.
 Create anaplcorefile
 CreateAplCoreonSyserror If this box is checked, an aplcore filewill be created.
 Passexceptionon tooperatingsystem
 PassExceptionsToOpSysIf this box is checked, the exceptionwill be passed on to your currentdebugging tool (e.g. Visual Studio).
 Copy toclipboard
 Copies the contents of the APL stacktrace window to the Clipboard.
 Generate complete image coreThe Generate complete image core option attempts to execute [SYSDIR]\userdump.exe, where [SYSDIR] is the windows system directory (typicallyc:\windows\system32, and userdump.exe is the UserMode Process Dumper, aMicrosoft tool that can be downloaded from the following url (which you may copyfromWinhelp and paste into a browser):
 http://www.microsoft.com/downloads/details.aspx?FamilyID=e23cd741-d222-48df-9cd8-28796f414256&DisplayLang=en
 The process creates a file called dyalog.core in the current directory. This file con-tains much more debug information than a normal aplcore (and is much larger than anaplcore) and can be sent to Dyalog Limited (zip it first please). Alternatively the filecan be loaded into Visual Studio .Net to do your own debugging.
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 Debugging your own DLLsIf you are using Visual Studio, the following procedure should be used to debug yourown DLLs when an appropriate Dyalog APL System Error occurs.
 Ensure that the Pass Exception box is checked, then click on Dismiss to close the Sys-tem Error dialog box.
 The system exception dialog box appears. Click on Debug to start the process in theVisual Studio debugger.
 After debugging, the system exception dialog box appears again. Click on Don'tsend to terminate Windows' exception handling.
 ErrorOnExternalException ParameterThis parameter allows you to prevent APL from displaying the System Error dialogbox (and terminating) when an exception caused by an external DLL occurs. The fol-lowing example illustrates what happens when the functions above are run, but withErrorOnExternalException set to 1.
 ⎕←2 ⎕NQ'.' 'GetEnvironment''ErrorOnExternalException'1
 fooEXTERNAL DLL EXCEPTIONcrash[2] MEMCPY 255 255 255
 ^⎕EN
 91)SI
 crash[2]*hoo[1]goo[1]foo[1]
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 Chapter 2:
 The APL Environment
 IntroductionThe Dyalog APL Development Environment includes a Session Manager, an Editor,and a Tracer all of which operate in windows on the screen. The session window iscreated when you start APL and is present until you terminate your APL session. Inaddition there may be a number of edit and/or trace Windows, which are created anddestroyed dynamically as required. All APL windows are under the control ofWin-dows and may be selected, moved, resized, maximised and minimised using the stand-ard facilities that Windows provides.
 APL KeyboardsThe Classic and Unicode Editions of Dyalog APL forWindows use different tech-niques for mapping keystrokes to APL characters and to special command shortcuts.
 The Classic Edition uses a proprietary technique for these mappings. The UnicodeEdition uses Microsoft’s IME (Input Method Editor) technology. Many other appli-cations use the same technology, which means that the Dyalog Unicode IME may beused not only with Dyalog APL for Windows Unicode Edition, but also with wordprocessing applications, spreadsheets, terminal emulators etc. Therefore with the Dya-log Unicode IME installed, and with a suitable font selected, APL characters can beentered and viewed in many other applications.
 In both Classic and Unicode Editions APL characters are generated when the userpresses certain combinations ofmeta keys in conjunction with the normal characterkeys. Meta keys include Shift, Ctrl and Alt.
 For both input techniques it is possible to alter the mapping of keystrokes to APLcharacters, and to add support for new languages. It is also possible to alter the key-strokes which define special command keyboard shortcuts. For further details, see"Unicode Edition Keyboard" on page 66 or "Classic Edition Keyboard" on page 71
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 Unicode EditionPrevious Unicode Editions of Dyalog APL used the Dyalog Ctrl or Dyalog AltGrkeyboard or the old IME to enter APL characters. With Version 13.2 the Dyalog Ctrland Dyalog AltGr keyboards are no longer issued and the Dyalog Unicode IME isthe sole input mechanism for APL characters. The Dyalog Unicode IME can be usedwith previous Unicode Editions of Dyalog APL provided that they are patched to aVersion created on or after 1st April 2011.
 Note that previous versions of Dyalog APL included the Comfort on-screen key-board; which has been withdrawn.
 Further details and a list of languages supported are described in the Dyalog UnicodeIME section below.
 Classic EditionThe mapping for each of the ⎕AV positions and its associated keystroke is defined bya selectable translate table. ⎕AV includes all the APL symbols used by Dyalog APLas well as all the (non-APL) characters which appear on a standard keyboard. Thismapping only works with Classic Edition.
 The Classic Edition installation also includes the Dyalog Unicode IME (describedbelow) so that users may enter APL characters into other applications; the DyalogUnicode IME is however not used by the Classic Edition itself.
 The Classic Edition includes support for Danish, Finnish, French, German, Italian,Swedish, and both British and American English keyboards. The default keyboardmapping for unsupported languages is American English.
 Dyalog Unicode IMEThe Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.Only keystrokes which resolve to characters that either do not appear on the standardkeyboard or which differ from those that appear on the standard keyboard areincluded in the selectable translate table. In effect the Dyalog Unicode IME can beregarded as an overlay of the standard keyboard which contains just APL characters.
 Dyalog intends to extend the Dyalog Unicode IME to include a mechanism that willallow any overstrike combination to be added, and that the Dyalog Unicode IMEwill be made freely available and not be reserved just for Dyalog APL users.
 This new Dyalog Unicode IME replaces the previously issued IME, as well as theDyalog Ctrl and Dyalog AltGr keyboards.
 The Dyalog Unicode IME supplied with Version 13.2 includes support for Danish,Finnish, French, German, Italian, Swedish and British and American English key-boards, based on the Version 12.1 Dyalog Ctrl layouts.
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 The Dyalog Unicode IME also has support for the Danish, British and American Eng-lish physical keyboards, which are available from Dyalog Ltd. It also includes sup-port for Spanish and German keyboards based on the layout of the Dyalog hardwarekeyboard.
 The default keyboard mapping for unsupported languages is American English.
 The IME translate tables include mappings for the special command keystrokes usedby Dyalog APL.
 These command keystroke mappings are ignored by applications unless the appli-cation is explicitly named in the Dyalog Unicode IME configuration. It is expectedthat only terminal emulators used for running UNIX-based versions of Dyalog APLwill use this feature.
 In particular, Dyalog APL forWindows Unicode Edition does not use the mappingsin the translate tables; the mappings are defined under Options/Configure/KeyboardShortcuts (see "Keyboard Shortcuts Tab" on page 135).
 To allow you to identify which IME you are using, the Dyalog Unicode IME uses adifferent icon to that used in previous Versions as shown below:
 The Dyalog Unicode IME
 The old APL IME
 Session ManagerThe Dyalog APL/W session is fully configurable. Not only can you change theappearance of the menus, tool bars and status bars, but you can add new objects ofyour choice and attach your own APL functions and expressions to them. Functionsand variables can be stored in the session namespace. This is independent of theactive workspace; so there is no conflict with workspace names, and your utilitiesremain permanently accessible for the duration of the session. Finally, you may set updifferent session configurations for different purposes which can be saved and loadedas required.
 The session window is defined by an object called ⎕SE. This is very similar to aForm object, but has certain special properties. The menu bar, tool bar and status barson the session window are in fact MenuBar, ToolControl and StatusBar objectsowned by ⎕SE. All of the other components such as menu items and tool buttons arealso standard GUI objects. You may use ⎕WC to create new session objects and youmay use ⎕WS to change the properties of existing ones. ⎕WG and ⎕WNmay also beused with ⎕SE and its children.
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 Components of the session that perform actions (MenuItem and Button objects) do sobecause their Event properties are defined to execute system operations or APLexpressions. System operations comprise a pre-defined set of actions that can be per-formed by Dyalog APL/W. These are coded as keywords within square brackets. Forexample, the system operation [WSClear] produces a clear ws, after first dis-playing a dialog box for confirmation. You may customise your session by adding ordeleting objects and by attaching system operations or APL expressions to them.
 Like any other object, ⎕SE is a namespace that may contain functions and variables.Furthermore, ⎕SE is independent of the active workspace and is unaffected by )LOAD and )CLEAR. It is therefore sensible to store commonly used utilities, par-ticularly those utilities that are invoked by events on session objects, in ⎕SE itself,rather than in each of your application workspaces.
 The possibility of configuring your APL session so extensively leads to the require-ment to have different sessions for different purposes. To meet this need, sessions arestored in special files with a .DSE (Dyalog Session) extension. The default session(i.e. the one loaded when you start APL) is specified by the session_file parameter.You may customise this session and then save it over the default one or in a separatefile. You can load a new session from file at any stage without affecting your activeworkspace.
 Positioning the CursorThe cursor may be positioned within the current APL window by moving the mousepointer to the desired location and then clicking the Left Button. The APL cursorwill then move to the character under the pointer.
 SelectionDragging the mouse selects the text from the point where the mouse button isdepressed to the point where the button is released. When you select multiple lines,the use of the left mouse button always selects text from the start of the line. A con-tiguous block of text can be selected by dragging with the right mouse button.
 Double-clicking the left mouse button to the left of a line selects the whole line,including the end-of-line character.
 ScrollingData can be scrolled in a window using the mouse in conjunction with the scrollbar.
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 Invoking the EditorThe Editor can be invoked by placing the mouse pointer over the name of an editableobject and double-clicking the left button on the mouse. If you double-click on theempty Input Line it acts as "Naked Edit" and opens an edit window for the suspendedfunction (if any) on the APL stack. For further details, see "Invoking the Editor" onpage 211. See also "DoubleClickEdit " on page 18.
 The Current ObjectIf you position the input cursor over the name of an object in the session window,that object becomes the current object. This name is stored in the CurObj property ofthe Session object and may be used by an application or a utility program. Thismeans that you can click the mouse over a name and then select a menu item or clicka button that executes code that accesses the name.
 The Session Pop-up MenuClicking the right mouse button brings up the Session pop-up menu. This isdescribed later in this chapter.
 Drag-and-Drop EditingDrag-and-Drop editing is the easiest way to move or copy a selection a short distancewithin an edit window or between edit windows.
 Tomove text using drag-and-drop editing:1. Select the text you want to move.2. Point to the selected text and then press and hold down the left mouse but-
 ton. When the drag-and-drop pointer appears, drag the cursor to a new loca-tion.
 3. Release the mouse button to drop the text into place.
 To copy text using drag-and-drop editing:1. Select the text you want to move.2. Hold down the Ctrl key, point to the selected text and then press and hold
 down the left mouse button. When the drag-and-drop pointer appears, dragthe cursor to a new location.
 3. Release the mouse button to drop the text into place.
 If you drag-and-drop text within the Session window, the text is copied and notmoved whether or not you use the Ctrl key.
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 InterruptsTo generate an interrupt, click on the Dyalog APL icon in the Windows SystemTray; then chooseWeak Interrupt or Strong Interrupt. To close the menu, clickCancel. Alternatively, to generate a weak interrupt, press Ctrl+Break, or selectInterrupt from the Action menu on the Session Window.
 Unicode Edition KeyboardIntroductionUnicode Edition supports the use of standard Windows keyboards that have the addi-tional capability to generate APL characters when the user presses Ctrl, Alt, AltGr (orsome other combination of meta keys) in combination with the normal characterkeys.
 Version 13.2 is supplied with the Dyalog Unicode IME keyboard for a range of dif-ferent languages as listed below. These keyboards have the same mappings as theDyalog Ctrl keyboard layouts used in Version 12.1. The intention is that only APLcharacters and characters that appear in locations different from the underlying key-board are defined; any other keystroke is passed through as is.
 InstallationDuring the Installation of Dyalog Version 13.2 Unicode Edition, setup installs theDyalog Unicode IME (IME). For any given Input Language the IME consists of anadditional service for that Input Language, and a translate table which maps key-strokes for the appropriate keyboard to Unicode code points for APL characters
 An IME service is installed for every Input Language that the user who installs Dya-log APL has defined, as well as every Input Language for which Dyalog has support.
 The keyboard mappings are defined for the following national languages:
 l Danish, Finnish, French, German, Italian, Swedish and British and AmericanEnglish keyboards (based on the Dyalog APL Version 12.1 Ctrl layouts)
 l Danish, British and American English physical keyboards, as supplied byDyalog Ltd.
 l German and Spanish keyboards based on the Dyalog hardware keyboard lay-out
 For any other Input Language the American English translate table is selected. Notethat some Input Languages are defined to be substitutes for other Input Languages;for example Australian English Input is a substitute for American English Input, Aus-trian German Input a substitute for German German Input. In these cases the IME willinstall the appropriate translate table. It is also possible to create support for new lan-guages or to modify the existing support. See the IME User Guide for further details.
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 Configuring the Dyalog APL IMEThe following description uses screenshots taken from a Windows 7 PC with threeInput Languages configured for the current user: English (United Kingdom) - thedefault Input Language, Danish (Denmark) and English (United States).
 The Dyalog Unicode IME is added as an additional service to all keyboards definedto the user and the administrator at the time that the IME was installed.
 For each IME the underlying keyboard layout file will be the same as that defined forthe base keyboard. The layout file is a DLL created by Microsoft.
 The language specified in the description of the IME is the name of the IME translatetable that has been associated with the IME for the specific keyboard. In the case oflanguages not supported by the IME the keyboard will default to en-US.With theIME as supplied with Version 13.2 altering this text requires editing the appropriateRegistry value.
 The IME may be configured fromwithin APL or fromWindows.
 From within Dyalog APLTo change the properties of the IME go to Options/Configure/Unicode Input tab andselect Configure Layout:
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 From WindowsRight click on either the Input Language icon or the Keyboard layout icon in theTaskBar and select Settings:
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 To alter the configuration of any of the installed IMEs, select that IME and click onProperties:
 Input translate table:The translate table defines the mapping between APL characters and the keystrokesthat generate those APL characters. It is possible to alter the mapping or to create sup-port for new keyboards by altering the translate table, or by selecting a different trans-late table. See the IME User Guide for more details.
 Overstrikes:In the original implementations of APL, many of the special symbols could only begenerated by overstriking one character on top of another as is reflected in the appear-ance of the glyphs. For example, the symbol for Grade Up (⍋) is actually the symbolfor delta (∆) superimposed on the symbol for vertical bar (|)
 In Dyalog APL such symbols can be generated either by a single keystroke, or (inReplacemode) by overtyping one symbol with another. For example ⍋may be gen-erated using Shift+Ctrl+4, or by switching to Replacemode and typing the three key-strokes Ctrl+h, Left-Cursor, Ctrl+m.
 Using the Dyalog Unicode IME the character can also be entered by pressingCtrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike IntroducerKey (key code OS).
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 Use Overstrike popup:With this option selected, when the character following the Overstrike IntroducerKey is pressed, a popup box displays all the overstrikes which contain the last char-acter typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:
 Note the fine (red) line under the ∆ in the Session window. This indicates that anoverstrike creation operation is in progress.
 The input of the symbol ⍋ can be completed by pressing Ctr+m, or by moving theselection up and down the pop-up list using Cursor-Up or Cursor-Down 
 Overstrikes do not require the OS introducer key (exper-imental):With this option selected, the IME identifies characters which are part of a valid over-strike, and when such a character is entered into the session, begins an overstrike cre-ation operation. This mode is experimental in the IME supplied with Version 13.2.
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 Classic Edition KeyboardThe standard Version 13.2 Classic Edition keyboard tables are files supplied in theaplkeys sub-directory named cc.din where cc is the standard 2-character countrycode, e.g. uk.din.
 Note that the standard tables do not support the entry of APL underscored characters⍙ⒶⒷⒸⒹⒺⒻⒼⒽⒾⒿⓀⓁⓂⓃⓄⓅⓆⓇⓈⓉⓊⓋⓌⓍⓎⓏ.
 The standard table supports two modes of use; traditional (mode 0) and unified(mode 1). The keyboard starts in mode 1 and may be switched between modes byclicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.
 Unified LayoutThe following picture illustrates the standard UK keyboard Unified layout.
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 APL symbols are entered using the Ctrl and Ctrl+Shift keys as illustrated below.
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 Traditional LayoutThe following picture illustrates the standard UK keyboard Traditional layout.
 APL symbols are entered using the Shift and Ctrl+Shift keys as illustrated below.
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 Line-Drawing SymbolsClassic Edition includes 12 single-line graphics characters for drawing lines andboxes. Line-drawing characters are entered using the keys on the numeric keypad inconjunction with the Ctrl key as shown below. Num Lock must be on.
 Normal Ctrl
 7 8 9 ┌ ┬ ┐
 4 5 6 ├ ┼ ┤
 1 2 3 └ ┴ ┘
 0 . │ ─
 Note:to accommodate other characters, line-drawing symbols are located in the non-printable area of the font layout. Although these characters can normally be used inoutput to the session (function: DISP in the UTIL workspace uses them),manyprinter drivers and some display drivers will not display characters from thesepositions in the font.

Page 79
                        

Chapter 2: The APL Environment 75
 Keyboard ShortcutsThe terms keyboard shortcut (Unicode Edition) and command (Classic Edition) areused herein to describe a keystroke that generates an action, rather than one thatproduces a symbol.
 Unicode EditionUnicode Edition provides a number of shortcut keys that may be used to performactions. For compatibility with Classic Edition and with previous Versions of Dya-log APL, these are identified by 2-character codes; for example the action to start theTracer is identified by the code <TC>, and mapped to user-configurable keystrokes.
 In the Unicode Edition, Keyboard Shortcuts are defined using Options/Con-figure/Keyboard Shortcuts and stored in the Windows Registry.  Note that the Uni-code IME translate tables have definitions for the Keyboard Shortcuts too; these areignored by the interpreter, and are intended for use with terminal emulators beingused in conjunction with non-GUI versions of Dyalog APL.
 To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon
 . If you hover the mouse over this icon, a pop-up tip is displayed to remind you ofyour keyboard shortcuts as illustrated below.
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 Classic EditionCommands fall into four categories, namely cursor movement, selection, editing direc-tives and special operations, and are summarised in the following tables. The inputcodes in the first column of the tables are the codes by which the commands are iden-tified in the Input Translate Table.
 Table 1: Cursor Movement CommandsInputCode Keystroke Description
 LS Ctrl+PgUp Scrolls left by a page
 RS Ctrl+PgDn Scrolls right by a page
 US PgUp Scrolls up by a page
 DS PgDn Scrolls down by a page
 LC Left Arrow Moves the cursor one character position to the left
 RC Right Arrow Moves the cursor one character position to theright
 DC Down Arrow Moves the cursor to the current character positionon the line below the current line
 UC Up Arrow Moves the cursor to the current character positionon the line above the current line
 UL Ctrl+Home Move the cursor to the top-left position in thewindow
 DL Ctrl+End Moves the cursor to the bottom-right position inthe window
 RL End Moves the cursor to the end of the current line
 LL Home Moves the cursor to the beginning of the currentline
 LW Ctrl+Left Arrow Moves the cursor to the beginning of the word tothe left of the cursor
 RW Ctrl+RightArrow
 Moves the cursor to the end of the word to theright of the cursor
 TB Ctrl+Tab Switches to the next session/edit/trace window
 BT Ctrl+Shift+Tab Switches to the previous session/edit/trace window
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 Table 2: Selection CommandsInputCode Keystroke Description
 Lc Shift+Left Arrow Extends the selection one character position tothe left
 Rc Shift+RightArrow
 Extends the selection one character position tothe right
 Lw Ctrl+Shift+LeftArrow
 Extends the selection to the beginning of theword to the left of the cursor
 Rw Ctrl+Shift+RightArrow
 Extends the selection to the end of the word tothe right of the cursor
 Uc Shift+Up Arrow Extends the selection to the current characterposition on the line above the current line
 Dc Shift+DownArrow
 Extends the selection to the current characterposition on the line below the current line
 Ll Shift+Home Extends the selection to the beginning of thecurrent line
 Rl Shift+End Extends the selection to the end of the currentline
 Ul Ctrl+Shift+Home Extends the selection to the beginning of the firstline in the window
 Dl Ctrl+Shift+End Extends the selection to the end of the last line inthe window
 Us Shift+PgUp Extends the selection up by a page.
 Ds Shift+PgDn Extends the selection down by a page
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 Table 3: Editing DirectivesInputCode Keystroke Description
 DI Delete Deletes the selection
 DK Ctrl+Delete Deletes the current line in an Edit window.Deletes selected lines in the Session Log.
 CT Shift+Delete Removes the selection and copies it to theclipboard
 CP Ctrl+Insert Copies the selection into the clipboard
 FD Ctrl+Shift+Enter Reapplies the most recent undo operation
 BK Ctrl+Shift+Bksp Performs an undo operation
 PT Shift+Insert Copies the contents of the clipboard into awindow at the location selected
 OP Ctrl+Shift+Insert Inserts a blank line immediately after the currentone (editor only)
 HT Tab Indents text
 TH Shift+Tab Removes indentation
 RD Keypad-slash Reformats a function (editor only)
 TL Ctrl+Alt+L Toggles localisation of the current name
 GL Ctrl+Alt+G Go to [line]
 AO Ctrl+Alt+, Add Comments
 DO Ctrl+Alt+. Delete Comments
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 Table 4: Special OperationsInputCode Keystroke Description
 IN Insert Insert on/off
 LN Keypad-minus Line numbers on/off
 ER Enter Execute
 ED Shift+Enter Edit
 TC Ctrl+Enter Trace
 EP Esc Exit
 QT Shift+Esc Quit
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 The Session Colour SchemeWithin the Development Environment, different colours are used to identify differenttypes of information. These colours are normally defined by registry entries and maybe changed using the Colour Configuration dialog box as described later in this chap-ter. In the Classic Edition, colours may alternatively be defined in the Output Trans-late Table (normally WIN.DOT). This table recognises up to 256 foreground and 256background colours which are referenced by colour indices 0-255. These colourindices are mapped to physical colours in terms of their Red, Green and Blue inten-sities (also 0-255). Foreground and background colours are specified independentlyas Cnnn or Bnnn. For example, the following entry in the Output Translate Tabledefines colour 250 to be red on magenta.
 C250: 255 0 0   + Red foregroundB250: 255 0 255 + Magenta background
 The first table below shows the colours used for different session components. Thesecond table shows how different colours are used to identify different types of datain edit windows.
 Table 5: Default Colour Scheme - SessionColour Used for Default
 249 Input and marked lines Red on White
 250 Session log Black on White
 252 Tracer : Suspended Function Yellow on Black
 253 Tracer : Pendent Function Yellow on Dark Grey
 245 Tracer : Current Line White on Red
 Table 6: Default Colour Scheme Edit windowsColour Array Type Editable Default
 236 Simple character matrix Yes Green on Black
 239 Simple numeric No White on Dk Grey
 241 Simple mixed No Cyan on Dk Grey
 242 Character vector of vectors Yes Cyan on Black
 243 Nested array No Cyan on Dk Grey
 245 ⎕OR object No White on Red
 248 Function or Operator No White on Dk Cyan
 254 Function or Operator Yes White on Blue
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 Syntax Colouring in the SessionAs an adjunct to the overall Session Colour Scheme, you may choose to apply a syn-tax colouring scheme to the current Session Input line(s). You may also extend syn-tax colouring to previously entered input lines, although this only applies to inputlines in the current session; syntax colouring information is not remembered in theSession Log.
 Syntax colouring may be used to highlight the context of names and other elementswhen the line was entered. For example, you can identify global names and localnames by allocating them different colours.
 "Colour Selection Dialog" on page 157 for further details.
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 The Session WindowThe primary purpose of the session window is to provide a scrolling area withinwhich you may enter APL expressions and view results. This area is described as thesession log. Normally, the session window will have a menu bar at the top with atool bar below it. At the bottom of the session window is a status bar. However, thesecomponents of the session may be extensively customised and, although this chapterdescribes a typical session layout, your own session may look distinctly different. Atypical Session is illustrated below.
 A typical Session window
 Window ManagementWhen you start APL, the session is loaded from the file specified by the session_fileparameter. The position and size of the session window are defined by the Posn andSize properties of the Session object ⎕SE, which will be as they were when the ses-sion file was last saved.
 The name of the active workspace is shown in the title bar of the window, andchanges if you rename the workspace or )LOAD another.
 You can move, resize, minimise or maximise the Session Window using the standardWindows facilities.
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 In addition to the Session Window itself, there are various subsidiary windowswhich are described later in the Chapter. In general, these subsidiary windows maybe docked inside the Session window, or may be stand-alone floating windows. Youmay dock and undock these windows as required. The standard Session layout illus-trated above, contains docked Editor, Tracer and SIStack windows.
 Note that the session window is only displayed when it is required, i.e. when APLrequests input from or output to the session. This means that end-user applicationsthat do not interact with the user through the session, will not have an APL sessionwindow.
 DockingNearly all of the windows used in the Dyalog APL IDE may be docked in the Ses-sion window or be stand-alone floating windows. When windows are docked in theSession, the Session window is split into resizable panes, separated by splitters. Thefollowing example, using the Status window, illustrates the principles involved. (Theuse of the Status window is described later in this Chapter.)
 To start with, the Status window is hidden. You may display it by selecting theStatusmenu item from the Toolsmenu. It initially appears as a floating (undocked)window as shown below.
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 If you press the left mouse button down over the Status window title bar, and drag it,you will find that when the mouse pointer is close to an edge of the Session window,the drag rectangle indicates a docking zone as shown below. This indicates the spacethat the window will occupy if you now release the mouse button to dock it.
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 The next picture shows the result of the docking operation. The Session window isnow split into 2 panes, with the Status window in the upper pane and the Session logwindow in the lower pane. You can resize the panes by dragging with the mouse.
 You will notice that a docked window has a title bar (in this case, the caption isStatus) and 3 buttons which are used to Minimise,Maximise and Close the dockedwindow.
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 The next picture shows the result of minimising the Status window pane. All thatremains of it is its title bar. The Minimise button has changed to a Restore button,which is used to restore the pane to its original size.
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 You can pick up a docked window and then re-dock it along a different edge of theSession as illustrated below.
 Docking the Status window along the left edge of the Session causes the Session win-dow to be split into two vertical panes. Notice how the title bar is now drawn ver-tically.
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 If you click the right mouse button over any window, its context menu is displayed.If the window is dockable, the context menu contains the following options:
 Undock Undocks the docked window. The window is displayed atwhatever position and size it occupied prior to being docked.
 HideCaption Hides the title bar of the docked window,
 DockableSpecifies whether the window is currently dockable or is lockedin its current state. You can use this to prevent the window frombeing docked or undocked accidentally.
 The last picture shows the effect of using Hide Caption to remove the title bar. In thisstate, you can resize the pane with the mouse, but the Minimise, Maximise and Closebuttons are not available. However, you can restore the object's title bar using its con-text menu.
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 Entering and Executing ExpressionsIntroductionThe session contains the input line and the session log. The input line is the last linein the session, and is (normally) the line into which you type an expression to be eval-uated.
 The session log is a history of previously entered expressions and the results theyproduced.
 If you are using a log file, the Session log is loaded into memory when APL is startedfrom the file specified by the log_file parameter. When you close your APL session,the Session log is written back out to the log file, replacing its previous contents.
 In general you type an expression into the input line, then press Enter (ER) to run it.After execution, the expression and any displayed results become part of the sessionlog.
 You can move around in the session using the scrollbar, the cursor keys, and thePgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-ning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end of thelast (i.e. the current) line in the session log. Home (LL) and End (RL) move the cursorto the beginning and end respectively of the line containing the cursor.
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 Language BarThe Language Bar is an optional window which is initially docked to the SessionWindow, to make it easy to pick APL symbols without using the keyboard.
 If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tipis displayed to remind you of its usage. If you click on a symbol in the Language Bar,that symbol is inserted at the cursor in the current line in the Session.
 Auto CompleteAs you start to enter characters in an APL expression, the Auto Complete suggestionspop-up window (AC for short) offers you a choice based upon the characters youhave already entered and the current context.
 For example, if you enter a ⎕, AC displays a list of all the system functions and var-iables. If you then enter the character r, the list shrinks to those system functions andvariables beginning with the letter r, namely ⎕refs, ⎕rl, and ⎕rtl. Instead ofentering the remaining characters, you may select the appropriate choice in the AClist. This is done by pressing the right cursor key or (in PocketAPL) by tapping thechoice in the list.
 If you begin to enter a name, AC will display a list of namespaces, variables, func-tions, operators that are defined in the current namespace. If you are editing a func-tion, AC will also include names that are localised in the function header.
 If the current space is a GUI namespace, the list will also include Properties, Eventsand Methods exposed by that object.
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 As an additional refinement, AC remembers a certain number of previous auto com-plete operations, and uses this information to highlight the most recent choice youmade.
 For example, suppose that you enter the two characters )c. AC offers you )clearthru' )cs, and you choose )cs from the list. The next time you enter the two char-acters )c, AC displays the same list of choices, but this time )cs is pre-selected.
 You can disable or customise Auto Completion from the Auto Complete page in theConfiguration dialog box which is described later in this chapter.
 Executing an ExpressionTo execute an expression, you type it into the input line, then press Enter (ER). Alter-natively, you can select Execute from the Action menu. Following execution, theexpression and any displayed results become part of the session log.
 Instead of entering a new expression in the input line, you can move back throughthe session log and re-execute a previous expression (or line of a result) by simplypointing at it with the cursor and pressing Enter. Alternatively, you can selectExecute from the Action menu. You may alter the line before executing it. If you doso, it will be displayed using colour 249 (Red on White), the same as that used for theinput line. When you press Enter the new line is copied to the input line prior tobeing executed. The original line is restored and redisplayed in the normal sessionlog colour 250 (Black on White).
 An alternative way to retrieve a previously entered expression is to useCtrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwardsand forwards through the input history, successively copying previously enteredexpressions over the current line. When you reach the expression you want, simplypress Enter to re-run it. These operations may also be performed from the Edit menuin the session window.
 Executing Several ExpressionsYou can execute several expressions, by changing more than one line in the sessionlog before pressing Enter. Each line that you change will be displayed using colour249 (Red on White). When you press Enter, these marked lines are copied down andexecuted in the order they appear in the log.
 Note that you don't actually have to change a line to mark it for re-execution; youcan mark it by overtyping a character with the same character, or by deleting a lead-ing space for instance.
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 It is also possible to execute a contiguous block of lines. To do this, you must firstselect the lines (by dragging the mouse or using the keyboard) and then copy theminto the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste themback into the session using Shift+Insert (PT). Lines pasted into the session are alwaysmarked (Red on White) and will therefore be executed when you press Enter. Toexecute lines from an edit window, you use a similar procedure. First select the linesyou want to execute, then cut or copy the selection to the clipboard. Then move tothe session window and paste them in, then press Enter to execute them.
 Session Print Width (PW)Throughout its history, APL has used a system variable ⎕PW to specify the width ofthe user's terminal or screen. Session output that is longer than ⎕PW is automaticallywrapped and split into multiple lines on the display. This feature of APL wasdesigned in the days of hard-copy terminals and has become less relevant in modernWindows environments.
 Dyalog APL continues to support the traditional use of ⎕PW, but also provides analternative option to have the system wrap Session output according to the width ofthe Session Window. This behaviour may be selected by checking the Auto PWcheckbox in the Session tab of the Configuration dialog box.
 Using Find/Replace in the SessionThe search and replace facilities work not just in the Editor as you would expect, butalso in the Session. For example, if you have just entered a series of expressionsinvolving a variable called SALES and you want to perform the same calculationsusing NEWSALES, the following commands will achieve it:
 Enter SALES in the Find box, and NEWSALES in the Replace box. Now click theReplace All button. You will see all occurrences of SALES change to NEWSALES.Furthermore, each changed line in the session becomes marked (Red on White). Nowclick on the session and press Enter (or select Execute from the Action menu).
 Once displayed, the Find or Find/Replace dialog box remains on the screen until it iseither closed or replaced by the other. This is particularly convenient if the same oper-ations are to be performed over and over again, and/or in several windows. Find andFind/Replace operations are effective in the window that previously had the focus.
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 Value TipsIf you hover the mouse pointer over a name in the Session or Debugger window, APLwill display a pop-up window containing the value of the symbol under the mousepointer.
 For example, in the following picture the mouse pointer was moved over the name ofthe variable HW in the Session window.
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 The next picture illustrates the Value Tip displayed when the mouse is hovered overthe name of the variable MAT.
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 Similarly, if you hover the mouse pointer over the name of a function, the system dis-plays the body of the function as a pop-up, as illustrated below.
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 Configuring Value TipsYou may enable/disable Value Tips and select other options from the General tab ofthe Configuration dialog box as shown below.
 You may experiment by changing the value of the delay before which Value Tips aredisplayed, until you find a comfortable setting.
 Note that the colour scheme used to display the Value Tip for a function need notnecessarily be the same colour scheme as you use for the function editor.
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 Array EditorThe Array Editor1 allows you to edit arbitrary arrays. It is invoked by either:
 l Clicking the icon in the Session toolbar when the mouse pointer is overthe name of a suitable variable.
 l Calling the User Command ]aedit, specifying the name of a suitable var-iable as its argument.
 l Calling it directly via ⎕NA
 The Array Editor draws data using a format that is similar to the output of theDISPLAY function. For example:
 1Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2013

Page 102
                        

Chapter 2: The APL Environment 98
 DocumentationFull documentation for the Array Editor, including a list of the keystrokes it uses, isavailable from the Help menu in the Array Editor's window.
 Supported ArraysThe Array Editor supports arrays that consist solely of characters and/or numbers.You may not use it to edit an array that contains an object reference or a ⎕OR.
 Reject unsupported dataThe way that the Arrays Editor reacts to unsupported arrays is determined by thevalue of the Reject unsupported data option which is accessed by theOptions/Reject unsupported data menu item on the Array Editor menubar.
 If this is set to true (the default), and you try to edit an array containing an object ref-erence, the Array Editor will refuse the start and the system will generate an error mes-sage.
 ⎕SE.NumEd.numed: Unexpected error in array editor:DOMAIN ERROR Argument contained data that is neither simple or
 nested.
 If this option is cleared, the Array editor will start but you will not be able to do any-thing. It is therefore advisable that you leave this option set.
 Notesl The Array Editor is supplied only with Unicode Editions of Dyalog
 APL/W. Please visit www.davidliebtag.com for details about availabilityand support for Classic Editions of Dyalog APL/W.
 l Namespaces are not supported.l Internal representations returned by ⎕OR are not supported.l Only one instance of the Array Editor may be executed at a time.l All calls to interpreter primitives use a value of 3 for ⎕ML.l Negative numbers must be represented using high minus signs. For example,
 ¯3 not -3.
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 ImplementationThe Array Editor is implemented by a DLL named dlaedit.dll (32-bit) ordlaedit64.dll (64-bit).
 The DLL exports two functions: DyalogEditArray andDyalogEditArrayTitle. The latter is used when you click the the icon inthe Session toolbar (via the APL function ⎕SE.NumEd.numed) and by the UserCommand ]aedit
 Calling the Array Editor DirectlyIf you wish to use the Array Editor directly, you may do so as follows using ⎕NA1.
 For both DyalogEditArray and DyalogEditArrayTitle the first argumentis the array to be edited, while the second argument is a place holder and shouldalways be 0
 For DyalogEditArrayTitle the 3rd argument is a character vector whose con-tents are displayed in the caption of the array editor window.
 The result is the newly altered array.
 Examples⎕NA'dlaedit.dll|DyalogEditArray <pp >pp' ⍝ 32-bit⎕NA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]' ⍝ 32-bit
 ⎕NA'dlaedit64.dll|DyalogEditArray <pp >pp' ⍝ 64-bit⎕NA'dlaedit64.dll|DyalogEditArrayTitle <pp >pp <0C2[]'⍝ 64-bit
 New←DyalogEditArray Old 0New←DyalogEditArrayTitle Old 0 Name
 1Note that these are not standard ⎕NA calls, but rather use an extension to ⎕NA, called DirectWorkspace Access. Dyalog does not intend to make this feature generally available at present: ifyou are interested in this feature please contact [email protected].
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 SharpPlot Graphics ToolsIntroductionIncluded with Dyalog APL (32-bit Windows versions only with the Microsoft .NetFramework Version 2.0 or later installed) is the SharpPlot graphics library which ispart of the RainPro graphics package..
 The Session includes 4 buttons which use SharpPlot to generate simple graphical pic-tures of the contents of the Current Object (identified by the name under or to the leftof the cursor).
 For example, if you have a numerical matrix in a variable called MAT, you can plot itby first positioning the cursor on the name MATin the Session window, and then click-ing one of the 4 graphical buttons in the Session toolbar.
 Data StructuresThe charting function can plot variables with the following data structures:
 l a simple numeric vectorl a vector of simple numeric vectorsl a simple numeric matrixl a matrix whose first row contains simple character vectors and whose other
 elements are simple numerics. In bar and line charts, the column headings inrow 1 are used as x-axis labels.
 l a matrix whose first column contains simple character vectors and whoseother elements are simple numerics. In bar and line charts, the row headingsin column 1 are used as legends to annotate the different series.
 l a matrix whose first row and first column both contain simple character vec-tors and whose other elements are simple numerics. In bar and line charts,the column headings in row 1 are used as x-axis labels, and the row head-ings in column 1 are used as legends annotate the different series.
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 Example: Bar ChartWine_Prices
 1961 1964 1966Lafite 8800 1342 1210Latour 15400 2357.5 4600Margaux 5980 672.5 920Mouton Rothschild 6710 713 2070Haut-Brion 13225 1840 1323
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 Example: Line ChartFirst_Growths
 1961 1964 1966 1970 1975 1976 1978 ...Lafite 8800 1342 1210 605 1380 2070 920 ...Latour 15400 2357.5 4600 2760 1552 978 1058 ...Margaux 5980 672.5 920 632 900 800 1208 ...
 ImplementationThe SharpPlot tools are implemented by four buttons in the Session toolbar. Each but-ton has a Select callback which runs the function ⎕SE.Chart.DoChart. This runs⎕SE.Chart.Do which constructs and then runs a function named⎕SE.Chart.MyChart.
 ⎕SE.Chart.MyChart uses an instance of the SharpPlot graphics class to producea chart of your data, which it saves as a temporary file. It then calls the SharpPlotviewer to display the file on your screen.
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 SharpPlot is a library of graphical subroutines, (originally written in APL andmachine-translated into C#) which is implemented as a .Net Namespace namedCauseway and supplied in \bin\sharpplot.dll in the Dyalog program direc-tory.
 NotesAlthough ⎕SE.Chart.MyChart is overwritten by successive uses of the graphicalbuttons, it is deliberately not erased each time. This allows you to use MyChart as asimple template to develop your own custom graphics function.
 The image is stored in Microsoft Enhanced Metafile Format in a temporary file whosename and location are generated automatically. The system does not delete the tem-porary file after use. For further details, See GetTempFileName in the Windowsdocumentation..
 The default program used to display the EMF file is SharpView.exe. You can optto use a different EMF viewer by setting the Charts\ViewCMDregistry key to nameanother program, such as Windows Picture and Fax Viewer.
 An attempt to plot the contents of a variables with an unsupported data structure (seeabove) is handled entirely by error trapping and will result in an error message boxand perhaps messages in the Status window.
 The Session GUI HierarchyAs distributed, the Session object ⎕SE contains two CoolBar objects. The first,named ⎕SE.cbtop runs along the top of the Session window and contains the tool-bars. The second, named ⎕SE.cbbot, runs along the bottom of the Session win-dows and contains the statusbars.
 The menubar is implemented by a MenuBar object named ⎕SE.mb.
 The toolbars in ⎕SE.cbtop are implemented by four CoolBand objects, bandtb1,bandtb2, bandtb3 and bandtb4 each containing a ToolControl named tb.
 The statusbars in ⎕SE.cbbot, are implemented by two CoolBand objects ,bandtb1 and bandtb2, each containing a StatusBar named sb.
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 The Session MenuBarThe Session MenuBar (⎕SE.mb) contains a set of menus as follows.
 The File MenuThe Filemenu (⎕SE.mb.file) provides a means to execute those APL SystemCommands that are concerned with the active and saved workspaces. The contents ofa typical File menu and the operations they perform are illustrated below.
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 Table 7: File MenuOperationsItem Action Description
 New [WSClear] Prompts for confirmation, then clears theworkspace
 Open [WSLoad] Prompts for a workspace file name, then loadsit
 Copy [WSCopy] Prompts for a workspace file name, thencopies it
 Save [WSSave] Saves the active workspace
 Save As [WSSaveas]Prompts for a workspace file name, then savesit
 Export [Makeexe]Creates a bound executable, an OLE Server,an ActiveX Control, or a .Net Assembly
 Export toMemory
 [MakeMemoryAssembly]
 Creates an in-memory .Net Assembly
 Drop [WSDrop]Prompts for a workspace file name, then erasesit
 PrintSetup [PrintSetup] Invokes the print set-up dialog box
 Continue [Continue]Saves the active workspace inCONTINUE.DWS and exits APL
 Exit [Off] Exits APL
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 ExportThe Export… menu item allows you to create a bound executable, an OLE Server (in-process or out-of-process), an ActiveX Control or a .Net Assembly.
 The dialog box used to create these various different files offers selective optionsaccording to the type of file you are making. The system detects which of these typesis most appropriate from the objects in your workspace. For example, if your work-space contains an ActiveXControl namespace, it will automatically select theActiveX Control option.

Page 111
                        

Chapter 2: The APL Environment 107
 The Create bound file dialog box contains the following fields. These will only bepresent if applicable to the type of bound file you are making.
 Item Description
 File nameAllows you to choose the name for your bound file The namedefaults to the name of your workspace with the appropriateextension.
 Save astype Allows you to choose the type of file you wish to create.
 Runtimeapplication
 If this is checked, your application file will be bound with theRun-Time DLL. If not, it will be bound with the DevelopmentDLL. The latter should normally only be used to permitdebugging.
 Consoleapplication
 Check this box if you want your executable to run as a consoleapplication. This is appropriate only if the application has nographical user interface.
 EnableNativeLook andFeel
 If checked, Native Look and Feel will be enabled for your boundfile.
 Icon fileAllows you to associate an icon with your executable. Type inthe pathname, or use the Browse button to navigate to an iconfile.
 Commandline
 For an out-of-process COM Server, this allows you to specify thecommand line for the process. For a bound executable, thisallows you to specify command-line parameters for thecorresponding Dyalog APL DLL.
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 Pressing the Version button brings up the Version Information dialog box shownbelow.
 This dialog box allows you to specify versioning information that will be stored inyour bound file.
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 The Edit MenuThe Edit menu (⎕SE.mb.edit) provides a means to recall previously entered inputlines for re-execution and for copying text to and from the clipboard.
 Unicode Edition Classic Edition
 Table 8: Edit menu operationsItem Action Description
 Back [Undo]Displays the previous input line. Repeateduse of this command cycles back through theinput history.
 Forward [Redo]Displays the next input line. Repeated use ofthis command cycles forward through theinput history.
 Clear [Delete] Clears the selected text
 Copy [Copy] Copies the selection to the clipboard
 Paste [Paste]
 Pastes the text contents of the clipboard intothe session log at the current location. Thenew lines are marked and may be executedby pressing Enter.
 PasteUnicode [Pasteunicode]
 Same as Paste, but gets the Unicode text fromthe clipboard and converts to ⎕AV. ClassicEdition only.
 PasteNon-Unicode
 [Pasteansi]Same as Paste, but gets the ANSI text fromthe clipboard and converts to ⎕AV. ClassicEdition only.
 Find [Find] Displays the Find dialog box
 Replace [Replace] Displays the Find/Replace dialog box
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 The View MenuThe View menu (⎕SE.mb.view) toggles the visibility of the Session Toolbar, Stat-usBar, and Language Bar.
 Table 9: View menu operationsItem Action Description
 Toolbar Shows/Hides Session toolbars
 Statusbar Shows/Hides Session statusbars
 LanguageBar Shows/Hides Language Bar
 The Window MenuThis contains a single action (⎕SE.mb.windows) which is to close all of the Editand Trace windows and the Status window.
 Table 10: Window menu operationsItem Action Description
 Close all Windows [CloseAll] Closes all Edit and Trace windows
 Note that [CloseAll] removes all Trace windows but does not reset the State Indi-cator.
 In addition, theWindow menu will contain options to switch the focus to any sub-sidiary windows that are docked in the Session as illustrated above.
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 The Session MenuThe Session menu (⎕SE.mb.session) provides access to the system operationsthat allow you to load a session (⎕SE) from a session file and to save your current ses-sion (⎕SE) to a session file. If you use these facilities rarely, you may wish to movethem to (say) the Optionsmenu or even dispense with them entirely.
 Table 11: Sessionmenu operationsItem Action Description
 Open [SELoad]
 Prompts for a session file name, then loads the sessionfrom it, replacing the current one. Sets the Fileproperty of ⎕SE to the name of the file from which thesession was loaded.
 Save [SESave]Saves the current session (as defined by ⎕SE) to thesession file specified by the File property of ⎕SE.
 SaveAs [SESaveas]
 Prompts for a session file name, then saves the currentsession (as defined by ⎕SE) in it. Resets the Fileproperty of ⎕SE.
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 The Log MenuThe Log menu (⎕SE.mb.log) provides access to the system operations that manip-ulate Session log files.
 Table 12: Log menu operationsItem Action Description
 New [NewLog]Prompts for confirmation, then empties the currentSession log.
 Open [OpenLog]Prompts for a Session log file, then loads it intomemory, replacing the current Session log
 Save [SaveLog]Saves the current Session log in the current log file,replacing its previous contents
 SaveAs [SaveLogAs]
 Prompts for a file name, then saves the currentSession log in it.
 Print [PrintLog] Prints the contents of the Session log.
 The Action MenuThe Action menu (⎕SE.mb.action) may be used to perform a variety of operationson the current object or the current line. The current object is the object whose namecontains the cursor. The current line is that line that contains the cursor. The Edit,Copy Object, Paste Object and Print Object items operate on the current object. Forexample, if the name SALES appears in the session and the cursor is placed some-where within it, SALES is the current object and will be copied to the clipboard byselecting Copy object or opened up for editing by selecting Edit.
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 Execute runs the current line; Trace traces it.
 Unicode Edition Classic Edition
 Table 13: Actionmenu operationsItem Action Description
 Edit [Edit] Edit the current object
 Trace [Trace]Executes the current line under the control of theTracer
 Execute [Execute] Executes the current line
 CopyObject [ObjCopy]
 Copies the contents of the current object to theclipboard.
 PasteObject [ObjPaste]
 Pastes the contents of the clipboard into thecurrent object, replacing its previous value
 PrintObject [ObjPrint] Prints the current object.
 ClearStops [ClearTSM]
 Clears all ⎕STOP, ⎕MONITOR and ⎕TRACEsettings
 Interrupt [Interrupt] Generates a weak interrupt
 Reset [Reset] Performs )RESET
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 The Options MenuThe Optionsmenu (⎕SE.mb.options) provides configuration options.
 Table 14: Options menu operationsItem Action Description
 Expose GUIProperties [ExposeGUI]
 Exposes the names of properties,methods and events in GUI objects
 Expose RootProperties [ExposeRoot]
 Exposes the names of the properties,methods and events of the Root object
 ExposeSessionProperties
 [ExposeSession]Exposes the names of the properties,methods and events of  ⎕SE
 Line Numbers [LineNumbers]Toggle the display of line numbers inedit and trace windows on/off
 Configure [Configure]Displays the Configuration dialogbox
 Colours [ChooseColors]Displays the Colours Selection dialogbox
 The values associated with the Expose GUI, Expose Root and Expose Session optionsreflect the values of these settings in your current workspace and are saved in it.
 When you change these values through the Optionsmenu, you are changing them inthe current workspace only.
 The default values of these items are defined by the parameters default_wx, Prop-ertyExposeRoot and PropertyExposeSE which may be set using the Object Syntaxtab of the Configuration dialog.
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 The Tools MenuThe Toolsmenu (⎕SE.mb.tools) provides access to various session tools anddialog boxes.
 Unicode Edition Classic Edition
 Table 15: Tools MenuOperationsItem Action Description
 Explorer [Explorer] Displays the Workspace Explorer tool
 Search [WSSearch] Displays the Workspace Search tool
 Status [Status] Displays or hides the Status window
 AutoStatus [AutoStatus]Toggle; if checked, causes the Statuswindow to be displayed when a newmessage is generated for it
 EventViewer [EventViewer] Displays or hides the Event Viewer
 Properties [ObjProps]Displays a property sheet for the currentobject
 KeyboardViewer
 Displays the APLTeam Keyboard Viewer.Classic Edition only.
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 The Threads MenuThe Threadsmenu (⎕SE.mb.threads) provides access to various session toolsand dialog boxes.
 Table 16: Threads MenuOperationsItem Action Description
 ShowThreads [Threads] Displays the Threads Tool
 Show Stack [Stack] Displays the SI Stack window
 Show TokenPool [TokenPool]
 Displays the Token Poolwindow
 Auto Refresh [ThreadsAutoRefresh]Refreshes the Threads Tool onevery thread switch
 Pause onError [ThreadsPauseOnError] Pauses all threads on error
 Pause allThreads [ThreadsPauseAll] Pauses all threads
 Resume allThreads [ThreadsResumeAll] Resumes all threads
 Restart allThreads [ThreadsResrartAll] Restarts all threads
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 The Help MenuThe Help menu (⎕SE.mb.help) provides access to the help system which is pack-aged as a singleMicrosoft HTMLHelp compiled help file namedhelp\dyalog.chm.
 Table 17: Helpmenu operationsLabel Action Description
 DocumentationCenter [Decanter]
 Opens your web browser onhelp\index.html which displays anindex to the on-line PDF documentationand selected internet links.
 LatestEnhancements [Reunites]
 Opens help\dyalog.chm, starting atthe first topic in the Version 13.2Release Notes section. Note thatprevious Release Notes are alsoincluded for your convenience.
 Language Help [Lang Help]Opens help\dyalog.chm, starting atthe first topic in the Language Referencesection.
 Gui Help [GuiHelp]Opens help\dyalog.chm, starting atthe first topic in the Object Referencesection.
 Dyalog WebSite [DyalogWeb]
 Opens your web browser on the Dyaloghome page.
 Email Dyalog [DyalogEmail]
 Opens your email client and creates anew message to Dyalog Support, withinformation about the Version ofDyalog APL you are running.
 About DyalogAPL [About] Displays an About dialog box
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 Session Pop-Up MenuThe Session popup menu (⎕SE.popup) is displayed by clicking the right mouse but-ton anywhere in the Session window. If the mouse pointer is over a visible objectname, the popup menu allows you to edit, print, delete it or view its properties. Notethat the name of the pop-up menu is specified by the Popup property of ⎕SE.
 Table 18: Session popupmenu operationsItem Action Description
 Edit [Edit] Edits the current object
 Print [ObjPrint] Prints the current object
 Delete [ObjDelete] Erases the current object
 Properties [GUIHelp]Displays the Object Properties dialog boxfor the current object
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 Item Action Description
 Help [Help]Displays the help topic associated with thecurrent object or the APL symbol under thecursor
 LineNumbers [LineNumbers] Toggles line numbers on/off
 Copy [Copy] Copies the selection to the clipboard
 Paste [Paste]
 Pastes the text contents of the clipboard intothe session log at the current location. Thenew lines are marked and may be executedby pressing Enter.
 PasteUnicode [Pasteunicode]
 Same as Paste, but gets the Unicode textfrom the clipboard and converts to ⎕AV
 PasteNon-Unicode
 [Pasteansi]Same as Paste, but gets the ANSI text fromthe clipboard and converts to ⎕AV
 Explorer [Explorer] Displays the Workspace Explorer
 Search [WSSearch] Displays the Find Objects tool
 EventViewer [EventViewer] Displays the Event Viewer
 Threads [Threads] Displays the Threads Tool
 Status [Status] Displays the Status window
 Colours [ChooseColors] Displays the Colour Selection dialog
 Interrupt [Interrupt] Generates a weak interrupt
 Openlink [OpenLink]
 Opens the URL or link using the appropriateprogram. See "Underline URLs and links" onpage 128
 Copylink toclipboard
 [Copy_Link]Copies the URL or link to the WindowsClipboard. See "Underline URLs and links"on page 128
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 The Session ToolbarsThe Session toolbars are contained by four separate CoolBand objects, allowing youto configure their order in whichever way you choose.
 The Session tool bars
 The bitmaps for the buttons displayed on the session tool bar are implemented bythree ImageList objects owned by the CoolBar ⎕SE.cbtop. These represent theToolButton images in their normal, highlighted and inactive states and are namediln, ilh and ili respectively.
 These images derive from three bitmap resources contained in dyalog.exe namedtb_normal, tb_hot and tb_inactive. The statements that create these ImageL-ist object in function BUILD_SESSION in BUILDSE.DWS are as follows.
 :With '⎕SE.cbtop''iln'⎕WC'ImageList'('MapCols' 0)('Masked' 1)'iln.bm'⎕WC'Bitmap'('' 'tb_normal')('MaskCol'(192 192
 192))'ilh'⎕WC'ImageList'('MapCols' 0)('Masked' 1)'ilh.bm'⎕WC'Bitmap'('' 'tb_hot')('MaskCol'(192 192
 192))'ili'⎕WC'ImageList'('MapCols' 0)('Masked' 1)'ili.bm'⎕WC'Bitmap'('' 'tb_inactive')('MaskCol'(192
 192 192)):EndWith
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 Workspace (WS) Operations
 Clear WorkspaceExecutes the system operation [WSClear] which asksfor confirmation, then clears the workspace.
 Load WorkspaceExecutes the system operation [WSLoad] whichdisplays a file selection dialog box and loads theselected workspace.
 Copy WorkspaceExecutes the system operation [WSCopy] whichdisplays a file selection dialog box and copies the(entire) selected workspace
 Save WorkspaceExecutes the system operation [WSSaveas] whichdisplays a file selection dialog box and saves theworkspace in the selected file.
 Re-ExportWorkspace
 Executes the system operation [REExport] which re-exports the workspace using the settings, parameters andoptions that were previously selected using the CreateBound File dialog.
 Print WorkspaceExecutes the system operation [PrintFnsInNS] thatprints all the functions and operators in the currentnamespace.
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 Object Operations
 Copy ObjectExecutes the system operation [ObjCopy] whichcopies the contents of the current object to theclipboard.
 Paste ObjectExecutes the system operation [ObjPaste] whichcopies the contents of the clipboard into the currentobject, replacing its previous value.
 Print ObjectExecutes the system operation [ObjPrint] that printsthe current object.
 Edit ObjectExecutes the system operation [Edit] which edits thecurrent object using the standard system editor.
 Edit ArrayExecutes a defined function in ⎕SE that edits thecurrent object using the Array Editor (Unicode Edition)or a spreadsheet-like interface based upon the Gridobject (Classic Edition). See "Array Editor" on page 97.
 BarchartExecutes a defined function in ⎕SE that displays thevalue of the current object in a Barchart.
 LinechartExecutes a defined function in ⎕SE that that displaysthe value of the current object in a Linechart.
 PiechartExecutes a defined function in ⎕SE that that displaysthe value of the current object in a Piechart.
 ScatterplotExecutes a defined function in ⎕SE that that displaysthe value of the current object in a Scatterplot.
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 Tools
 Explorer
 Executes the system operation [Explorer] whichdisplays the Workspace Explorer tool.
 Search
 Executes the system operation [WSSearch] whichdisplays the Workspace Search tool.
 Line NumbersExecutes the system operation [LineNumbers] whichtoggles the display of line numbers in edit and tracewindows on and off.
 Clear all StopsExecutes the system operation [ClearTSM] whichclears all ⎕STOP, ⎕MONITOR and ⎕TRACE settings
 Edit Operations
 Copy SelectionExecutes the system operation [Copy] which copiesthe selected text to the clipboard.
 Paste SelectionExecutes the system operation [Paste] which pastesthe text in the clipboard into the current window at theinsertion point.
 Recall LastExecutes the system operation [Undo]which recalls theprevious input line from the input history stack
 Recall Next Executes the system operation [Redo] which recallsthe next input line from the input history stack.
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 Session Operations
 Load SessionExecutes the system operation [SELoad] whichdisplays a file selection dialog box and loads theselected Session File.
 Select Font
 Selects the font to be used in the Session window.
 Select Font Size
 Selects the size of the font to be used in the Sessionwindow.
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 The Session Status BarThe session status bar is represented by two CoolBands each of which contains a Stat-usBar object. There are a number of StatusFields as illustrated below. Your ownstatus bar may be configured differently.
 Classic Edition
 Unicode Edition
 The StatusField objects owned by the session StatusBar may have special values ofStyle, which are used for operations relevant only to the Session. These styles are sum-marised in the tables shown below.
 Table 19: Session status fields : first rowStatusField Style Description
 hint None Displays hints for the session objects, or "Ready..."when APL is waiting for input
 insrep InsRep Displays the mode of the Insert key (Ins or Rep)
 mode KeyMode
 Displays the keyboard mode. This is applicable onlyto a multi-mode keyboard. The text displayed isdefined by the Mn= string in the Input Table.Classic Edition Only.
 num NumLock Indicates the state of the Num Lock key. Displays"NUM" if Num Lock is on, blank if off.
 caps CapsLock Indicates the state of the Caps Lock key. Displays"Caps" if Caps Lock is on, blank if off.
 pause Pause Displays a flashing red "Pause" message when thePause key is used to halt session output
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 Table 20: Session status fields : second rowStatusField Style Description
 curobj CurObj Displays the name of the current object (the namelast under the input cursor)
 tc ThreadCount Displays the number of threads currently running(minimum is 1)
 dqlen DQLen Displays the number of events in the APL eventqueue
 trap Trap Turns red if ⎕TRAP is set
 si SI Displays the length of ⎕SI. Turns red if non-zero
 io IO Displays the value of ⎕IO. Turns red if ⎕IO is notequal to the value of the default_io parameter
 ml ML Displays the value of ⎕ML. Turns red if ⎕ML is notequal to the value of the default_ml parameter
 Toggle Status FieldsIn the default Session files distributed with this release, the Statusfields used to dis-play the value of ⎕IO, the state of the Insert key (Ins/Rep) and the current keyboardmode (e.g. Apl/Uni) have callback functions attached to MouseDblClick. This meansthat you can toggle the state of these fields by double-clicking with the left mousebutton.
 If you dislike this behaviour, you may set the Event property of the Statusfields to 0and re-save the Session file. Alternatively, you may modify BUILDSE.DWS andrebuild the Session from scratch.
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 The Configuration Dialog BoxGeneral Tab
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 Table 21: Configuration dialog: GeneralLabel Parameter Description
 Show linenumbers lines_on_functions
 Determines whether or not linenumbers are shown in edit/tracewindows
 Recently usedfile list size file_stack_size
 Specifies the number of the mostrecently used workspacesdisplayed in the File menu.
 Display ValueTips after ValueTips/Delay
 Specifies the delay before APLwill display the value of avariable or the code for a functionwhen the user hovers the mouseover its name.
 Colour Scheme ValueTips/ColourScheme
 Specifies the colour scheme usedto display the value of a variableor the code for a function whenthe user hovers the mouse over itsname.
 Enable NativeLook and Feel XPLookAndFeel
 Specifies whether or not NativeLook and Feel is enabled. Thischanges the appearance of user-interface controls such as Buttonsin both the Session and theDyalog GUI.
 Apply NativeLook and Feelto dockedcaptions
 XPLookAndFeelDocker
 Specifies whether or not NativeLook and Feel is honoured whendrawing the title bars of dockedwindows, including dockedSession windows.
 UnderlineURLs and links URLHighlight
 Specifies whether or not URLsand links are highlighted inSession and Edit windows.
 Configurationsaved in inifile Specifies the full pathname of the
 registry folder used by APL
 Underline URLs and linksIf this option is selected, valid URLs are identified when the cursor is in the Sessionor in an Edit or Trace window.When the mouse pointer is over a URL, the URL is
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 underscored and the appropriate items in the Session Popup menu are activated.These allow you to open the link or copy it to the clipboard.
 You may also open a URL using Ctrl+Click (Left Mouse button).
 Currently a URL string is defined to be a string starting with any of the followingstrings:
 l http://l https://l www.l mailto:
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 Unicode Input Tab (Unicode Edition Only)Unicode Edition can optionally select your APL keyboard each time you start APL.
 To choose this option, select one of your installed APL keyboards, enable theActivate selected keyboard checkbox, then click OK
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 Label Parameter Description
 Activateselectedkeyboard
 InitialKeyboardLayoutInUse
 1 = automatically selectthe specified APLkeyboard on start-up.0 = no action
 Showkeyboards forall Languages
 InitialKeyboardLayoutShowAll
 1 = show list of allinstalled keyboards0 = show only the Dyalogkeyboards
 Keyboard InitialKeyboardLayout the name of the APLkeyboard to be selected.
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 Table 22: Configuration dialog: Unicode Input/Configure LayoutLabel Parameter Description
 EnableOverstrikes ResolveOverstrikes 1 = enable overstrikes.
 0 = disable overstrikes
 Overstrikes donot require the<OS> key
 1 = IME identifies overstrike operationautomatically0 = IME requires the <OS> key tosignal an overstrike operation
 Use Overstrikepopup OverstrikesPopup 1 = enable the overstrike popup.
 0 = disable the overstrike popup
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 Input Tab (Classic Edition Only)
 Table 23: Configuration dialog: KeyboardLabel Parameter Description
 Input tablesearch path aplkeys A list of directories to be searched for the
 specified input table
 Input table file aplk The name of the input table file (.DIN)
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 Output Tab (Classic Edition Only)
 Table 24: Configuration dialog: OutputLabel Parameter Description
 Output tablesearch path apltrans A list of directories to be searched for the
 specified output table
 Output tablefile aplt The name of the output table file (.DOT)
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 Keyboard Shortcuts Tab
 To alter the keystroke associated with a particular action, simply select the actionrequired and press the keystroke. For example, to change the keystroke associatedwith the action <UA> (undo all changes) from (None) to Ctrl+Shift+u, simply selectthe corresponding row in the list and press Ctrl+Shift+u. IfConfirm before Overwriteis checked, you will be prompted to confirm or cancel before each and every changeis written back to the registry.
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 Workspace Tab
 Table 25: Configuration dialog:WorkspaceLabel Parameter Description
 Workspacesearch path wspath
 A list of directories to be searched for thespecified workspace when the userexecutes )LOAD wsname
 Maximumworkspace size(kB)
 maxws The maximum size of the workspace inKB. Default is 16384.
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 Help/DMX Tab
 Table 26: Configuration dialog: Help/DMXLabel Parameter Description
 DMX messagesshould go to DMXOUTPUTONERROR
 If checked, these boxes causeAPL to display ⎕DMX messagesin the corresponding window(s).
 Use Microsoft'sdocumentationcentre for non-Dyalog topics
 UseDefaultHelpCollection
 If this option is checked, APLwill look for help atMicrosoft's documentaioncenter for the the current stringunder the cursor.
 URL DefaultHelpCollection The url for the documentationcenter.
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 Windows Tab
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 Table 27: Configuration dialog:Windows (EditWindows)Label Parameter Description
 Width edit_cols The maximum number of rows displayedin a new edit window
 Height edit_rows The maximum number of columnsdisplayed in a new edit window
 X Pos edit_first_xThe initial horizontal position incharacters of the first edit window relativeto the Session window
 Y Pos edit_first_yThe initial vertical position in charactersof the first edit window relative to theSession window
 X Offset edit_offset_xThe initial horizontal position incharacters of the second and subsequentedit windows relative to the previous one
 Y Offset edit_offset_yThe initial vertical position in charactersof the second and subsequent editwindows relative to the previous one
 Table 28: Configuration dialog:Windows (Trace Windows)Label Parameter Description
 X Pos trace_first_xThe initial horizontal position incharacters of the first trace windowrelative to the Session window
 Y Pos trace_first_yThe initial vertical position in charactersof the first trace window relative to theSession window
 X Offset trace_offset_x
 The initial horizontal position incharacters of the second and subsequenttrace windows relative to the previousone
 Y Offset trace_offset_yThe initial vertical position in charactersof the second and subsequent tracewindows relative to the previous one
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 Table 29: Configuration dialog:Windows (QuadSMWindow)Label Parameter Description
 Width sm_cols The width of the ⎕SM and prefectwindows
 Height sm_rows The height of the ⎕SM and prefectwindows
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 Session Tab
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 Table 30: Configuration dialog: SessionLabel Parameter Description
 ⎕IO default_io The default value of ⎕IO in a clearws.
 ⎕ML default_ml The default value of ⎕ML in a clear ws
 ⎕PP default_pp The default value of ⎕PP in a clearws.
 ⎕RTL default_rtl The default value of ⎕RTL in a clearws.
 ⎕RL default_rl The default value of ⎕RL in a clearws.
 ⎕DIV default_div The default value of ⎕DIV in a clearws.
 ⎕WX default_wx The default value of ⎕WX in a clearws.
 Auto PW auto_pwIf checked, the value of ⎕PW is dynamicand depends on the width of the SessionWindow.
 Session file session_file The name of the Session file in which thedefinition of your session (⎕SE) is stored.
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 Log Tab
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 Table 31: Configuration dialog: LogLabel Parameter Description
 Use Session logfile log_file_inuse Specifies whether or not the Session log
 is saved in a session log file
 Use Session logfile log_file The full pathname of the Session log file
 Confirm onDeletion fromSession log
 confirm_session_delete
 Specifies whether or not you areprompted to confirm the deletion of a linefrom the Session (and Session log).
 Session log size(Kb) log_size The size of the Session log buffer in Kb
 Input buffer size(Kb) input_size
 The size of the buffer used to storemarked lines (lines awaiting execution) inthe Session
 History size(Kb) history_size
 The size of the buffer used to storepreviously entered (input) lines in theSession
 PFKey buffersize(Kb) pfkey_size The size of the buffer used to store PFKey
 definitions (⎕PFKEY)
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 Trace/Edit Tab
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 Table 32: Configuration dialog: Trace/EditLabel Parameter Description
 Classic Dyalogmode ClassicMode Selects pre-Version 9 behaviour for
 Edit and Trace windows
 Allow floatingedit windows DockableEditWindows
 Allows individual Edit windowsto be undocked from (and re-docked in) the main Edit window
 Allow sessionabove editwindows
 SessionOnTopSpecifies whether or not theSession may appear on top of Editand Trace Windows
 Single tracewindow SingleTrace Specifies whether or not there is a
 single Trace window
 Show statusbars StatusOnEdit
 Specifies whether or not status barsare displayed along the bottom ofindividual Edit windows
 Show tool bars ToolBarsOnEditSpecifies whether or not tool barsare displayed along the top ofindividual Edit windows
 Show tracestack on error Trace_on_error
 Specifies whether or not the Traceris automatically invoked when anerror or stop occurs in a definedfunction
 Warn if tracestack biggerthan
 Trace_level_warnSpecifies the maximum stack sizefor automatic deployment of theTracer.
 Confirm on editwindow close confirm_close
 Specifies whether or not aconfirmation dialog is displayed ifthe user alters the contents of anedit window, then closes itwithout saving
 Confirm on editwindow fix confirm_fix
 Specifies whether or not aconfirmation dialog is displayed ifthe user alters the contents of anedit window, then saves it usingFix or Exit
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 Label Parameter Description
 Confirm on editwindow abort confirm_abort
 Specifies whether or not aconfirmation dialog is displayed ifthe user alters the contents of anedit window, then aborts using
 Autoformatfunctions AutoFormat
 Selects automatic indentation forControl Structures when functionis opened for editing
 Autoindentfunctions AutoIndent
 Selects semi-automatic indentationfor Control Structures whileediting
 Double-click toEdit DoubleClickEdit
 Specifies whether or not double-clicking  over a name invokes theeditor
 Paste text asUnicode UnicodeToClipboard
 Specifies whether or not texttransferred to and from theWindows clipboard is to be treatedas Unicode
 Tab stops every TabStops The number of spaces inserted bypressing Tab in an edit window
 Exit and fix ... See Fixing Scripts below
 If not ... See Fixing Scripts below
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 Fixing ScriptsWhen using the Editor to edit a script such as a Class or Namespace you can specifywhether, when you Fix the script and Exit the Editor, just the functions in the scriptare re-fixed, or whether the whole script is re-executed, thereby re-initialising anyFields or variables defined within.
 These two actions always appear in the Editor File menu, but you can specify whichis associated with the <EP> (Esc) key by selecting the appropriate option in thedrop-downs labelled:
 l Exit and save changes (EP) in a suspended class or namespace should fix:l If not suspended fix:
 In both cases, you may select eitherOnly Functions or Everything.
 The label for the corresponding items on the Editor File menu (see "The File Menu(editing a script)" on page 219) will change according to which behaviour applies.Note that if you specify a keystroke for <S1> in the Keyboard Shortcuts tab, this willbe associated with the unselected action.

Page 153
                        

Chapter 2: The APL Environment 149
 Auto Complete Tab
 Note: To enter values in the OK Key and Cancel Keyfields, click on the field with themouse and then press the desired keystroke.
 Table 33: Configuration dialog: Auto CompleteLabel Parameter Description
 Use AutoComplete Enabled Specifies whether or not Auto
 Completion is enabled.
 Makesuggestionsafter
 PrefixSize
 Specifies the number of charactersyou must enter before AutoCompletion begins to makesuggestions
 Delaycompletion for KeyboardInputDelay
 Specifies the delay in millisecondsbefore Auto Completion begins tomake suggestions
 Suggest up to RowsSpecifies the maximum number ofrows (height) in the AutoCompletepop-up suggestions box.
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 Label Parameter Description
 Show up to Cols
 Specifies the maximum number ofcolumns (width) in theAutoComplete pop-up suggestionbox
 Keep History HistorySpecifies whether or notAutoComplete maintains a list ofprevious AutoCompletions.
 History Length HistorySize Specifies the number of previousAutoCompletions that are maintained
 Includefilenames ShowFiles
 Specifies whether or notAutoCompletion suggests directoryand file names for )LOAD, )COPYand )DROP system commands.
 OK Key CompleteKey1CompleteKey2
 Specifies two possible keys that maybe used to select the current optionfrom the Auto Complete suggestionbox.
 Cancel Key CancelKey1CancelKey2
 Specifies two possible keys that maybe used to cancel (hide) the AutoComplete suggestion box.
 Common Key CommonKey1
 Specifies the key that will auto-complete the common prefix. This isdefined to be the longest string ofleading characters in the currentlyselected name that is shared by atleast one other name in the AutoComplete suggestion box.
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 SALTSALT is the Simple APL Library Toolkit, a simple source code management systemfor Classes and script-based Namespaces. SPICE uses SALT to manage developmenttools which “plug in” to the Dyalog session
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 Table 34: Configuration dialog: SALTLabel Parameter Description
 EnableSalt AddSALT Specifies whether or not SALT is enabled
 Comparecommandline
 CompareCMDThe command line for a 3rd party filecomparison tool to be used to comparetwo versions of a file. See note.
 Editor Editor Name of the program to be used to editscript files (default "Notepad").
 Classsourcefolders
 SourceFolder Sets the SALT working directory; a list offolders to be searched for source code.
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 User Commands Tab
 This page is used to specify and organise a list of folders that contain User-Commandfiles. When you issue a User Command, these folders will be searched for the sourceof the command in the order in which they appear in this list.
 Table 35: Configuration dialog: User CommandsLabel Parameter Description
 Source Folders SALT\CommandFolderUse this field to add folders to thelist of folders that will be searchedfor User Commands.

Page 158
                        

Chapter 2: The APL Environment 154
 Object Syntax Tab
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 Table 36: Configuration dialog: Object SyntaxLabel Parameter Description
 Exposeproperties ofGUINamespaces
 default_wx
 Specifies the value of ⎕WX in a clearworkspace. This in turn determineswhether or not the names ofproperties, methods and events ofGUI objects are exposed. If set (⎕WXis 1), you may query/set propertiesand invoke methods directly as ifthey were variables and functionsrespectively. As a consequence, thesenames may not be used for globalvariables in GUI objects.
 Exposeproperties ofRoot
 PropertyExposeRoot
 Specifies whether or not the names ofproperties, methods and events of theRoot object are exposed. If set, youmay query/set the properties of Rootand invoke the Root methods directlyas if they were variables andfunctions respectively. As aconsequence, these names may not beused for global variables in yourworkspace.
 Exposeproperties ofSessionNamespace
 PropertyExposeSE
 Specifies whether or not the names ofproperties, methods and events of theSession object are exposed. If set, youmay query/set the properties of ⎕SEand invoke ⎕SE methods directly asif they were variables and functionsrespectively. As a consequence, thesenames may not be used for globalvariables in the ⎕SE namespace.
 The Object Syntax tab of the Configuration dialog is used to set your default pref-erences for Object Syntax.
 The Object Syntax settings for the current workspace are reflected by the ObjectSyntax submenu of the Optionsmenu. Use Options/Object Syntax to change them.These settings are saved in the workspace.
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 .Net FrameworkTab
 This dialog box allows you to specify which version of the .Net Framework youwant to use with Dyalog APL. It is only necessary to do this if you have more thanone version of the .Net Framework installed.
 If Specify .Net Version is selected, APL will display the versions of the .Net Frame-work that are installed in the combo box below.
 Choose the version you require and click OK.
 Unlike the other configuration dialogs, which typically set values in the Registry,this dialog creates a configuration file dyalog.exe.config in the same directoryas the Dyalog APL program. Note the following:
 l Version 13.2 does not read the contents of an existingdyalog.exe.config file.
 l For .Net Version 2, no configuration file is required; if you select Version 2having previously selected Version 4, the file will be deleted.
 l You will need suitable permissions to write the configuration file, or deleteit – you may wish to start APL by right clicking on the Dyalog shortcutand selecting Run as administrator.
 The dialog box shows the contents of this file as illustrated above.
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 Colour Selection Dialog
 The Colour Selection dialog box allows you to select colours for:
 l Syntax colouringl Edit, Trace and Session windowsl Status window
 The colour selection dialog box is selected by the [ChooseColor] system actionwhich by default is attached to the Options/Coloursmenu item on the Session menu-bar and to the Coloursmenu item in the Session pop-up menu.
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 Syntax ColouringSyntax colouring allows you to visually identify various components in the functionedit and session windows by assigning different colours to them, such as:
 l Global references (functions and variables)l Local references (functions and variables)l Primitive functionsl System functionsl Localised System Variablesl Commentsl Character constantsl Numeric constantsl Labelsl Control Structuresl Unmatched parentheses, quotes, and braces
 SchemesYou may define a number of different syntax colouring schemes which are suitablefor different purposes and a selection of schemes is provided. Choose the scheme youwish to use from the Combo box provided. If you change a colour allocation, youmay overwrite an existing Colour Scheme or define a new one by clicking Save Asand then entering the name of the Scheme. You may delete a Colour Scheme usingthe Delete button.
 Changing ColoursTo allocate a colour to a syntax element, you must first select the syntax element.You may select a syntax element from the Combo box provided, or by clicking on anexample in the sample function provided. Having selected a syntax element, choosea colour using the Foreground or Background selectors as appropriate.
 Show IdiomsThe Show Idioms checkbox allows you to choose whether or not idioms are to beidentified by syntax colouring.
 Single BackgroundThe Single Background checkbox allows you to choose whether to impose a singlebackground colour, or to allow the use of different background colours for differentsyntax elements.
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 Function EditorCheck this box if you want to enable syntax colouring in Edit windows.
 Function TracerCheck this box if you want to enable syntax colouring in Trace windows.
 Session InputCheck this box if you want to enable syntax colouring in the Session window. Notethat the colour scheme used for the Session may differ from the colour schemeselected for Edit windows and is specified by the Session Colour Scheme box on theSession/Trace tab.
 Only current input lineThis option only applies if Session syntax colouring is enabled. Check this box ifyou want syntax colouring to apply only to the current input line. Clear this box, ifyou want to apply syntax colouring to all the input lines in the current Session win-dow. Note that syntax colouring of input lines is not remembered in the Session log,so input lines from previous sessions do not have syntax colouring.
 HotKeysYou may associate different hot key with any or all of your colour schemes.
 When you depress a hot key over a function in an Edit window, the function is dis-played using the scheme associated with the hot key. Releasing the hot key causes itto be displayed in the normal scheme.
 This feature is intended to allow you to quickly check for certain syntax elements.For example, you may define a special scheme that only highlights global names andassociate a hot key with it. Pressing the hot key will temporarily highlight the glob-als for you.
 To associate a hot key with a colour scheme, click on the Hotkey field, and thenmake the desired keystroke. To disassociate a hot key, use <backspace>.
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 Print Configuration Dialog BoxThe Print Configuration dialog box is displayed by the system operation[PrintSetup] that is associated with the File/Print Setup menu item. It is alsoavailable from Edit windows and from theWorkspace Explorer and Find Objectstools.
 There are four separate tabs namely Setup,Margins,Header/Footer and Printer.
 Note that the printing parameters are stored in the Registry in the Printing sub-folder
 Setup Tab
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 Table 37: Print Configuration dialog: SetupLabel Parameter Description
 Color scheme InColour
 Check this box if you want to printfunctions with syntax colouring. Notethat that printing in colour is slower thanprinting without colour.
 Color scheme SchemeName Select the colour scheme to be used forprinting.
 This text WrapWithText
 Check this option button if you wish toprefix wrapped lines (lines that exceedthe width of the paper) with a particulartext string
 This text WrapLeadText Specifies the text for prefixing wrappedlines
 This manyspaces WrapWithSpaces Check this option button if you wish to
 prefix wrapped lines with spaces.
 This manyspaces WrapLeadSpaces
 Specifies the number of spaces to beinserted at the beginning of wrappedlines.
 Line numberson functions LineNumsFns Check this box if you want line numbers
 to be printed in defined functions.
 Line numberson variables LineNumsVars
 Check this box if you want line numbersto be printed in variables. If you choosethis option, line numbering starts at ⎕IO.
 Font FontClick to select the font to be used forprinting. Note that only fixed-pitch fontsare supported.
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 Margins Tab
 Table 38: Print Configuration dialog:MarginsLabel Parameter Description
 Use margins UseMargins Check this box if you want margins toapply
 Left margin MarginLeft Specifies the width of the left margin
 Right margin MarginRight Specifies the width of the right margin
 Top margin MarginTop Specifies the height of the top margin
 Bottom margin MarginBottom Specifies the height of the bottom margin
 Inches MarginInch Specifies that the margin units are inches
 Centimetres MarginCM Specifies that the margin units arecentimetres
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 Header/Footer Tab
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 Table 39: Print Configuration dialog: Header/FooterLabel Parameter Description
 Header DoHeader Specifies whether or not a header isprinted at the top of each page
 Header HeaderText The header text
 Footer DoFooter Specifies whether or not a footer isprinted at the bottom of each page
 Footer FooterText The footer text
 Prefix functionswith DoSepFn Specifies whether or not text is printed
 before each defined function
 Prefix functionswith SepFnText
 The text to be printed before each definedfunction. This can include its name,timestamp and author
 Prefix variableswith DoSepVar Specifies whether or not text is printed
 before each variable.
 Prefix variableswith SepVarText The text to be printed before each
 variable. This can include its name.
 Prefix otherobjects with DoSepOther
 Specifies whether or not text is printedbefore other objects. These include lockedfunctions, external functions, ⎕NAfunctions, derived functions andnamespaces.
 Prefix otherobjects with SepOtherText The text to be printed before other
 objects. This can include its name.
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 The specification for headers and footers may include a mixture of your own text, andkeywords which are enclosed in braces, e.g. {objname}. Keywords act like variablesand are replaced at print time by corresponding values.
 Any of the following fields may be included in headers, footers and separators.
 {WSName} {WS} Workspace name{NSName} {NS} Namespace name{ObjName} {OB} Object name{Author} {AU} Author{FixDate} {FD} Date function was last fixed{FixTime} {FT} Time function was fixed{PrintDate} {PD} Today's date{PrintTime} {PT} Current time{CurrentPage} {CP} Current page number{TotalPages} {TP} Total number of pages{RightJustify} {RJ} Right-justifies subsequent text/fields{HorizontalLine} {HL} Inserts a horizontal line{CarriageReturn} {CR} Inserts a new-line
 For example, the specification:
 Workspace: {wsname} {objname} {rj} Printed {PrintTime} {PrintDate}
 would cause the following header, footer or separator to be printed at the appropriateposition in each page of output:
 Workspace: U:\WS\WDESIGN WIZ_change_toolbar   Printed 14:40:11 02 March1998
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 Printer Tab
 Table 40: Print Configuration dialog: PrintLabel Parameter Description
 Name PrinterField The name of the printer to be used forprinting from Dyalog APL.
 Properties Click this to set Printer options.
 Where Reports the printer device
 Print
 Allows you to choose between printingall of the current object or just theselection. Note that this option is presentonly when the dialog box is displayed inresponse to selecting Print.
 Status Window
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 The Status window is used to display systemmessages and supplementary infor-mation. These include the operations that take place when you register an OLEServeror ActiveXControl.
 The Status window is also used to display supplementary information about errors.For example, if in a ⎕WC statement you misspell the type of an object, you will get asuitable error message in the Status window, in addition to the DOMAIN ERRORmes-sage in the Session.
 Example'F'⎕WC'FROM' ⍝ Should be 'FORM'
 DOMAIN ERROR'F'⎕WC'FROM'
 ^
 The Status window can be explicitly displayed or hidden using the [Status] sys-tem operation which is associated with the Tools/Statusmenu item.
 There is also an option to have the Status window appear automatically whenever anew message is written to it. This option is selected using the [AutoStatus] sys-tem operation which is associated with the Tools/AutoStatusmenu item.
 Note that when you close the Status window, all the systemmessages in it arecleared.
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 The Workspace Explorer ToolThe Explorer tool is a modeless dialog box that may be toggled on and off by the sys-tem action [Explorer]. In a default Session, this is attached to a MenuItem in theToolsmenu and a Button on the session toolbar.
 The Explorer contains two sub-windows. The one on the left displays the namespacestructure of your workspace using a TreeView. The right-hand window is a ListViewthat displays the contents of the namespace that is selected in the TreeView.
 The Explorer is closely modelled on theWindows Explorer in Windows and the facil-ities it provides are very similar. ForWindows users, the operation of this tool is prob-ably self-explanatory. However, other users may find the following discussion useful.
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 Exploring the WorkspaceThe TreeView displays the structure of your workspace. Initially it shows the rootand Session namespaces # and ⎕SE. The icon for # is open indicating that its con-tents are those that appear in the ListView. You can expand or collapse the TreeViewof the workspace structure by clicking on the mini-buttons (labelled + and -) or bydouble-clicking the icons. A single click on a closed namespace icon opens it andcauses its contents to be displayed in the ListView. Another way to open a names-pace is to double-click its icon in the ListView. Only one namespace can be open ata time. The icons used in the display are described below.
 Class
 Namespace (closed)
 GUI Namespace (closed)
 Namespace (open)
 GUI Namespace (open)
 Function
 Variable
 Operator
 Indicates an object that has been erased
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 Viewing and Arranging ObjectsThe ListView displays the contents of a namespace in one of four different waysnamely Large Icon view, Small Icon view, List view orDetails view. You can switchbetween views using the View menu or the tool buttons that are provided. In the firstthree views, the system displays the name of the object together with an icon thatidentifies its type. In Details view, the system displays several columns of additionalinformation. You may resize the column widths by dragging or double-clicking thelines in the header. To hide a column, drag its width to the far left. The additional col-umns are:
 LocationThis is the namespace containing the object. By definition, thisis the same for all of the objects shown in the ListView and isnormally hidden
 Description
 For a function or operator, this is the function header stripped oflocalised names and comment. For a variable, the descriptionindicates its rank, shape and data type. For a namespace, thedescription indicates the nature of the namespace; a plainnamespace is described as namespace, a GUI Form object isdescribed as Form, and so forth.
 Size The size of the object as reported by ⎕SIZE.
 Modifiedon
 For functions and operators, this is the timestamp when theobject was last fixed. For other objects this field is empty.
 Modifiedby
 For functions and operators, this is the name of the user who lastfixed the object. For other objects this field is empty.
 In any view, you may arrange the objects in ascending order of name, size, timestampor class by clicking the appropriate tool button. In Details view, you may sort inascending or descending order by clicking on the appropriate column heading. Thefirst click sorts in ascending order; the second in descending order.
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 Moving and Copying ObjectsYou can move and copy objects from one namespace to another using drag-drop orfrom the Edit menu.
 To move one or more objects using drag-and-drop editing:
 1. Select the objects you want to move in the ListView.2. Point to one of the selected objects and then press and hold down the left
 mouse button. When the drag-and-drop pointer appears, drag the object(s) toanother namespace in the TreeView. To indicate which of the namespaces isthe current target, its name will be highlighted as you drag the selectedobject(s) over the TreeView.
 3. Release the mouse button to drop the objects into place. The objects willdisappear from the ListView because they have been moved to anothernamespace.
 To copy one or more objects using drag-and-drop editing, the procedure is the sameexcept that you must press and hold the Ctrl key before you release the mouse button.
 You may also move and copy objects using the Edit menu. To do so, select the object(s) and then chooseMove orCopy from the Edit menu. You will be prompted for thename of the namespace into which the objects are to be moved or copied. Enter thenamespace and click OK.
 Editing and Renaming ObjectsYou can open up an edit window for a function or variable by double-clicking itsicon, or by selecting it and choosing Edit from the Edit menu or from the popupmenu. You may rename an object by clicking its name (as opposed to its icon) andthen editing this text. You may also select the object and choose Rename from theEdit menu or from the popup menu. Note that when you rename an object, the orig-inal name is discarded. Unlike changing a function name in the editor, this is not acopy operation.
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 Using the Explorer as an EditorIf you open the Fns/Ops item, the names of the functions and operators in the names-pace are displayed below it alphabetically in the left (tree view) pane. When youselect one of these names, the function itself is opened in the right (list view) pane.
 You may use this feature to quickly cycle through the functions (or variables) in anamespace, pressing cursor up and cursor down in the left (tree view) pane to movefrom one to another.
 You may also edit the function directly in the right (list view) pane before moving onto another.
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 The File Menu
 The Filemenu, illustrated above, provides the following actions. All but Print setupand Close act on the object or objects that are currently selected in the ListView.
 Print Prints the object(s).
 Printsetup Displays the Print Configuration dialog box.
 Delete Erases the object(s).
 Rename Renames the object. This option only applies when a singleobject is selected.
 Properties Displays a property sheet; one for each object that is selected.
 Close Closes the Explorer
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 The Edit Menu
 The Edit menu, illustrated above, provides the following actions. The Edit, Copy andMove operations act on the object or objects that are currently selected in the List-View.
 Edit Opens an edit window for each of the objects selected.
 Copy Prompts for a namespace and copies the object(s) there.
 Move Prompts for a namespace and moves the object(s) there.
 SelectFunctions Selects all of the functions and operators in the ListView.
 SelectVariables Selects all of the variables in the ListView.
 Select None Deselects all of the objects in the ListView.
 Select All Selects all of the objects in the ListView.
 InvertSelection
 Deselects the selected objects and selects all those that werenot selected.
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 The Options Menu
 The Options menu, illustrated above, provides the following actions.
 Toolbar Displays or hides the Explorer toolbar.
 ToolbarCaptions Displays or hides the button captions on the Explorer toolbar.
 StatusBar Displays or hides the Explorer statusbar.
 TypeLibraries Enables/disables the exploring of Type Libraries
 ExpandAll
 Expands all namespaces and sub-namespaces in the TreeView,providing a complete view of the workspace structure, includingor excluding the Session object ⎕SE.
 RefreshNow
 Redisplays the TreeView and ListView with the current structureand contents of the workspace. Used if Auto Refresh is notenabled.
 AutoRefresh
 Specifies whether or not the Explorer immediately reflectschanges in the active workspace.
 If Auto Refresh is checked the Explorer is updated every time APL returns to desk-cal-culator mode. This means that it is always in step with the active workspace. If youhave a large number of objects displayed in the Explorer, the update may take a fewseconds and you may wish to prevent this by un-checking this menu item  If you doso, the Explorer must be explicitly updated by selecting the Refresh Now action.
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 The View Menu
 The View menu, illustrated above, provides the following actions.
 Columns Allows you to select which columns you wish to display.
 LargeIcons Selects Large Icon view in the ListView.
 SmallIcons Selects Small Icon view in the ListView.
 List Icons Selects List view in the ListView.
 Details Selects Details view in the ListView.
 Scope Allows you to choose whether the Explorer displays objects inlocal scope or in global scope.
 ArrangeIcons Sorts the items in the ListView by name, type, size or date.
 Line upIcons Rearranges the icons into a regular grid.
 AutoArrange
 If checked, the icons are automatically re-arranged whenappropriate
 .
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 The Tools Menu
 The Toolsmenu, illustrated above, provides the following actions.
 Find Displays the Find Objects Tool
 Go to Prompts for a namespace and then opens that namespace in theTreeView, displaying its contents in the ListView
 Go toSessionSpace
 Opens the namespace in the TreeView control corresponding tothe current space in the Session.
 Set SessionSpace
 Sets the current space in the Session to be the namespace that iscurrently open in the TreeView.
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 Browsing ClassesClasses are represented by icons. The picture below shows 3 classes: Bird,Parrot and DomesticParrot.
 If you open the # node in the left-hand pane, you see the contents of # as a tree.
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 Browsing Class ScriptsSelecting DomesticParrot in the left-hand pane brings up its Class Script in theright-hand pane.
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 …and selecting Parrot in the left-hand pane brings up the Class Script forParrot.
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 …and finally, selecting Bird in the left-hand pane brings up the Class Script forBird.
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 If you open a Class node, a tree appears to help you to navigate within the Classscript. In the picture below, the user has opened the [Methods] node and thenclicked on Speak. The system has responded by scrolling to (if necessary) and high-lighting the appropriate section of the script.

Page 187
                        

Chapter 2: The APL Environment 183
 Browsing Type LibrariesWhen the View/Type Libraries option is enabled, theWorkspace Explorer allowsyou to:
 l Browse the Type Libraries for all the COM server objects that are installedon your computer, whether or not they are loaded in your workspace.
 l Load Type Libraries for COM objectsl Browse the Type Library associated with an OLEClient object that is
 already instantiated in the workspace.
 If the Microsoft .Net Framework is installed, you may in addition:
 l Load Metadata for specific .Net classesl Browse the loaded Metadata, viewing information about classes, methods,
 properties and so forth.
 If the Type Libraries option is enabled, theWorkspace Explorer displays a folderlabelled TypeLibswhich, when opened, displays two others labelled LoadedLibraries and Registered Libraries as shown below.
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 Browsing Registered LibrariesIf you open the Registered Libraries folder, theWorkspace Explorerwill display inthe tree view pane the names of all the Type Libraries associated with the COMServer objects that are installed on your computer.
 If you select one of these Library names, some summary information is displayed inthe list view pane.
 For example, the result of selecting the Microsoft Excel 9.0 Object Library is illus-trated below.
 If instead, you select the Registered Libraries folder itself, the list of Registered TypeLibraries is displayed in the list view pane
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 Loading a Type LibraryYou can load a library shown in the list view pane by double-clicking its name.
 Alternatively, you can load a library shown in the tree view pane by selecting Loadfrom its context menu.
 In either case, a message box will appear asking you to confirm. The operation toload a Type Library may take a few moments to complete.
 Notice that if the selected Library references any other libraries, they too will beloaded. For example, loading theMicrosoft Excel 9.0 Object Library brings in theMicrosoft Office 9.0 Object Library and theMicrosoft Visual Basic for ApplicationsExtensibility 5.3 Library too. It also contains references to a general library called theOLE Automation Type Library, so this is also loaded.
 When you )SAVE your workspace, all of the Type Libraries that you have loadedwill be saved with it. Note that type library information can take up a considerableamount of workspace.
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 Browsing Loaded LibrariesIf you have already loaded any Type Libraries into the workspace, using the Work-space Explorer or as a result of creating one or more OLEClient objects, you canselect and open the Loaded Libraries folder.
 The picture below illustrates the effect of having loaded the Microsoft Excel 9.0Object Library.
 Notice that any external references to other libraries causes these to be brought intoo.
 If you select a loaded Type Library, summary information is displayed in the listview pane.
 If you open a loaded Type Library, four sub-folders appear named Object CoClasses,Objects, Enums and Event Sets respectively.
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 Object CoClassesA Type Library describes a number of objects. Typically, all of the objects have prop-erties and methods, but only some of them, perhaps just a few, generate events.Objects which generate events are represented by CoClasses, each of which has apointer to the object itself and a pointer to an event set.
 For example, the Microsoft Excel 9.0 Object Library contains seven CoClassesnamed Application, Chart,Global etc as shown below.
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 Opening the Application folder you can see that the Application CoClass comprisesthe _Application object coupled with the AppEvents event set as shown below.
 The specific methods, properties and events supported by the CoClass object can beexamined by opening the appropriate sub-folder. The same information for these andother objects is also accessible from the Objects and Event Sets folders as discussedbelow.
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 ObjectsThe Objects folder contains several sub-folders each of which represents a namedobject defined in the library.
 Each object folder contains two sub-folders named Methods and Properties. Selectingone of these causes the list of Methods or Properties to be displayed in the list viewpane. The picture below shows the Methods exposed by the Microsoft Excel 9.0Range object.
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 If you open theMethods or Properties subfolder, you can display more detailed infor-mation about individual Methods and Properties. For example, the following pictureshows information about the SaveAsmethod exposed by the Microsoft Excel 9.0Worksheet object.
 This tells you that the SaveAsmethod takes up to 9 parameters of which the first, File-name, is mandatory and is of data type VT_BSTR (a character string). Note that [in]indicates that the parameter is an input parameter.
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 Incidentally, the optional Fileformat parameter is an example of a parameter whosevalue must be one of a list of Enumerated Constants. Even without looking at the doc-umentation, the possible values can be deduced by browsing the Enums folder, withthe results shown below.
 You can therefore deduce that the following expression, executed in the namespaceassociated with the currently active worksheet, will save the sheet in comma-sep-arated format (CSV) in a file called mysheet.csv:
 SaveAs 'MYSHEET.CSV' xlCSV
 or
 SaveAs 'MYSHEET.CSV' 6
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 Event SetsThe Event Sets folder contains several sub-folders each of which represents a namedset of events generated by the objects defined in the library.
 If you open one of these event sets, the names of the events it contains are displayedin the tree view pane. If you then select one of the events, its details are displayed inthe list view pane as shown below.
 This example shows that when it fires, the SheetActivate event invokes your call-back function with a single argument named Sh whose datatype is VT_DISPATCH(in practice, a Worksheet object).
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 EnumsThe Enums folder will typically contain several sub-folders each of which representsa named set of enumerated constants.
 If you select one of these sets, the names and values of the constants it contains aredisplayed in the list view pane as shown below.
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 Browsing .Net ClassesMicrosoft supplies a tool for browsing .NET Class libraries called ILDASM.EXE1.
 As a convenience, the Dyalog APLWorkspace Explorer has been extended to per-form a similar task as ILDASM so that you can gain access to the information withinthe context of the APL environment.
 The information that describes .NET classes, which is known as itsMetadata, is partof the definition of the class and is stored with it. This Metadata corresponds to TypeInformation in COM, which is typically stored in a separate Type Library.
 To enable the display ofMetadata in the Workspace Explorer, you must have theType Libraries option of the View menu checked.
 1 ILDASM.EXE can be found in the .NET SDK and is distributed with Visual Studio
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 To gain information about one or more Net Classes, open the Workspace Explorer,right click theMetadata folder, and choose Load.
 This brings up the Browse .Net Assembly dialog box as shown below. Navigate to the.NET assembly of your choice, and click Open.
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 Note that the .NET Classes provided with the .NET Framework are typically locatedin C:\WINDOWS\Microsoft.NET\Framework\V2.0.50215. The last namedfolder is the Version number.
 The most commonly used classes of the .NET Namespace System are stored in thisdirectory in an Assembly named mscorlib.dll, along with a number of other fun-damental .NET Namespaces.
 The result of opening this Assembly is illustrated in the following screen shot. Thesomewhat complex tree structure that is shown in the Workspace Explorer merelyreflects the structure of the Metadata itself.
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 Opening the System/ Classes sub-folder causes the Explorer to display the list ofclasses contained in the .NET Namespace System as shown in the picture below.
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 The Constructors folder shows you the list of all of the valid constructors and theirparameter sets with which you may create a new instance of the Class by callingNew. The constructors are those named .ctor; you may ignore the one named .cctor,(the class constructor) and any labelled as Private.
 For example, you can deduce that DateTime.Newmay be called with threenumeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. Thereare in fact seven different ways that you can create an instance of a DateTime.
 For example, the following statement may be used to create a new instance ofDateTime (09:30 in the morning on 30th April 2001):
 mydt←⎕NEW DateTime (2001 4 30 9 30 0)
 mydt30/04/2001 09:30:00
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 The Properties folder provides a list of the properties supported by the Class. Itshows the name of the property followed by its data type. For example, theDayOfYear property is defined to be of type Int32.
 You can query a property by direct reference:
 mydt.DayOfWeekMonday
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 Notice too that the data types of some properties are not simple data types, butClasses in their own right. For example, the data type of the Now property is itselfSystem.DateTime. This means that when you reference the Now property, youget back an object that represents an instance of the System.DateTime object:
 mydt.Now07/11/2001 11:30:48
 ⎕TS2001 11 7 11 30 48 0
 TheMethods folder lists the methods supported by the Class. The Explorer shows thedata type of the result of the method, followed by the name of the method and thetypes of its arguments. For example, the IsLeapYear method takes an Int32parameter (year) and returns a Boolean result.
 mydt.IsLeapYear 20001
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 Many of the reported objects are listed as Private, which means they are inaccessibleto users of the class – you are not able to call them or inspect their value. For moreinformation about classes, see the chapter on Object Oriented Programming in theDyalog APL Language Reference Manual.
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 Find Objects ToolThe Find Objects tool is a modeless dialog box that may be toggled on and off by thesystem action [WSSearch]. In a default Session, this is attached to a MenuItem inthe Tools menu and a Button on the session toolbar. This tool allows you to searchthe active workspace for objects that satisfy various criteria.
 The first page allows you to specify the name of the object which you wish to findand the namespace(s) in the workspace that are to be searched for it.
 You type the name of the object you wish to find into the field labelled Named. Tolocate all objects beginning with a particular string, enter the string followed by a '*'character. For example, if you enter the string FOO*, the system will locate all objectswhose name begins with FOO.
 Four check boxes are provided for you to specify the types of objects you wish tolocate. For example, if you clear Variables,Operators and Namespaces, the systemwill only search for functions.
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 You can restrict the search to a particular namespace by typing its name into the fieldlabelled Look in. You can also restrict the search by clearing the Include sub-namespaces and Include Session namespace check boxes. Clearing the formerrestricts the search to the root namespace or to the namespace that you have specifiedin Look in, and does not search within any sub-namespaces contained therein. Clear-ing the latter causes the system to ignore ⎕SE in its search.
 The second page, labelled Modified, allows you to search for objects that have beenmodified by a particular user or at a certain time
 To make the search dependent upon modification, you must check theModifiedObjects check box.
 To locate objects modified by a particular user, enter the user name in the fieldlabelled Modified by. Otherwise leave this blank.
 To find objects which have been modified at a certain time or within a specifiedperiod of time, check the appropriate radio button and enter the appropriate dates ortime spans.
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 The third page, labelled Advanced, allows you to search for objects that contain a par-ticular text string.
 If you wish to search for objects containing a particular character string, type thestring into the field labelled Containing Text.
 Match Case specifies whether or not the text search is case sensitive.
 Use Regular Expressions specifies whether or not regular expressions are applicable.For example, if you enter FOO* into the field labelled Containing Text and checkthis box, the system will find objects that contain any text string starting with the 3characters FOO. If this box is not checked, the system will find objects that containthe 4 characters FOO*.
 Match Whole Word specifies whether or not the search is restricted to entire words.
 As Symbol Reference specifies whether or not the search is restricted to APL symbols.If so, matching text in comments and other strings is ignored.
 If you wish to restrict the search to find only objects whose size is within a givenrange, check the box labelled Size is between and enter values into the fields pro-vided.
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 When you press the Find Now button, the system searches for objects that satisfy allof the criteria that you have specified on all 3 pages of the dialog box and displaysthem in a ListView. The example below illustrates the result of searching the work-space for all functions containing references to the symbol CURSOR.
 You may change the way in which the objects are displayed in the ListView usingthe View menu or the tool buttons, in the same manner as for objects displayed in theWorkspace Explorer. You may also edit, delete and rename objects in the same way.Furthermore, objects can be copied or moved by dragging from the ListView in theSearch tool to the TreeView in the Explorer.
 If you wish to specify a completely new set of criteria, press the New Search button.This will reset all of the various controls on the 3 pages of the dialog box to theirdefault values.
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 Object Properties Dialog BoxThe Object Properties dialog box displays detailed information for an APL object. Itis displayed by executing the system action [ObjProps]. In a default Session, thisis provided in the Toolsmenu, the Session popup menu and from the Explorer. Anexample (for a function) is shown below.
 Properties TabThe Properties tab displays general information about the object. For a function, thisincludes an extract from its header line, when it was last modified, and by whom.
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 Value TabFor a variable, the Values tab displays the value of the variable. For a function, it dis-plays its canonical representation.
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 Monitor TabTheMonitor tab applies only to a function and displays the result of ⎕MONITOR.The Reset button resets ⎕MONITOR for the lines on which it is currently set. The SetAll Lines button sets ⎕MONITOR to monitor all the lines in the function. The ClearAll Lines switches ⎕MONITOR off.
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 COM Properties TabThe COM Properties tab applies only to a function in an OLEServer or Activ-eXControl namespace. The tab is used to define arguments and data types for anexported Method or Property. For further information, see Interface Guide.
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 Net Properties TabThe Net Properties tab applies only to a function in a NetType namespace. The tab isused to define arguments and data types for an exported Method or Property. For fur-ther information, see .Net Interface Guide.
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 The EditorInvoking the EditorThe editor may be invoked in several ways. From the session, you can use the systemcommand )ED or the system function ⎕ED, specifying the names(s) of the object(s) tobe edited. You can also type the name of the object and then press Shift+Enter (ED),click the Edit tool on the tool bar, or select Edit from the Action menu. If you invokethe editor when the cursor is positioned on the empty input line, with a suspendedfunction in the State Indicator, the editor is invoked on the suspended function andthe cursor is positioned on the line at which it is suspended. This is termed nakededit. These ways of invoking the editor apply only in the session window
 In addition, there is a general point-and-edit facility which works in edit and tracewindows too. Simply position the input cursor over a name and double-click the leftmouse button. Alternatively, you can press Shift+Enter or select Edit from the Filemenu. The name can appear in the Session, in an Edit window, or in a Trace window;the effect is the same. Note that, in the Session, typing a name and pressingShift+Enter is actually a special case of point-and-edit. Note also that a naked editcan be invoked by double-clicking the left mouse button in the empty input line.
 The type of a new object defaults to function/operator unless the object is shadowed,in which case it defaults to a variable (vector of character vectors). You can howeverspecify the type of a new object explicitly using )ED or ⎕ED . For example, typing")ED ∊LIST -MAT" in a CLEAR WS would create Edit windows for a vector ofcharacter vectors named LIST and a character matrix called MAT. See )ED or ⎕ED fordetails.
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 If the name is not already being edited, it is assigned a new edit window. If you edit aname which is already being edited, the system focuses on the existing edit windowrather than opening a new one. Edit windows are displayed using the colour com-bination associated with the type of the object being edited.
 Window Management (Standard)Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editoris a Multiple Document Interface (MDI) window that may be a stand-alone window,or be docked in the Session window. Each of the objects being edited is displayed ina separate sub-window. Individual edit windows are managed using standard MDIfacilities.
 The initial size of an edit window is specified by the edit_rows and edit_cols param-eters. The first edit window is positioned at 0 0. Subsequent ones are staggeredaccording to the values of the edit_offset_y and edit_offset_x parameters.
 By default, the Session has the Editor docked along the right edge of the Session win-dow.When you edit a function, the Editor window automatically springs into viewas illustrated overleaf.
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 You can resize the Editor pane to view more or less of the Session itself, by draggingits title bar.
 Using the buttons in the title bar, you can instantly maximise the Editor pane toallow you to concentrate on editing, or minimise it to reveal the entire Session. Ineither case, the restore button quickly restores the 2-pane layout.
 The picture below shows the effect of maximising the Editor. The BUILD_SESSIONedit window is itself maximised within the Editor too.
 Note that when the Editor has the focus, the Editor menubar is displayed in place ofthe Session menubar.
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 Window Management (Classic Dyalog mode)IfClassic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit win-dow is a top-level window created as a child of the Session window. This means thatEdit windows always appear on top of the Session.
 The first edit window is created at the position specified by the edit_first_y andedit_first_x parameters. The initial size of an edit window is specified by the edit_rows and edit_cols parameters.
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 Subsequent ones are staggered according to the values of the edit_offset_y and edit_offset_x parameters.
 Moving around an edit windowYou can move around in the edit window using the scrollbar, the cursor keys, and thePgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-ning of the top-line in the object and Ctrl+End moves the cursor to the end of the lastline in the object. Home (LL) and End (RL) move the cursor to the beginning and endrespectively of the line containing the cursor.
 Closing an edit windowClosing an edit window from its SystemMenu has the same effect as choosing Exitfrom the FileMenu; namely that it fixes the object in the workspace and then closesthe edit window.
 Minimising an edit windowMinimising an edit window causes it to be displayed as a Dyalog APL Edit icon,with the name of the object underneath. The edit window can be restored in the nor-mal way, or by an attempt to re-edit the same name.
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 Editor ToolBar
 Toggle line numbersToggles Line numbers on/off.
 Comment selected textAdds a comment to the beginning ofthe current line or all selected lines.
 Uncomment selected textRemoves a comment (if present) fromthe current line or all selected lines.
 Save changes and returnSaves changes and closes the currentedit window.
 Search Box
 Enter search text and click one of thefollowing two buttons.
 Search for Next MatchLocates the next occurrence of thesearch text
 Search for Previous MatchLocates the previous occurrence ofthe search.
 Refactor text as methodInserts a Method template for theselected name.
 Refactor text as fieldInserts a Field template for theselected name.
 Refactor text as propertyInserts a Property template for theselected name.
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 The File Menu
 The Filemenu illustrated above is displayed when editing a simple object and pro-vides the following options.
 Fix
 Fixes the object in the workspace, but leaves the editwindow open. Edit history is also preserved. If the datahas changed and the confirm_fix parameter is set, youwill be prompted to confirm.
 Fix Script (Disabled unless editing a script)
 Edit Opens an Edit window on the name under the mousepointer. (Disabled when not).
 Print Prints the current contents of the edit window.
 Print Setup Displays the Print Configuration dialog box.
 Properties Displays the Object Properties dialog box for thecurrent object.
 Exit (and Fix)Fixes the object in the workspace and closes the editwindow. If the data has changed and the confirm_exitparameter is set, you will be prompted to confirm.
 Exit (and fixscript) (Disabled unless editing a script)
 Exit and discardchanges
 Closes the edit window, but does not fix the object inthe workspace. If the data has changed and theconfirm_abort parameter is set, you will be prompted toconfirm.
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 The File Menu (editing a script)
 The File menu illustrated above is displayed when editing a script and provides thefollowing different options from those shown on the preceding page.
 Fix whole script Fixes the entire script
 Fix only functions Fixes only the functions in the script.
 Exit and fix wholescript Fixes the entire script, and exits the Editor.
 Exit and fix onlyfunctions
 Fixes only the functions in the script and exits theEditor.
 Editing ScriptsSuppose that you have a Class that manages a list of items in a shared Field, so some-where in the script would appear a line such as:-
 :Field shared public List {gets} {zilde}
 You run your application for a bit, and List, which was initially empty, getsupdated as new instances of the Class are created. You then edit the Class to add anew function, or fix a bug. In this instance, when you exit the editor you may notwant List to be reset back to the empty vector although you do want the new ver-sion of the function(s) in the Class to be fixed.
 Nevertheless whenever you edit the Class when it is not suspended, you probablyalways want the entire script to be re-fixed, and List re-initialised.
 The options in the Filemenu shown above provide for these alternatives.
 In addition, the Configuration dialog (See "Fixing Scripts" on page 148) allows youto define the behaviour of the keystrokes <EP> and <S1> for both the suspendedcase and the non-suspended case. This association will be displayed against theappropriate action according to the state of the script you are editing.

Page 224
                        

Chapter 2: The APL Environment 220
 The Edit MenuThe Edit menu provides a means to execute those commands that are concerned withediting text. The Edit menu and the actions it provides are described below.
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 Reformat Reformats the function body in the edit window, indentingcontrol structures as appropriate.
 UndoUndoes the last change made to the object. Repeated use ofthis command sequentially undoes each change made sincethe edit window was opened.
 Redo Re-applies the previous undone change. Repeated use ofthis command sequentially restores every undone change.
 Cut Copies the selected text to the clipboard and removes itfrom the object.
 Copy Copies the selected text to the clipboard.
 Paste Copies the text in the clipboard into the object at thecurrent location of the input cursor.
 Paste Unicode Same as Paste, but gets the Unicode text from the clipboardand converts to ⎕AV
 Paste Non-Unicode
 Same as Paste, but gets the ANSI text from the clipboardand converts to ⎕AV.
 Clear Deletes the selection or the character under the cursor. Hasno effect on the clipboard
 Open Line Inserts a blank line immediately below the current one.
 Delete Line Deletes the current line.
 Goto Line Prompts for a line number, then positions the cursor on thatline.
 Find Displays the Find dialog box.
 Replace Displays the Replace dialog box.
 Commentselected lines
 Adds a comment symbol to the beginning of all selectedlines.
 UnCommentselected lines
 Removes a comment symbol from the beginning of allselected lines.
 Toggle Localname
 Adds or removes the name under the cursor to/from thefunction header line.
 The Find and Replace items are used to display the Find dialog box and theFind/Replace dialog box respectively. These boxes are used to perform search andreplace operations and are described later in this Chapter.
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 Once displayed, each of the two dialog boxes remains on the screen until it is eitherclosed or replaced by the other. This is convenient if the same operations are to be per-formed over and over again, and/or in several windows. Find and Find/Replace oper-ations are effective in the window that previously had the focus.
 The Refactor Menu
 The Refactormenu illustrated above applies only when editing a Class and providesthe following options. In each case, the user must highlight a name in the Edit win-dow, and then select one of these options to insert the appropriate template for thatname into the body of the Class.
 Add text as Field Inserts a Field template for the selected name.
 Add text as Property Inserts a Property template for the selected name.
 Add text as Method Inserts a Method template for the selected text name.
 The View Menu

Page 227
                        

Chapter 2: The APL Environment 223
 The View menu, illustrated above, provides the following actions.
 Trace Displays a column to the left of the function that displays⎕TRACE settings
 Stop Displays a column to the left of the function that displays⎕STOP settings
 Monitor Displays a column to the left of the function that displays⎕MONITOR settings
 LineNumbers Toggles the display of line numbers on/off.
 FunctionLineNumbers
 Toggles the display of line numbers on individual functionson/off. This option is only enabled when editing a Class,Namespace script or Interface.
 Tree View Toggles the display of the treeview in the left-hand pane.
 Outlining Turns outlining on and off.
 Expand AllOutlines Expands all outlines.
 Collapse AllOutlines Collapses all outlines
 Expand allOutlinesbelow here
 Expands all outlines below the level of the current line.
 Function Line NumbersThe Function Line Numbers option in the Editor menu provides an additional levelof line-numbering. If selected, line numbers are displayed independently on eachindividual function (or operator) in the Class. This option is only enabled when youare editing a Class, Namespace script or Interface, and is disabled for all other typesof object.
 Note that function line-numbering and general line-numbering are independentoptions and it is possible to have the entire Class numbered (from [0] to the numberof lines in the Class) in addition to having line-numbering on each individual func-tion.
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 The Window MenuTheWindow menu provides a means to control the display of the various edit win-dows. TheWindow menu and the actions it provides are described below.
 Close AllWindows
 Closes all the edit windows. If Confirm on Edit Window Closed ischecked, you will be prompted to confirm for any objects that youhave changed.
 Cascade Arranges the edit windows in overlapping fashion.
 Tile Arranges the edit windows in a tiling fashion.
 ArrangeIcons Arranges any minimised edit windows.
 Editor Allows you to Select the edit window corresponding to the namedobject.
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 Using the EditorCreating a New FunctionType the name of your function and invoke the editor. To do this you may pressShift+Enter, or select Edit from the Action menu, or double-click the left button onyour mouse, or click the Edit tool in the tool bar. A new window will appear on thescreen with the name you have chosen displayed in the top border. The name is alsoinserted in the function header and the cursor positioned to the right. The new win-dow is automatically given the input focus.
 Line-Numbers on/offTry changing the line numbers setting by clicking on the Line Numbers option in theOptionsmenu. Note that line-numbering on/off is effective for all edit windows.
 Adding LinesIf the keyboard is in Insert mode, pressing Enter at the end of a line opens you a newblank line under the current one and positions the cursor there ready for input. Youcan also open a new blank line by pressing Ctrl+Shift+Insert (OP).
 If the cursor is at the end of the last line in the function, pressing Enter adds anotherline even if the keyboard is in Replace mode.
 Indenting TextDyalog APL allows you to insert leading spaces in lines of a function and (unless theAutoFormat parameter is set) preserves these spaces between editing sessions.Embedded spaces are however discarded. You can enter spaces using the space bar orthe Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to thevalue of the TabStops parameter. If the AutoIndent parameter is set, new lines areautomatically indented the same amount as the preceding line.
 ReformattingThe RD command (which by default is mapped to Keypad-Slash) reformats a func-tion according to yourAutoFormat and TabStops settings.
 Deleting LinesTo delete a block of lines, select them by dragging the mouse or using the keyboardand then press Delete or select Clear from the Edit menu. A quick way to delete thecurrent line without selecting it first is to press Ctrl+Delete (DK) or select DeleteLine from the Edit menu.

Page 230
                        

Chapter 2: The APL Environment 226
 Copying LinesSelect the lines you wish to copy by dragging the mouse or using the keyboard. Thenpress Ctrl+Insert or select Copy from the Edit menu. This action copies the selectionto the clipboard. Now position the input cursor where you wish to make the copyand press Shift+Insert, or select Paste from the Edit menu. You can also use thismethod to duplicate a ragged block of text.
 To copy text using drag-and-drop editing:
 1. Select the text you want to move.2. Hold down the Ctrl key, point to the selected text and then press and hold
 down the left mouse button. When the drag-and-drop pointer appears, dragthe cursor to a new location.
 3. Release the mouse button to drop the text into place.
 Moving LinesSelect the lines you wish to copy by dragging the mouse or using the keyboard. Thenpress Shift+Delete or select Cut from the Edit menu. This action copies the selectionto the clipboard and removes it. Now position the input cursor at the new locationand press Shift+Insert, or select Paste from the Edit menu. You can also use thismethod to move a ragged block of text.
 To move text using drag-and-drop editing:
 1. Select the text you want to move.2. Point to the selected text and then press and hold down the left mouse but-
 ton. When the drag-and-drop pointer appears, drag the cursor to a new loca-tion.
 3. Release the mouse button to drop the text into place.
 Joining and Splitting LinesTo join a line to the previous one: select Insert mode; position the cursor on the firstcharacter in the line; press Bksp.
 To split a line: select Insert mode; position the cursor at the place you want it split;press Return.
 Toggling LocalisationThe TL command (which by default is mapped to Ctrl+Up) toggles the localisationof the name under the cursor. If the name is currently global, pressing Ctrl+Up causesthe name to be added to the list of locals in the function header. If the name is alreadylocalised, pressing Ctrl+Alt+l removes it from the header.
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 OutliningWhen you are editing a function, outlining identifies the blocks of code within con-trol structures, and allows you to collapse and expand these blocks so that you canfocus your attention on particular parts of the code
 The picture below shows the result of opening the function ⎕SE.cbtop.TB_POPUP.
 )ed ⎕SE.cbtop.TB_POPUP
 Notice that the various control structure blocks are delineated by a treeview diagram.
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 l When you hover the mouse pointer over one of the boxes that mark the startof a block , the line marking the extent of that block becomes highlighted,as shown above.
 l If you click on a box, the corresponding section collapses, so that onlythe first line of the block is displayed, as shown below.
 l If you click on a box, the corresponding section is expanded.
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 SectionsFunctions and scripted objects (classes, namespaces etc.) can be subdivided into Sec-tions with :Section and :EndSection statements. Both statements may be fol-lowed by an optional and arbitrary name or description. The purpose is to split thefunction up into sections that you can open and close in the Editor, thereby aidingreadability and code management. Sections have no effect on the execution of thecode, but must follow the nesting rules of other control structures.
 The following picture illustrates the use of sections in a function calledDumpWindow. The function is divided into 5 sections named Comments, Init,NAs, MakeBitmap and CopyToClipBoard.
 The first picture shows the function with all sections closed.
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 The next picture shows the effect of opening the Comments section. Notice how thisis delineated by the statements:
 :Section Comments...:EndSection Comments
 And with the Init section opened too:
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 Finally, with all the sections opened:
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 Editing ClassesThe picture below shows the result of opening the ComponentFile class. Noticehow each function is delineated separately and that each function is individuallyline-numbered.
 )ed ComponentFile
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 The outlining feature really comes into its own when editing classes because you cancollapse and expand whole functions. The picture below shows the effect of col-lapsing all but the Appendmethod.
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 When you edit a class, a separate treeview is optionally displayed in the left pane tomake it easy to navigate within the class. When you click on a name in the treeview,the editor automatically scrolls the appropriate section into view (if necessary) andpositions the edit cursor at its start. The picture below illustrates the result of openingthe [Methods] section and then clicking on Rename.
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 Sections within ScriptsScripts can also be subdivided into Sections using :Section and :EndSectionstatements. As with single functions, the purpose is only to split the script up into sec-tions that you can open and close in the Editor. Sections have no effect on theexecution of the code.
 The following picture illustrates a Class named actuarial which, for editing pur-poses, has been sub-divided into five separate Sections named Main,MenuHandlers, Validation, Utilities and OldCode. In this picture, allthe Sections are closed.
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 The next picture shows the effect of opening just the Main section.
 Notice that this section is delimited by the two statements:
 :Section Main...:EndSection Main
 In this picture the 3 functions within the Main section are temporarily closed.
 Similarly, the section called Validation is delimited by:
 :Section Validation...:EndSection Validation
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 Find and Replace DialogsThe Find and Find/Replace dialog boxes are used to locate and modify text in anEdit window.
 Search For
 Enter the text string that you want to find. Note that thetext from the last 10 searches is available from the drop-down list. If appropriate, the search text is copied from theFind Objects tool. This makes it easy to first search forfunctions containing a particular string, and then to locatethe string in the functions.
 Replace WithEnter the text string that you want to use as a replacement.Note that the text from the last 10 replacements is availablefrom the drop-down list.
 Match Case Check this box if you want the search to be case-sensitive.
 Match WholeWord
 Check this box if you want the search to only match wholewords.
 Use RegularExpressions
 Check this box if you want to use various wild cardsymbols.
 AutoMoveIf checked, the Find or Find/Replace dialog box willautomatically position itself so as not to obscure a matchedsearch string in the edit window.
 Direction Select Up or Down to control the direction of search.
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 Using Find and ReplaceFind and Replace work on the concept of a current search string and a currentreplace string which are entered using the Find and Find/Replace Dialog boxes.These boxes also contain buttons for performing search/replace operations.
 Suppose that you want to search through a function for references to the string"Adam". It is probably best to work from the start of the function, so first position thecursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The FindDialog box will appear on your screen with the input cursor positioned in the editbox awaiting your input. Type "Adam" and click the Find Next button (or pressReturn), and the cursor will locate the first occurrence. Clicking Find Next again willlocate the second occurrence. You can change the direction of the search by selectingUp instead ofDown. You could search another function for "Adam" by opening anew Edit window for it and clicking Find Next. You do not have to redefine thesearch string.
 Now let us suppose that you wish to replace all occurrences of "Adam" with"Amanda". First select Replace from the Edit menu. This will cause the Find Dialogbox to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" intothe box labelled ReplaceWith, then click Replace All. All occurrences of "Adam" inthe current Edit window are changed to "Amanda". To repeat the same global changein another function, simply open an edit window and click Replace All again. Ifinstead you only want to change particular instances of "Adam" to "Amanda" youmay use Find Next to locate the ones you want, and then Replace to make eachindividual alteration.
 Saving and QuittingTo save the function and terminate the edit, press Esc (EP) or select Exit from the Filemenu. The new version of the function replaces the previous one (if any) and the editwindow is destroyed.
 Alternatively, you can select Fix from the Filemenu. This fixes the new version ofthe function in the workspace, but leaves the edit window open. Note that the historyis also retained, so you can subsequently undo some changes and fix the functionagain.
 To abandon the edit, press Shift+Esc (QT) or select Abort from the Filemenu. Thisdestroys the edit window but does not fix the function. The previous version (if any)is unchanged.
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 The TracerThe Tracer is a visual debugging aid that allows you to step through an applicationline by line. During a Trace you can track the path taken through your code, displayvariables in edit windows and watch them change, skip forwards and backwards in afunction. You can cutback the stack to a calling function and use the Session andEditor to experiment with and correct your code. The Tracer may be invoked in sev-eral ways as discussed below.
 Tracing an expressionFirstly, you may explicitly trace a function (strictly an expression) by typing anexpression then pressing Ctrl+Enter (TC) or by selecting Trace from the Action menu.This lets you step through the execution of an expression from the beginning.
 In the same way as when you execute a statement by pressing Enter, the expression is(if necessary) copied down to the input line and then executed. However, if theexpression includes a reference to an unlocked defined function or operator,execution halts at its first line and a Trace window containing the suspended func-tion or operator is displayed on the screen. The cursor is positioned to the left of thefirst line which is highlighted.
 Naked TraceThe second way to invoke the Tracer is when you have a suspended function in theState Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termednaked trace. The same thing can be achieved by selecting Trace from the Actionmenu on the Session Window or by clicking the Trace button in the Trace Tools.However, in ALL cases it is essential that the input cursor is on the empty Input linein the Session.
 The effect of naked trace is to open the Tracer and to position the cursor on the cur-rently suspended line. It is exactly as if you had Traced to that point from the InputLine expression whose execution caused the suspension.
 Automatic TraceThe third way to invoke the Tracer is to have the system do it automatically for youwhenever an error occurs. This is achieved by setting the Show trace stack on erroroption in the Trace/Edit tab of the Configuration dialog (Trace_on_error param-eter). When an error occurs, the system will automatically deploy the Tracer. Notethat this means that when an error occurs, the Trace window will then receive theinput focus and not the Session window.
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 Tracer OptionsFromVersion 10.1 onwards, the Tracer is designed to be docked in the Session win-dow.
 In previous versions of Dyalog APL, the Tracer was implemented as a stack of sep-arate windows (one per function on the calling stack) or as a single, but still separate,window.
 You can disable the standard behaviour by selecting Classic Dyalog mode from theTrace/Edit tab of the Configuration dialog box.
 If you do so, you may then choose to have the Tracer operate in multiple windows orin a single window.
 These alternatives are discussed later in this Chapter.
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 The Trace WindowThe Tracer is implemented as a single dockable window that displays the functionthat is currently being executed. There are two subsidiary information windowswhich are also fully dockable. The first of these (SIStack) displays the current func-tion calling stack; the second (Threads) displays a list of running threads.
 In the default Session files, the Tracer is docked along the bottom edge of the Sessionwindow.When you invoke the Tracer, it springs up as illustrated below. In this exam-ple, the function being traced is ⎕SE.UCMD, which is invoked by typing a user-com-mand, in this case ]display.
 In the default layout, the SIstack window is displayed alongside the main Tracer win-dow, although this can be hidden or made to appear as a separate floating window, asrequired.
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 Trace ToolsThe Tracer may be controlled from the keyboard, or by using the Trace Toolswhichare arranged along the title bar of the Debugger window. Note that the button namesare solely for reference purposes in the description that follows.
 Button Name KeyCode Keystroke Description
 Exec ER Enter Executes the current line
 Trace TC Ctrl+Enter Traces execution of the currentline
 Back BK Ctrl+Shift+Bksp Skips back one line
 Fwd FD Ctrl+Shift+Enter Skips forward one line
 Restart RM →⎕LC Restarts execution of the currentthread, closing all its tracewindows
 Restart all Restarts execution for all threads,closing all trace windows
 Continue BH Continues execution of thecurrent thread, leaving Tracewindows displayed
 Edit ED Shift+Enter Invokes the Editor
 Exit EP Esc Closes the Trace window, exitsthe current function
 Intr Ctrl+Pause Interrupts execution
 Reset CS Clears all break-points (resets⎕STOP on every function)
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 Using the Trace Tools, you can single-step through the function or operator by click-ing the Exec and/or Trace buttons. If you click Exec the current line of the function oroperator is executed and the system halts at the next line. If you click Trace, the cur-rent line is executed but any defined functions or operators referenced on that line arethemselves traced. After execution of the line the system again halts at the next one.Using the keyboard, the same effect can be achieved by pressing Enter or Ctrl+Enter.
 The illustration below shows the state of execution having clicked Exec 6 times toreach ⎕SE.UCMD[7].
 Execution Reached ⎕SE.UCMD[7]
 The next illustration shows the result of clicking Trace at this point. This caused thesystem to trace into ⎕SE.SaltUtils.Spice, the function called from⎕SE.UCMD[7].
 Notice how each function call on the stack is represented by an item in the SIstackwindow.
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 Execution Reached ⎕SE.SALTUtils.Spice [1]
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 The illustration below shows the state of execution having traced deeper into the sys-tem.
 Execution reached four levels deep
 At this stage, the State Indicator is as follows:
 )SI⎕SE.SALT.Load[1]*⎕SE.SALTUtils.BootSpice[17]⎕SE.SALTUtils.Spice[18]⎕SE.UCMD[7]
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 Controlling ExecutionThe point of execution may be moved by clicking the Back and Fwd buttons in theTrace Toolswindow or, using the keyboard, by pressing Ctrl+Shift+Bksp andCtrl+Shift+Enter. Notice however that these buttons do not themselves change theState Indicator or the display in the SIStack window. This happens only when yourestart execution from the new point.
 You can cut back the stack by clicking the <EP> button in the Trace Toolswindow.This causes execution to be suspended at the start of the line which was previouslytraced. The same effect can be achieved using the keyboard by pressing Esc. It canalso be done by selecting Exit from the Filemenu on the Trace Window or by select-ing Close from its systemmenu.
 The <RM> button removes the Trace window and resumes execution. The same isachieved by the expression →⎕LC. The <BH> button also continues execution, butleaves the Trace window displayed and allows you to watch its progress.
 Using the Session and the EditorWhilst using the Tracer you can skip to the Session or to any Edit window and backagain. While it is docked, you may resize the Tracer pane by dragging its title bar,and you may use the buttons provided to maximise, minimise and restore the Tracerpane within the Session window.
 Unless you move it sideways, the cursor is positioned to the left of the suspendedline in the top Trace window. If you press Shift+Enter (ED) with the cursor in thisposition, the trace window becomes an edit window allowing you to edit the func-tion or operator on top of the stack. You can achieve the same thing by selecting Editfrom the Filemenu, but the input cursor MUST again be in the left-most (empty) col-umn, or the system will attempt to open an edit window for the name under the cursor(point-and-edit).
 When you finish editing, the window reverts to a trace window with the new def-inition of the function or operator displayed.
 You may also open a new edit window fromwithin the Tracer using point-and-edit.
 You can copy text from a trace window to the session for editing and execution or forexperimentation.
 It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on adifferent expression.
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 Setting Break-PointsBreak-points are defined by ⎕STOP and may be toggled on and off in an Edit orTrace window by clicking in the appropriate column. The example below illustratesa function with a ⎕STOP break-point set on line [5].
 ⎕STOP break-points set or cleared in an Edit window are not established until thefunction is fixed. ⎕STOP break-points set or cleared in a Trace window are estab-lished immediately.
 Clearing All Break-Points
 You can clear all break-points by pressing the above button in the Trace Tools win-dow. This in fact resets ⎕STOP for all functions in the workspace.

Page 253
                        

Chapter 2: The APL Environment 249
 The Classic mode TracerIf you select Classic Dyalog mode from the Trace/Edit tab in the Configurationdialog box, the Tracer behaves in the same way as in Dyalog APL Version 8.2. How-ever, the Tracer is not dockable in the Session.
 If you select the Classic mode Tracer, you may choose between multiple trace win-dows or a single trace window using the Single Trace Window option.
 Multiple Trace WindowsThe following behaviour is obtained by deselecting the Single Trace Windowoption.
 l Each function on the SI stack is represented by a separate trace window.The top window contains the function that is currently executing, other win-dows display functions further up the stack, in the order in which they werecalled.
 l When you press Ctrl+Enter or click the Trace button on a line that callsanother function, a new trace window appears on top of the stack and dis-plays the newly called function.
 l When a function exits, its trace window disappears and the focus moves tothe previous trace window. When the last function in a traced suspensionexits, the last trace window disappears.
 l If you click the Quit this function button in the Trace Tools window, orpress Escape, or close the trace window by clicking on its [X] button or typ-ing Alt-F4, the top trace window disappears and the focus moves to the pre-vious trace window
 l If you close any of the trace windows further down the stack, the stack willbe cut back to the corresponding point, i.e. to the line of code that calledthe function whose trace window you closed.
 l The <RM> button removes all the trace windows and resumes execution.The same is achieved by the expression →⎕LC. The <CS> button also con-tinues execution, but leaves the trace windows displayed and allows you towatch their progress.
 l If you minimise any of the trace windows, the entire stack is minimised to asingle icon, from which it may be restored.
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 Single Trace WindowThe following behaviour is obtained by selecting the Single Trace Window option.
 l The trace window contains a combo box whose drop-down displays the con-tents of the SI stack. This box is not provided if there are multiple trace win-dows.
 l The trace window is re-used when tracing into, or returning from, a calledfunction. This means that there is never more than one trace windowpresent.
 l When the last function in a traced suspension exits, the trace window dis-appears.
 l If you click the Quit this function button in the Trace Tools window, orpress Escape, the current function is removed from the stack and the tracewindow reused to display the calling function if there is one.
 l Closing the trace window by clicking on its [X] button or typing Alt-F4removes the window and clears the current suspension. It is equivalent totyping naked branch (→) in the session window.
 l If you move or resize the trace window, APL remembers its position, so thatit reappears in the same position when next used.
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 The Threads ToolThe Threads Tool is used to monitor and debug multi-threaded applications. To dis-play the Threads Tool, select Show Threads Tool from the Session Threadsmenu, orThreads from the Session pop-up menu.
 The above picture illustrates a situation using the LIFT.DWSworkspace after execut-ing the function RUN. The Pause on Error option was enabled and a Stop was set onRUN[63]. When RUN suspended at this point, all other threads (1-8) were auto-matically Paused. Note that all other threads happen to be Paused in the middle ofcalls to system functions
 The columns of the Threads Tool display the following information.
 Column Description
 Tid The Thread ID (⎕TID) and name (⎕TNAME) if set
 Location The currently executing line of function code
 State Indicates what the thread is doing. (see below)
 Flags Normal or Paused.
 Treq The Thread Requirements (⎕TREQ)
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 Thread StatesState Description
 Pending Not yet running
 Initializing Not yet running
 Defined function Between lines of a defined function
 Dynamic function Between lines of a dynamic function
 Suspended Indicates that the thread is suspended and is able toaccept input from the Session window.
 Session Indicates that Session window is connected to thisthread.
 (no stack)Indicates that the thread has no SI stack and the Sessionis connected to another thread. This state can only occurfor Thread 0.
 Exiting About to be terminated
 :Hold Waiting for a :Hold token
 :EndHold Waiting for a :Hold token
 ⎕DL Executing ⎕DL
 ⎕DQ Executing ⎕DQ
 ⎕NA Waiting for a DLL (⎕NA) call to return.
 ⎕TGET Executing ⎕TGET, waiting for a token
 ⎕TGET(Ready to continue) Executing ⎕TGET, having got a token
 ⎕TSYNC Waiting for another thread to terminate
 Awaiting request Indicates a thread that is associated with a .NET systemthread, but is currently unused
 Called .Net Waiting for a call to .NET to return.
 Paused/NormalIn addition to the thread state as described above, a thread may be Paused orNormalas shown in the Flags column. A Paused thread is one that has temporarily beenremoved from the list of threads that are being scheduled by the thread scheduler. APaused thread is effectively frozen.
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 Threads Tool Pop-Up Menu
 Switch toSelecting this item causes APL to attempt to suspend (ifnecessary) and switch to the selected thread, connectingit to the Session and Debugger windows.
 Refresh Now Refreshes the Threads Tool display to show the currentposition and state of each thread.
 Auto RefreshSelecting this item causes the Threads Tool to beupdated continuously, so that it shows the latestposition and state of each thread.
 Pause Threads onError
 If this item is checked, APL automatically Pauses allother threads when a thread suspends due to an error oran interrupt.
 PausedThis item toggles a thread between being Paused andNormal. It Pauses a Normal thread and resumes aPaused thread.
 Pause All This item causes all threads to be Paused.
 Resume All This item resumes all threads.
 Restart All This item resumes all Paused threads, restarts allsuspended threads, and closes the Debugger.
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 Debugging ThreadsThe Debugger provides a tabbed interface that allows you to easily switch betweensuspended threads for debugging purposes. To keep things simple for non-threadedapplications, Tabs are only displayed if there is a thread suspended that is other thanThread 0. The following picture shows the Debugger open on a multi-threaded appli-cation (LIFT.DWS) when only Thread 0 is suspended. This has been achieved by set-ting a stop on RUN[63]
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 In the next picture, the user has chosen to display the Threads Tool and then dock itbetween the Session and Debugger windows. Note that only one thread, thread 0(Run) is suspended. All the other threads are Paused (because Pause on Error is ena-bled).
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 The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)which was Paused on PERSON[7] in the middle of a ⎕TGET. The act of switchingto this thread caused it to be suspended at the beginning of its current line PERSON[7] and the Debugger now displays two Tabs to represent the two suspendedthreads. Note that both the thread id and the thread name are displayed on the Tabs.
 Note also that the Session window is connected to the thread indicated by theselected Tab. In this case, typing MYFLOOR into the Session window displays thevalue of the local variable MYFLOOR in Thread 6 (Lady 6).
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 You can use the Tabs to switch between the suspended threads, so clicking the Tablabelled 0:Run causes the display to change to the picture shown below. The Ses-sion is now connected to Thread 0 (Run), so the value of ⎕LC is 63.
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 The Event ViewerThe Event Viewer can be used to monitor events on Dyalog APL GUI objects. To dis-play the Event Viewer, select Event Viewer from the Session Toolsmenu.
 You can choose:
 l which types of events you want to monitorl which objects you want to monitor
 In the example illustrated above, the user has chosen to monitor events on a Form#.F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,MouseDblClick and Configure events. Notice that there is a callback #.FOOattached to the Configure event.
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 The Spy Menu
 The Spy menu, illustrated above, provides the following options and actions.
 Close: Closes the Event Viewer
 Clear: Clears all of the event information that is currentlydisplayed in the Event Viewer.
 All:In this mode all the events are displayed in the EventViewer as they occur, whether or not there is an actionassociated with them.
 As Queued:
 In this mode only events that have associated actionsare displayed in the event viewer. Note that KeyPressevents are always queued and therefore always appear,even if there is no associated action.
 SnapShot:
 In this mode the Event Viewer displays a snapshot of theinternal event queue. Only those events that arecurrently in the internal APL event queue waiting to beprocessed are displayed.
 Stop Logging: When checked, this item switches event logging off.
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 The Columns Menu
 The Columns menu allows you to choose which information is displayed for theevents you are monitoring.
 Object If checked, this item displays the name of the object onwhich the event occurred.
 Event Name If checked, this item displays the name of the event thatoccurred.
 Event Number If checked, this item displays the event number of theevent that occurred.
 ParametersIf checked, this item displays the parameters for theevent that occurred. These are the items that would bepassed in the argument to a callback function.
 ActionIf checked, this item displays the action associated withthe event, for example the name of a callback function,or an expression to be executed.
 Thread ID If checked, this item displays the thread id of the threadin which the event occurred
 NqedIf checked, this item displays 0 or 1 according towhether or not the event occurred naturally or wasgenerated programmatically by ⎕NQ.
 Event ID If checked, this item displays the event id of the eventthat occurred. This id is used internally.
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 The Select Menu
 The Select menu allows you to highlight certain events in the Event Viewer. Forexample, if you are monitoring TCP/IP events on a number of TCPSockets, you canhighlight just the events for a particular socket.
 Select MatchingEvents
 Highlights all the events that have the same Object andEvent Name (or Event Number) as the currently selectedevent.
 Select All EventsOn This Object
 Highlights all the events that have the same Object asthe currently selected event.
 Select All EventsOf This Type
 Highlights all the events that have the same EventName (or Event Number) as the currently selected event
 These items are also available from the pop-up menu that appears when you press theright mouse button over an event displayed in the Event Viewerwindow.
 The Options Menu
 The Optionsmenu allows you to choose which information is displayed for theevents you are monitoring.
 Always on TopIf checked, this item causes the Event Viewer window tobe displayed above all other windows (including otherapplication windows).
 Use APL font
 If checked, this item causes the information displayed inthe Event Viewer window to be displayed using theAPL font (the same font as is used in the Sessionwindow). If not, the system uses the appropriateWindows font.
 Settings... Displays the Event Viewer Options Dialog Box.
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 Options Dialog BoxThe Event Viewer Options dialog box allows you to select the objects and eventsthat you wish to monitor.
 Events to viewThe list box shows all the events that are support by the Dyalog APL GUI and allowsyou to select which events are to be monitored. Only those events that are selectedwill be reported. You can sort the events by name or by event number by clicking theappropriate column header.
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 Objects to view
 All Objects If checked, this item enables event reporting on allDyalog APL GUI objects.
 Objects of Type
 If checked, this item activates the adjoining Selectbutton and disables all other Object selectionmechanisms. Clicking the Select button brings up adialog box that allows you to choose which types ofDyalog APL GUI objects you want to monitor.
 Find Tool
 This tool allows you to choose a single specific DyalogAPL GUI object that you want to monitor. To use it,drag the Find Tool and move it over your Dyalog APLGUI objects. As you drag it, the individual objects arehighlighted and their details displayed in the Name,Type, Thread ID and Handle fields. Drop the Find Toolon the object of your choice.
 SelectClicking this button brings up a dialog box thatdisplays the entire Dyalog APL GUI structure as a treeview. You can choose a single object by selecting it.
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 The Session ObjectPurpose: The Session object ⎕SE is a special system object that represents
 the session window and acts as a parent for the session menus, toolbar(s) and status bar.
 Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,TCPSocket, CoolBar, ToolControl, BrowseBox
 Properties Type, Caption, Posn, Size, File, Coord, State, Event, FontObj,YRange, XRange, Data, TextSize, Handle, HintObj, TipObj,CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,MethodList, ChildList, EventList, PropList
 Methods ChooseFont, FileRead, FileWrite
 Events Close, Create, FontOK, FontCancel, WorkspaceLoaded
 Description
 There is one (and only one) object of type Session and it is called ⎕SE. You may use⎕WG, ⎕WS and ⎕WN to perform operations on ⎕SE, but you cannot expunge it with⎕EX nor can you recreate it using ⎕WC. You may however expunge all its children.This will result in a bare session with no menu bar, tool bar or status bar.
 ⎕SE is loaded from a session file when APL starts. The name of the session file isspecified by the session_file parameter. If no session file is defined, ⎕SE will have nochildren and the session will be devoid of menu bar, tool bar and status bar com-ponents.
 You may use all of the standard GUI system functions to build or configure the com-ponents of the Session to your own requirements. You may also control the Sessionby changing certain of its properties.
 Note that the Session reports a Create event when APL is first started, and a Work-spaceLoaded event when a workspace is loaded or on a clear ws.
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 Read-Only PropertiesThe following properties of ⎕SE are read-only and may not be set using ⎕WS:
 Type A character vector containing 'Session'
 Caption A character vector containing the current caption in the title barof the Session window.
 TextSize Reports the bounding rectangle for a text string. For a fulldescription, see TextSize in Object Reference.
 CurObjA character vector containing the name of the current object.This is the name under or immediately to the left of the inputcursor.
 CurPos
 A 2-element integer vector containing the position of the inputcursor (row and column number) in the session log. This is ⎕IOdependent. If ⎕IO is 1, and the cursor is positioned on thecharacter at the beginning of the first (top) line in the log,CurPos is (1 1). If ⎕IO is 0, its value would be (0 0).
 CurSpace
 A character vector which identifies the namespace from whichthe current expression was executed. If the system is notexecuting code, CurSpace is the current space and is equivalentto the result of ⊃''⎕NS''.
 Handle The window handle of the Session window.
 LogA vector of character vectors containing the most recent set oflines (input statements and results) that are recorded in thesession log. The first element contains the top line in the log.
 InputA vector of character vectors containing the most recent set ofinput statements (lines that you have executed) contained in theinput history buffer.
 ChildList A vector of character vectors containing the types of object thatcan be created as a child of ⎕SE.
 MethodList A vector of character vectors containing the names of themethods associated with ⎕SE.
 EventList A vector of character vectors containing the names of the eventsgenerated by ⎕SE
 PropList A vector of character vectors containing the names of theproperties associated with ⎕SE.
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 Read/Write PropertiesThe following properties of ⎕SEmay be changed using ⎕WS:
 Coord Specifies the co-ordinate system for the session window.
 Data May be used to associate arbitrary data with the session object⎕SE.
 Event
 You may use this property to attach an expression or callbackfunction to the Create event or to user-defined events. A callbackattached to the Create event can be used to initialise the Sessionwhen APL starts.
 FileThe full pathname of the session file that is associated with thecurrent session. This is the file name used when you save or loadthe session by invoking the FileRead or FileWrite method.
 FontObj
 Specifies the APL font. In general, the FontObj property mayspecify a font in terms of its face name, size, and so forth or it mayspecify the name of a Font object. For applications, the lattermethod is recommended as it will result in better management offont resources. However, in the case of the Session object, it isrecommended that the former method be used.
 HintObj
 Specifies the name of the object in which hints are displayed.Unless you specify HintObj individually for session components,this object will be used to display the hints associated with all ofthe menu items, buttons, and so forth in the session. The objectnamed by this property is also used to display the message“Ready...” when APL is waiting for input.
 PopupA character vector that specifies the name of a popup menu to bedisplayed when you click the right mouse button in a Sessionwindow.
 Posn
 A 2-element numeric vector containing the position of the top-leftcorner of the session window relative to the top-left corner of thescreen. This is reported and set in units specified by the Coordproperty.
 Size A 2-element numeric vector containing the height and width of thesession window expressed in units specified by the Coord property.
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 State
 An integer that specifies the window state (0=normal, 1=minimised,2=maximised). You may wish to use this property to minimise andlater restore the session under program control. If you save yoursession with State set to 2, your APL session will start offmaximised.
 TipObj
 Specifies the name of the object in which tips are displayed. Unlessyou specify TipObj individually for session components, this objectwill be used to display the tips associated with all of the menuitems, buttons, and so forth in the session.
 XRange See Object Reference
 YRange See Object Reference
 Configuring the SessionAs supplied, your default session will have a menu bar, a tool bar and a status bar.There are many ways in which you may configure this set-up, including the fol-lowing:
 You may select a different APL font or character size.
 You may alter the appearance of the menus by changing the Caption properties of thevarious Menu and MenuItem objects. For example, you may prefer the menus toappear in your own language.
 You may alter the structure of the menus. For example, you may wish to create aSearch menu directly on the menu bar rather than having Find and Replace as part ofthe Edit menu.
 You may add new Menu and MenuItem objects to the menu bar, or new Buttonobjects to the tool bar, that execute APL functions or expressions for you. You canstore the code inside the ⎕SE namespace so that it is remains available when youswitch from one workspace to another.
 You may add other objects to the tool bar to allow you to provide input for your func-tions or to display output. For example, you may display a Combo object that offersyou a selection of names applicable to a particular task.
 You may add additional toolbars.
 You may remove objects too; for example, you can remove fields from the StatusBaror even delete it entirely. Indeed, you may dispense with the menu bar and/or tool baras well.
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 This section illustrates how you can configure your session using worked examples.The examples are by no means exhaustive, but are designed to demonstrate the prin-ciples. Please note that the structure and names of the objects used in these examplesmay not be identical to your default session as supplied. Before you attempt tochange your session, please check the structure and the object names using ⎕WN and⎕WG. The supplied session was created using the function BUILD_SESSION in theworkspace BUILDSE. If you wish to make substantial changes to your session, youmay find it most convenient to edit the functions in this workspace, re-run BUILD_SESSION, and then save it.
 Please note that these examples assume that Expose Session Properties is enabled.
 Changing the FontThe APL session font is defined by the Font property of ⎕SE. To change the font per-manently, you should select a different Font and/or size of Font using the combo andspinner boxes on the Session toolbar, and save your Session.
 Classic Edition is distributed with bitmap fonts suitable for use on your screen, andTrueType fonts for your printer. You can use the TrueType font on the screen, but itis less attractive than the bitmap fonts at low resolutions. The bitmap fonts come intwo sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may selectother sizes, so long as the height is a multiple of 16 or 22. The scaling is performedautomatically by Windows.
 Changing Menu AppearanceThe name of the Session MenuBar is '⎕SE.mb'. To simplify the specification ofobject names, we will first change space to the MenuBar itself:
 )CS ⎕SE.mb⎕SE.mb
 The names of the Menu objects owned by the MenuBar are given by the expression:
 'Menu' ⎕WN ''file  edit  view  windows  session  log  action  options tools  help
 The current caption on the file menu is:
 file.Caption&File
 To change the Caption to Workspace:
 file.Caption←'Workspace'
 To change the colour of the New option in the Filemenu to red:
 file.clear.FCol←255 0 0
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 Reorganising the Menu StructureThis example shows how you may alter the structure of the session menus by addinga Search menu to the menu bar to provide access to the Find and Find/Replacedialog boxes and removing these options from the Edit menu.
 To simplify the process, we will first change space into the MenuBar object itself:
 )CS ⎕SE.mb⎕SE.mb
 Then we can begin by adding the Search menu. You can specify where the newmenu is to be added using its Posn property. In this case, Search will be added at posi-tion 3 (after Edit).
 'search'⎕WC 'Menu' '&Search' 3
 Next we will remove the Find and Replace MenuItem objects from the Edit menu.Their names can be obtained from ⎕WN:
 'MenuItem'⎕WN'edit'edit.prev  edit.next  edit.clear  edit.copy  edit.paste edit.find  edit.replace
 It is worth noting that these MenuItems perform their actions because their Eventproperty is set to execute the system operations [Find] and [Replace] respec-tively when they are selected.
 edit.find.EventSelect  [Find]
 edit.replace.EventSelect  [Replace]
 The following statement removes them from the Edit menu:
 ⎕EX¨'edit.find' 'edit.replace'
 and the following statements add them to the Search menu:
 'search.find' ⎕WC 'MenuItem' '&Find'('Event' 'Select' '[Find]')
 'search.replace' ⎕WC 'MenuItem' '&Replace'('Event' 'Select' '[Replace]')
 Adding your own MenuItemThis example shows how you can add a menu item that executes an APL expression.In this case we will do something very simple; namely add a Time option to theTools menu which will execute ⎕TS. Notice that the statement also defines a Hint.This will be displayed when you select the option, prior to releasing the mouse but-ton to action it.
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 Once again, we will start by changing space into the Toolsmenu itself
 )CS ⎕SE.mb.tools⎕SE.mb.tools
 Then we will define a new MenuItem to perform the action we require:
 'ts'⎕WC'MenuItem' '&Time'('Event' 'Select' '⍎⎕TS')('Hint' 'Display Timestamp')
 The ⍎ symbol is very important and distinguishes an expression to be executed imme-diately, as in this case, from a callback function. The resulting Toolsmenu nowappears as follows:
 A customised Tools menu
 Selecting Time produces the following output in the session:
 2007 12 10 17 10 2 0
 Adding your own Tool ButtonThis example shows how you can add a button to the session tool bar that executesan APL function.
 The example function we will use is called XREF. This function analyses anotherfunction, listing the sub-functions that it calls. Instead of returning a result, this exam-ple displays the sub-functions in a Form.
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 ∇ XREF FN;REFS[1] :If 0<⍴FN[2] :AndIf 3=⎕NC FN[3] REFS←⎕REFS FN[4] REFS←(3=⎕NC REFS)⌿REFS[5] REFS←(↓REFS)~¨' '[6] REFS←REFS~⊂FN[7] :If 0<⍴REFS[8] 'F'⎕WC'Form'('Functions called by ',FN)[9] F.FontObj←⎕SE.FontObj[10] 'F.L'⎕WC'List'REFS(0 0)(100 100)[11] :EndIf[12] :EndIf
 ∇
 To make this function available from a Session tool button, we need to do a numberof things.
 Firstly, we must install the function in ⎕SE so that it is always there, regardless of thecurrent active workspace. This is easily achieved using the Explorer or ⎕NS.
 '⎕SE' ⎕NS 'XREF'
 Secondly, we need to find another way to specify its argument FN. One possibilitywould be to display a dialog box, asking the user to specify the name of the functionto be analysed. A neater solution is to use the CurObj property of ⎕SE which reportsthe name under the cursor. Using CurObj, the user can simply place the cursor overthe name of the function to be analysed, and then click the XREF tool button.
 To get FN from CurObj, all we need to do is to change the header and lines 1-2 to:
 [0] XREF;FN;REFS[1] :If 0<⍴FN←⎕SE.CurObj[2] :AndIf 3=⎕NC FN←⎕SE.CurSpace,'.',FN
 Notice that the function name reported by CurObj is prefixed by its pathname whichcomes from the CurSpace property. This reports the user’s current namespace.
 Next we will add a new button to the tool bar in the Tools CoolBand. Ideally wewould use a suitable bitmap, but to simplify the example, we will use a standard textbutton:
 )CS ⎕SE.cbtop.bandtb3.tb⎕SE.cbtop.bandtb3.tb
 'xref' ⎕WC 'Button' 'XREF''xref' ⎕WS 'Event' 'Select' '⍎⎕SE.XREF'
 Adding a tool button
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 User CommandsDyalog APL includes a mechanism to define User Commands.
 User commands are developer tools, written in APL, which can be executed withouthaving to explicitly copy code into your workspace and/or save it in every work-space in which you want to use it.
 A User Command is a name prefixed by a closing square bracket, which may be nila-dic or take an argument. A User Command executes APL code that is typically storedsomewhere outside the current active workspace.
 By default, the existing SPICE command processor is hooked up to the user com-mand mechanism, and a number of new SPICE commands have been added. For exam-ple:
 ]display 'hello' (⍪'world')┌→────────────┐│ ┌→────┐ ┌→┐ ││ │hello│ ↓w│ ││ └─────┘ │o│ ││ │r│ ││ │l│ ││ │d│ ││ │w│ ││ └─┘ │└∊────────────┘
 The implementation of User Commands is very simple: If a line of input begins witha closing square bracket (]), and there exists a function by the name ⎕SE.UCMD,then the interpreter will call that function, passing the input line (without thebracket) as the right argument.
 To add a user command, drop a new Spice command file in the folder SALT\Spice.
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 Chapter 3:
 APL Files
 IntroductionMost languages store programs and data separately. APL is unusual in that it allowsyou to store programs and data together in a workspace.
 This can be inefficient if your dataset gets very large; when your workspace isloaded, you are loading ALL of your data, whether you need it or not.
 It also makes it difficult for other users to access your data, particularly if you wantthem to be able to update it.
 In these circumstances, you must extract your data from your workspace, and write itto a file on disk, thus separating your data from your program. There are many dif-ferent kinds of file format. This section is concerned with the APL Component Filesystem which preserves the idea that your data consists of APL objects; hence youcan only access this type of file from within APL
 The Component File system has a set of system functions through which you accessthe file. Although this means that you have to learn a whole new set of functions inorder to use files, you will find that they provide you with a very powerful mech-anism to control access to your data.
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 Component FilesOverviewA component file is a data file maintained by Dyalog APL. It contains a series ofAPL arrays known as componentswhich are accessed by reference to their relativeposition or component number within the file. Component files are just like otherdata files and there are no special restrictions imposed on names or sizes.
 A set of system functions is supplied to perform a range of file operations. These pro-vide facilities to create or delete files, and to read and write components. Facilitiesare also provided for multi-user access, including the capability to determine whomay do what, and file locking for concurrent updates.
 Tying and Untying FilesTo access an existing component file it must be tied, i.e. opened for use. The tie maybe exclusive (single-user access) or shared (multi-user access). A file is untied, i.e.closed, using ⎕FUNTIE or on terminating Dyalog APL. File ties survive )LOAD,⎕LOAD and )CLEAR operations.
 Tie NumbersA file is tied by associating a file name with a tie number. Tie numbers are integersin the range 1 - 2147483647 and, you can supply one explicitly, or have the inter-preter allocate the next available one by specifying 0. The system functions which tiefiles return the tie number as a ‘shy’ result.
 Creating and Removing FilesA component file is created using ⎕FCREATE which automatically ties the file forexclusive use. A newly created file is empty, i.e. contains 0 components. A file isremoved with ⎕FERASE, although it must be exclusively tied to do so.
 Adding and Removing ComponentsComponents are added to a file using ⎕FAPPEND and removed using ⎕FDROP. Com-ponent numbers are allocated consecutively starting at 1. Thus a new componentadded by ⎕FAPPEND is given a component number which is one greater that that ofthe last component in the file. Components may be removed from the beginning orend of the file, but not from the middle. Component numbers are therefore con-tiguous.
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 Reading and Writing ComponentsComponents are read using ⎕FREAD and overwritten using ⎕FREPLACE. There areno restrictions on the size or type of array which may replace an existing component.Components are accessed by component number, and may be read or overwritten atrandom.
 Component InformationIn addition to the data held in a component, the user ID that wrote it and the time atwhich it was written is also recorded. This control information is useful in providingan audit trail and in facilitating partial backups of components that have changed.
 Multi-User Access⎕FSTIE ties a file for shared (i.e. multi-user) access. This kind of access would beappropriate for a multi-user UNIX system, a network of single user PCs, or multipleAPL tasks underMicrosoft Windows.
 ⎕FHOLD provides the means for the user to temporarily prevent other co-operatingusers from accessing one or more files. This is necessary to allow a single logicalupdate involving more than one component, and perhaps more than one file, to becompleted without interference from another user. ⎕FHOLD is applicable to ExternalVariables as well as Component Files
 File Access ControlThere are two levels of file access control. As a regular data file, the operating systemread/write controls for owner and other users apply. In addition, Dyalog APL man-ages its own access controls using the access matrix. This is an integer matrix with 3columns and any number of rows. Column 1 contains user numbers, column 2 anencoding of permitted file operations, and column 3 passnumbers. Each row specifieswhich file operations may be performed by which user(s) with which passnumber.
 User NumberThis is a number which is defined by the aplnid parameter. If you intend to use Dya-log APL’s access matrix to control file access in a multi-user environment, it is desir-able to allocate to each user, a distinct user number. However, if you intend to relyon under-lying operating system controls, allocating a user number of 0 to everyoneis more appropriate. A user number of 0 (which is the installation default), causesAPL to circumvent the access matrix mechanism described below.
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 Permission CodeThis is an integer representation of a Boolean mask. Each bit in the mask indicateswhether or not a particular file operation is permitted as follows:
 ┌──┬──┬──┬──┬──┬──┬─┬─┬─┬─┬─┬─┬─┬─┬─┐ Bit No.│15│14│13│12│11│10│9│8│7│6│5│4│3│2│1│└──┴──┴──┴──┴──┴──┴─┴─┴─┴─┴─┴─┴─┴─┴─┘ File Access
 ↑ ↑  ↑  ↑  ↑  ↑   ↑   ↑ ↑ ↑ ↑ ↑ ↑   Operation   Code│ │  │  │  │  │   │   │ │ │ │ │ ││ │  │  │  │  │   │   │ │ │ │ │ └── ⎕FREAD         1│ │  │  │  │  │   │   │ │ │ │ └──── ⎕FTIE          2│ │  │  │  │  │   │   │ │ │ └────── ⎕FERASE        4│ │  │  │  │  │   │   │ │ └──────── ⎕FAPPEND       8│ │  │  │  │  │   │   │ └────────── ⎕FREPLACE     16│ │  │  │  │  │   │   └──────────── ⎕FDROP        32│ │  │  │  │  │   ││ │  │  │  │  │   └──────────────── ⎕FRENAME     128│ │  │  │  │  ││ │  │  │  │  └──────────────────── ⎕FRDCI       512│ │  │  │  └─────────────────────── ⎕FRESIZE    1024│ │  │  └────────────────────────── ⎕FHOLD      2048│ │  └───────────────────────────── ⎕FRDAC      4096│ └──────────────────────────────── ⎕FSTAC      8192└─────────────────────────────────── ⎕FHIST 16384
 For example, if bits 1, 4 and 6 are set and all other relevant bits are zero only⎕FREAD, ⎕FAPPEND and ⎕FDROP are permitted. A convenient way to set up themask is to sum the access codes associated with each operation.
 For example, the value 41 (1+8+32) authorises ⎕FREAD, ⎕FAPPEND and ⎕FDROP.A value of ¯1 (all bits set) permits all operations. Thus by subtracting the accesscodes of operations to be forbidden, it is possible to permit all but certain types ofaccess. For example, a value of ¯133 (¯1- 4+128) permits all operations except⎕FERASE and ⎕FRENAME. Note that the value of unused bits is ignored. Any non-zero permission code allows ⎕FSTIE and ⎕FSIZE. ⎕FCREATE, ⎕FUNTIE, ⎕FLIB,⎕FNAMES and ⎕FNUMS are not subject to access control. Passnumbers may also beused to establish different levels of access for the same user.
 When the user attempts to tie a file using ⎕FTIE or ⎕FSTIE a row of the accessmatrix is selected to control this and subsequent operations.
 If the user is the owner, and the owner's user ID does not appear in the access matrix,the value (⎕AI[1] ¯1 0) is conceptually appended to the access matrix. Thisensures that the owner has full access rights unless they are explicitly restricted.
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 The chosen row is the first row in which the value in column 1 of the access matrixmatches the user ID and the value in column 3 matches the supplied passnumberwhich is taken to be zero if omitted.
 If there is no match of user ID and passnumber in the access matrix (including implic-itly added rows) then no access is granted and the tie fails with a FILE ACCESSERROR.
 Once the applicable row of the access matrix is selected, it is used to verify all sub-sequent file operations. The passnumber used to tie the file MUST be used for everysubsequent operation. Secondly, the appropriate bit in the permission code cor-responding to the file operation in question must be set. If either of these conditionsis broken, the operation will fail with FILE ACCESS ERROR.
 If the access matrix is changed while a user has the file tied, the change takes imme-diate effect. When the user next attempts to access the file, the applicable row in theaccess matrix will be reselected subject to the supplied passnumber being the same asthat used to tie the file. If access with that password is rescinded the operation willfail with FILE ACCESS ERROR.
 When a file is created using ⎕FCREATE, the access matrix is empty. At this stage, theowner has full access with passnumber 0, but no access with a non-zero passnumber.Other users have no access permissions. Thus only the owner may initialise theaccess matrix.
 User 0If a user has an aplnid of 0, the access matrix and supplied passnumbers are ignored.This user is granted full and unrestricted access rights to all component files, subjectonly to underlying operating system restrictions.
 General File Operations⎕FLIB gives a list of component files in a given directory. ⎕FNAMES and ⎕FNUMSgive a list of the names and tie numbers of tied files. These general operations whichapply to more than one file are not subject to access controls.
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 Component File System FunctionsSee Language Reference for full details of the syntax of these system functions.
 General
 ⎕FAVAIL Report file system availability
 File Operations
 ⎕FCREATE Create a file
 ⎕FTIE Tie an existing file (exclusive)
 ⎕FSTIE Tie an existing file (shared)
 ⎕FUNTIE Untie file(s)
 ⎕FCOPY Copy a file
 ⎕FERASE Erase a file
 ⎕FRENAME Rename a file
 File information
 ⎕FHIST Report file events
 ⎕FNUMS Report tie numbers of tied files
 ⎕FNAMES Report names of tied files
 ⎕FLIB Report names of component files
 ⎕FPROPS Report file properties
 ⎕FSIZE Report size of file
 Writing to the file
 ⎕FAPPEND Append a component to the file
 ⎕FREPLACE Replace an existing component
 Reading from a file
 ⎕FREAD Read one or more components
 ⎕FRDCI Read component information
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 Manipulating a file
 ⎕FDROP Drop a block of components
 ⎕FRESIZE Change file size (forces a compaction)
 ⎕FCHK Check and repair a file
 Access manipulation
 ⎕FSTAC Set file access matrix
 ⎕FRDAC Read file access matrix
 Control multi-user access
 ⎕FHOLD Hold file(s) - see later section for details
 Using the Component File SystemLet us suppose that you have written an APL system that builds a personnel database,containing the name, age and place of birth of each employee. Let us assume that youhave created a variable DATA, which is a nested vector with each element containinga person's name, age and place of birth:
 DISPLAY 2↑DATA.→-------------------------------------------------------.| .→----------------------. .→-------------------------. || | .→-------.    .→----. | | .→------.    .→--------. | || | |Jonathan| 42 |Wales| | | |Pauline| 21 |Isleworth| | || | '--------'    '-----' | | '-------'    '---------' | || '∊----------------------' '∊-------------------------' |'∊-------------------------------------------------------'
 Then the following APL expressions can be used to access the database:
 Example 1:Show record 2
 DISPLAY 2⊃DATA.→-------------------------.| .→------.    .→--------. || |Pauline| 21 |Isleworth| || '-------'    '---------' |'∊-------------------------'
 Example 2:How many people in the database?
 ⍴DATA123
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 Example 3:Update Pauline's age
 (2 2⊃DATA)←16
 Example 4:Add a new record to the database
 DATA ,← ⊂'Maurice' 18 'London'
 Now let's build a component file to hold our personnel database.
 Create a new file, giving the file name, and the number you wish to use to identify it(the file tie number):
 'COMPFILE' ⎕FCREATE 1
 If the file already exists, or you have already used this tie number, then APL willrespond with the appropriate error message.
 Now write the data to the file. We could write a function that loops to do this, but itis neater to take advantage of the fact that our data is a nested vector, and use each(¨).
 DATA ⎕FAPPEND¨ 1
 Now we'll try our previous examples using this file.
 Example 1:Show record 2
 DISPLAY ⎕FREAD 1 2.→-------------------------.| .→------.    .→--------. || |Pauline| 21 |Isleworth| || '-------'    '---------' |'∊-------------------------'
 Example 2:How many people in our database?
 ⎕FSIZE 1        ⍝ First component, next1 125 10324 4294967295  ⍝ component, file size,
 ⍝ maximum file size
 ¯1+2⊃⎕FSIZE 1   ⍝ Number of data items
 The fourth element of ⎕FSIZE indicates the file size limit. Dyalog APL does notimpose a file size limit, although your operating systemmay do so, but the concept isretained in order to make this version of Component Files compatible with others.
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 Example 3:Update Pauline's age
 REC ← ⎕FREAD 1 2       ⍝ Read second componentREC[2] ← 18            ⍝ Change ageREC ⎕FREPLACE 1 2      ⍝ And replace component
 Example 4:Add a new record
 ('Janet' 25 'Basingstoke') ⎕FAPPEND 1
 Example 5:Rename our file
        'PERSONNEL' ⎕FRENAME 1
 Example 6:Tie an existing file; give file name and have the interpreter allocate the next avail-able tie number.
        'SALARIES' ⎕FTIE 02
 Example 7:Give everyone access to the PERSONNEL file
 (1 3⍴0 ¯1 0)⎕FSTAC 1
 Example 8: Set different permissions on SALARIES.
 AM ← 1 3⍴1 ¯1 0    ⍝ Owner ID 1 has full accessAM⍪← 102 1 0       ⍝ User ID 102 has READ onlyAM⍪← 210 2073 0    ⍝ User ID 210 has
 ⍝ READ+APPEND+REPLACE+HOLD
 AM ⎕FSTAC 2        ⍝ Store access matrix
 Example 9: Report on file names and associated numbers
 ⎕FNAMES,⎕FNUMSPERSONNEL  1SALARIES   2
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 Example 10:Untie all files
 ⎕FUNTIE ⎕FNUMS
 Programming TechniquesControlling Multi-User AccessObviously, Dyalog APL contains mechanisms that prevent data getting mixed up iftwo users update a file at the same time. However, it is the programmer's respon-sibility to control the logic of multi-user updates.
 For example, suppose two people are updating our database at the same time. Thefirst checks to see if there is an entry for 'Geoff', sees that there isn't so adds a newrecord. Meanwhile, the second user is checking for the same thing, and so also adds arecord for 'Geoff'. Each user would be running code similar to that shown below:
 ∇  UPDATE;DATA;NAMES[1] ⍝ Using the component file[2] 'PERSONNEL' ⎕FSTIE 1[3] NAMES←⊃∘⎕FREAD ¨ 1,¨⍳¯1+2⊃⎕FSIZE 1[4] →END×⍳(⊂'Geoff')∊NAMES[5] ('Geoff' 41 'Hounslow')⎕FAPPEND 1[6] END:⎕FUNTIE 1
 ∇
 The system function ⎕FHOLD provides the means for the user to temporarily preventother co-operating users from accessing one or more files. This is necessary to allow asingle logical update, perhaps involving more than one record or more than one file,to be completed without interference from another user.
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 The code above is replaced by that below:
 ∇ UPDATE;DATA;NAMES[1] ⍝ Using the component file[2] 'PERSONNEL' ⎕FSTIE 1[3] ⎕FHOLD 1[4] NAMES←⊃∘⎕FREAD ¨ 1,¨⍳¯1+2⊃⎕FSIZE 1[5] →END×⍳(⊂'Geoff')∊NAMES[6] ('Geoff' 41 'Hounslow')⎕FAPPEND 1[7] END:⎕FUNTIE 1 ⋄ ⎕FHOLD ⍳0
 ∇
 Successive ⎕FHOLDs on a file executed by different users are queued by DyalogAPL; once the first ⎕FHOLD is released, the next on the queue holds the file.⎕FHOLDs are released by return to immediate execution, by ⎕FHOLD ⍬, or by eras-ing the external variable.
 It is easy to misunderstand the effect of ⎕FHOLD. It is NOT a file locking mechanismthat prevents other users from accessing the file. It only works if the tasks that wish toaccess the file co-operate by queuing for access by issuing ⎕FHOLDs. It would bevery inefficient to issue a ⎕FHOLD on a file then allow the user to interactively editthe data with the hold in operation. What happens if he goes to lunch? Any otheruser who wants to access the file and cooperates by issuing a ⎕FHOLD would have towait in the queue for 3 hours until the first user returns, finishes his update and his⎕FHOLD is released. It is usually more efficient (as well as more friendly) to issue⎕FHOLDs around a small piece of critical code.
 Suppose we had a control file associated with our personnel data base. This controlfile could be an external variable, or a component file. In both cases, the concept isthe same; only the commands needed to access the file are different. In this example,we will use a component file:
 'CONTROL'⎕FCREATE 1    ⍝ Create control file(1 3⍴0 ¯1 0) ⎕FSTAC 1  ⍝ Allow everyone access⍬ ⎕FAPPEND 1           ⍝ Set component 1 to empty⎕FUNTIE 1              ⍝ And untie it
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 Now we'll allow our man that likes long lunch breaks to edit the file, but will controlthe hold in a more efficient way:
 ∇  EDIT;CMP;CV[1] ⍝ Share-tie the control file[2] 'CONTROL' ⎕FSTIE 1[3] ⍝ Share-tie the data file[4] 'PERSONNEL' ⎕FSTIE 2[5] ⍝ Find out which component the user wants to edit[6] ASK:CMP←ASK∆WHICH∆RECORD[7] ⍝ Hold the control file[8] ⎕FHOLD 1[9] ⍝ Read the control vector[10] CV←⎕FREAD 1 1[11] ⍝ Make control vector as big as the data file[12] CV←(¯1+2⊃⎕FSIZE 2)↑CV[13] ⍝ Look at flag for this component[14] →(FREE,INUSE)[1+CMP⊃CV][15] ⍝ In use - tell user and release hold[16] INUSE:'Record in use' ⋄ ⎕FHOLD ⍬ ⋄ →ASK[17] ⍝ Ok to use - flag in-use and release hold[18] FREE:CV[CMP]←1 ⋄ CV ⎕FREPLACE 1 1⋄ ⎕FHOLD ⍬[19] ⍝ Let user edit the record[20] EDIT∆RECORD RECORD[21] ⍝ When he's finished, clear the control vector[22] ⎕FHOLD 1[23] CV←⎕FREAD 1 1 ⋄CV[CMP]←0 ⋄ CV ⎕FREPLACE 1 1[26] ⎕FHOLD ⍬[27] ⍝ And repeat[28] →ASK
 ∇
 Component 1 of our CONTROL file acts as a control vector. Its length is set equal tothe number of components in the PERSONNEL file, and an element is set to 1 if auser wishes to access the corresponding data component. Only the control file is eversubject to a ⎕FHOLD, and then only for a split-second, with no user inter-actionbeing performed whilst the hold is active.
 When the first user runs the function, the relevant entry in the control vector will beset to 1. If a second user accesses the database at the same time, he will have to waitbriefly whilst the control vector is updated. If he wants the same component as thefirst user, he will be told that it is in use, and will be given the opportunity to editsomething else.
 This simple mechanism allows us to lock the components of our file, rather the thanentire file. You can set up more informative control vectors than the one above; forexample, you could easily put the user name into the control vector and this wouldenable you to tell the next user who is editing the component he is interested in.
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 File DesignOur personnel database could be termed a record oriented system. All the infor-mation relating to one person is easily obtained, and information relating to a newperson is easily added, but if we wish to find the oldest person, we have to read ALLthe records in the file.
 It is sometimes more useful to have separate components, perhaps stored on separatefiles, that hold indexes of the data fields that you may wish to search on. For exam-ple, suppose we know that we always want to access our personnel database byname. Then it would make sense to hold an index component of names:
 ⍝ Extract name field from each data record'PERSONNEL' ⎕FSTIE 1NAMES←⊃∘⎕FREAD¨1,¨⍳¯1+2⊃⎕FSIZE 2
 ⍝ Create index file, and append NAMES'INDEX' ⎕FCREATE 2NAMES ⎕FAPPEND 2
 Then if we want to find Pauline's data record:
 NAMES←⎕FREAD 2,1       ⍝ Read index of namesCMP←NAMES⍳⊂'Pauline'   ⍝ Search for PaulineDATA←⎕FREAD 1,CMP      ⍝ Read relevant record
 There are many different ways to structure data files; you must design a structure thatis the most efficient for your application.
 Internal StructureIf you are going to make a lot of use of APL files in your systems, it is useful for youto have a rough idea of how Dyalog APL organises and manages the disk area usedby such files.
 The internal structure of external variables and component files is the same, and theexamples given below apply to both.
 Consider a component file with 3 components:
 'TEMP' ⎕FCREATE 1'One' 'Two' 'Three' ⎕FAPPEND¨1
 Dyalog APL will write these components onto contiguous areas of disk:
 .-.   .-.   .-.|1|   |2|   |3|.-----.-----.-------.| One | Two | Three |--------------------.
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 Replace the second component with something the same size:
 'Six' ⎕FREPLACE 1 2
 This will fit into the area currently used by component 2.
 .-.   .-.   .-.|1|   |2|   |3|.-----.-----.-------.| One | Six | Three |--------------------.
 If your system uses fixed length records, then the size of your components neverchange, and the internal structure of the file remains static.
 However, suppose we start replacing larger data objects:
 'Bigger One' ⎕FREPLACE 1 1
 This will not fit into the area currently assigned to component 1, so it is appended tothe end of the file. Dyalog APL maintains internal tables which contain the locationof each component; hence, even though the components may not be physicallystored in order, they can always be accessed in order.
 .-.   .-.     .-.|2|   |3|     |1|
 .-----.-----.-------.------------.|⎕⎕⎕⎕⎕| Six | Three | Bigger One |---------------------------------.
 The area that was occupied by component 1 now becomes free.
 Now we'll replace component 3 with something bigger:
 'BigThree' ⎕FREPLACE 1 3
 Component 3 is appended to the end of the file, and the area that was used beforebecomes free:
 .-.                .-.          .-.|2|                |1|          |3|
 .-----.------------------.------------.----------.|⎕⎕⎕⎕⎕| Six |⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕| Bigger One | BigThree |-------------------------------------------------.
 Dyalog APL keeps tables of the size and location of the free areas, as well as theactual location of your data. Now we'll replace component 2 with something bigger:
 'BigTwo' ⎕FREPLACE 1 2
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 Free areas are used whenever possible, and contiguous holes are amalgamated.
 .-.          .-.          .-.|2|          |1|          |3|
 .-----------.------------.------------.----------.|⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕|BigTwo|⎕⎕⎕⎕⎕| Bigger One | BigThree |-------------------------------------------------.
 You can see that if you are continually updating your file with larger data objects,then the file structure can become fragmented. At any one time, the disk area occu-pied by your file will be greater than the area necessary to hold your data. However,free areas are constantly being reused, so that the amount of unused space in the filewill seldom exceed 30%.
 Whenever you issue a monadic ⎕FRESIZE command on a component file, DyalogAPL COMPACTS the file; that is, it restructures it by reordering the components andby amalgamating the free areas at the end of the file. It then truncates the file andreleases the disk space back to the operating system (note that some versions ofUNIX do not allow the space to be released). For a large file with many components,this process may take a significant time.
 Error ConditionsFILE SYSTEM NOT AVAILABLE
 In a PC network, or in a single-processor Unix environment, if the FSCB file is miss-ing or inaccessible (restricted access permissions) the report FILE SYSTEM NOTAVAILABLE (Error code 28) will be given. The same error will occur under NFS ifthe aplfscb "daemon" is not running.
 FILE SYSTEM TIES USED UP
 The FSCB file has a limited capacity and when that capacity is reached the reportFILE SYSTEM TIES USED UP (Error code 30) will be given.
 FILE TIED
 A FILE TIED error is reported if you attempt to tie a file which another user hasexclusively tied. However, it is possible to get spurious FILE TIED errors in a net-work for the following reason.
 If an APL session has component files tied or has External Variables associated, andterminates abnormally, the FSCB will continue to record the file ties, even thoughthe session is no longer running. To prevent another user (or even the same appli-cation restarted) from getting spurious FILE TIED errors, APL checks whether theprocess flagged as having a file tied is actually running. If not, the entry is clearedand the new tie honoured.
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 In a networked environment, it is not possible for a process running on one node tocheck the status of a process running on another. If a node with component files tiedcrashes, its file ties will remain (incorrectly) recorded in the FSCB until either thatnode itself attempts to re-tie the files or until the FSCB is re-initialised.
 LimitationsFile Tie QuotaThe File Tie Quota is the maximum number of files that a user may tie concurrently.Dyalog APL itself allows a maximum of 256 under Unix and Windows, although ineither case your installation may impose a lower limit. When an attempt is made toexceed this limit, the report FILE TIE QUOTA (Error code 31) is given. On a UNIXsystem, there is a system-wide and a per-user limit on the number of open file descrip-tors. On many systems, the per-user limit is 20, and the system-wide limit about 100.Both limits are usually parameters specified when Unix is installed. UnderWindows,the maximum number of open files permitted is specified by the "FILES=" state-ment in CONFIG.SYS.
 File Name QuotaDyalog APL records the names of each user's tied files in a buffer of 40960 bytes.When this buffer is full, the report FILE NAME QUOTA USED UP (Error code 32)will be given. This is only likely to occur if long pathnames are used to identify files.
 The Effect of BufferingDisk drives are fairly slow devices, so most operating systems take advantage of afacility called buffering. This is shown in simple terms below:
 .------------------.| Operating System |   .--------.    .---------.| instruction to   |-->| BUFFER |--->| File on || write large data |   ---------.    |  disk   || object to a file |                 ----------.-------------------.
 When you issue a write to a disk area, the data is not necessarily sent straight to thedisk. Sometimes it is written to an internal buffer (or cache), which is usually held in(fast) main memory. When the buffer is full, the contents are passed to the disk. Thismeans that at any one time, you could have data in the buffer, as well as on the disk.If you machine goes down whilst in this state, you could have a partially updated fileon the disk. In these circumstances, the operating system generally recovers your fileautomatically.
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 If this facility is exploited, it offers very fast file updating. For systems that are I/Obound, this is a very important consideration. However, the disadvantage is thatwhilst it may appear that a write operation has completed successfully, part of thedata may still be residing in the buffer, waiting to be flushed out to the disk. It isusually possible to force the buffer to empty; see your operating systemmanuals fordetails (UNIX automatically invokes the sync() command every few seconds toflush its internal buffers).
 Dyalog APL exploits this facility, employing buffers internal to APL as well as mak-ing use of the system buffers. Of course, these techniques cannot be used when thefile is shared with other users; obviously, the updates must be written immediately tothe disk. However, if the file is exclusively tied, then several layers of buffers areemployed to ensure that file access is as fast as possible.
 You can ensure that the contents of all internal buffers are flushed to disk by issuing⎕FUNTIE ⍬ at any time.
 Integrity and SecurityThe structure of component files, the asynchronous nature of the buffering performedby APL, by the Operating System, and by the external device sub-system, introducesthe potential danger that a component file might become damaged. To prevent thishappening, the component file system includes optional journaling and check-sumfeatures. These are optional because the additional security these features providecomes at the cost of reduced performance. You can choose the level of security that isappropriate for your application.
 When journaling is enabled (see ⎕FPROPS), files are updated using a journal whicheffectively prevents system or network failures from causing file damage.
 Additional security is provided by the check sum facility which enables componentfiles to be repaired using the system function ⎕FCHK.
 Level 1 journaling protects a component file from damage caused by an abnormal ter-mination of the APL process. This could occur if the process is deliberately or acci-dentally terminated by the user or by the Operating System, or by an error in DyalogAPL.
 Level 2 journaling provides protection not just against the possibility that the APLprocess terminates abnormally, but that the Operating System itself fails. However, adamaged component file must be explicitly repaired using the system function⎕FCHK which will repair any damaged components by rolling them back to their pre-vious states.
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 Level 3 provides the same level of protection as Level 2, but following the abnormaltermination of either APL or the Operating System, the rollback of an incompleteupdate will be automatic and no explicit repair will be needed.
 Higher levels of Journaling inevitably reduce the performance of component fileupdates.
 For further information, see ⎕FPROPS and ⎕FCHK.
 Operating System CommandsAPL files are treated as normal data files by the operating system, and may be manip-ulated by any of the standard operating system commands.
 Do not use operating system commands to copy, erase or move component files thatare tied and in use by an APL session.
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 Chapter 4:
 Error Trapping
 Error Trapping ConceptsThe purpose of this section is to show some of the ways in which the ideas of errortrapping can be used to great effect to change the flow of control in a system.
 Most APLs have error trapping facilities in one form or another, but this section dis-cusses the facilities available to a Dyalog APL programmer.
 First, we must have an idea of what is meant by error trapping. We are all used toentering some duff APL code, and seeing a (sometimes) rather obscure, esoteric errormessage echoed back:
 10÷0DOMAIN ERROR
 10÷0^
 Now, these sorts of error messages are fine for us clever APL programmers, but mean-ingless to most of our users. We need to find a way to bypass the default action ofAPL, so that we can take an action of our own.
 Every error message reported by Dyalog APL has a corresponding error number (for alist of error codes and message, see ⎕TRAP, Language Reference). Many of these errornumbers plus messages are common across all versions of APL.We can see that thecode for DOMAIN ERROR is 11, whilst LENGTH ERROR has code 5.
 Dyalog APL provides two distinct but related mechanisms for the trapping and con-trol of errors. The first is based on the control structure :Trap ... :EndTrap,and the second, on the system variable ⎕TRAP. The control structure is easier toadminister and so is recommended for normal use, while the system variable providesslightly finer control and may be necessary for specialist applications.
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 Last Error number and Diagnostic MessageDyalog APL keeps a note of the last error that occurred, and provides this infor-mation through system functions: ⎕EN, ⎕EM and ⎕DM.
 10÷0DOMAIN ERROR
 10÷0^
 Error Number for last occurring error:
 ⎕EN11
 Error Message associated with code 11:
 ⎕EM 11DOMAIN ERROR
 ⎕DM (Diagnostic Message) is a 3 element nested vector containing error message,expression and caret:
 ⎕DMDOMAIN ERROR         10÷0        ^
 Use function DISPLAY to show structure:
 DISPLAY ⎕DM   ┌→─────────────────────────────────────┐   │ ┌→───────────┐ ┌→─────────┐ ┌→─────┐ │   │ │DOMAIN ERROR│ │ 10÷0│ │ ∧│ │   │ └────────────┘ └──────────┘ └──────┘ │   └∊─────────────────────────────────────┘
 Mix (↑) of this vector produces a matrix that displays the same as the error messageproduced by APL:
 ↑⎕DMDOMAIN ERROR
 10÷0^
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 Error Trapping Control StructureYou can embed a number of lines of code in a :Trap control structure within adefined function.
 [1] ...[2] :Trap 0[3] ...[4] ...[5] :EndTrap[6] ...
 Now, whenever any error occurs in one of the enclosed lines, or in a function calledfrom one of the lines, processing stops immediately and control is transferred to theline following the :EndTrap. The 0 argument to :Trap, in this case represents anyerror. To trap only specific errors, you could use a vector of error numbers:
 [2] :Trap 11 2 3
 Notice that in this case, no extra lines are executed after an error. Control is passed toline [6] either when an error has occurred, or if all the lines have been executedwithout error. If you want to execute some code only after an error, you could re-codethe example like this:
 [1] ...[2] :Trap 0[3] ...[4] ...[5] :Else[6] ...[7] ...[8] :EndTrap[9] ...
 Now, if an error occurs in lines [3-4], (or in a function called from those lines), con-trol will be passed immediately to the line following the :Else statement. On theother hand, if all the lines between :Trap and :Else complete successfully, con-trol will pass out of the control structure to (in this case) line [9].
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 The final refinement is that specific error cases can be accommodated using :Case[List] constructs in the same manner as the :Select control structure.
 [1] :Trap 17+⍳21            ⍝ Component file errors.[2] tie←name ⎕ftie 0    ⍝ Try to tie file[3] 'OK'[4] :Case 22[5] 'Can''t find ',name[6] :CaseList 25+⍳13[7] 'Resource Problem'[8] :Else[9] 'Unexpected Problem'[10] :EndTrap
 Note that :Trap can be used in conjunction with ⎕SIGNAL described below.
 Traps can be nested. In the following example, code in the inner trap structureattempts to tie a component file, and if unsuccessful, tries to create one. In either case,the tie number is then passed to function ProcessFile. If an error other than 22(FILE NAME ERROR) occurs in the inner trap structure, or an error occurs in func-tion ProcessFile (or any of its called function), control passes to line imme-diately to line [9].
 [1] :Trap 0[2] :Trap 22[3] tie←name ⎕ftie 0[4] :Else[5] tie←name ⎕fcreate 0[6] :EndTrap[7] ProcessFile tie[8] :Else[9] 'Unexpected Error'[10] :EndTrap

Page 299
                        

Chapter 4: Error Trapping 295
 Trap System Variable: ⎕TRAPThe second way of trapping errors is to use the system variable: ⎕TRAP.
 ⎕TRAP, can be assigned a nested vector of trap specifications. Each trap spec-ification is itself a nested vector, of length 3, with each element defined as:
 list of errornumbers The error numbers we are interested in.
 action code Either 'E' (Execute) or 'C' (Cut Back). There areothers, but they are seldom used.
 action to be taken APL expression, usually a branch statement or a call toan APL function.
 So a single trap specification may be set up as:
 ⎕TRAP←5 'E' 'ACTION1'
 and a multiple trap specification as:
 ⎕TRAP←(5 'E' 'ACTION1')((1 2 3) 'C' 'ACTION2')
 The action code E tells APL that you want your action to be taken in the function inwhich the error occurred, whereas the code C indicates that you want your action tobe taken in the function where the ⎕TRAP was localised. If necessary, APL must firsttravel back up the execution stack (cut-back) until it reaches that function.
 Example TrapsThese action codes are best illustrated by example.
 Dividing by ZeroLet's try setting a ⎕TRAP on DOMAIN ERROR:
 MSG←'''Please give a non-zero right arg'''⎕TRAP←11 'E' MSG
 When we enter:
 10÷0
 APL executes the expression, and notes that it causes an error number 11. Before issu-ing the standard error, it scans its ⎕TRAP table, to see if you were interested enoughin that error to set a trap; you were, so APL executes the action specified by you:
 10÷0Please give non-zero right arg
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 Let's reset our ⎕TRAP:
 ⎕TRAP←0⍴⎕TRAP        ⍝ No traps now set
 and write a defined function to take the place of the primitive function ÷:
 ∇ R←A DIV B[1] R←A÷B[2] ∇
 Then run it:
 10 DIV 0DOMAIN ERROR
 DIV[1] R←A÷B^
 Let's edit our function, and include a localised ⎕TRAP:
 ∇ R←A DIV B;⎕TRAP[1] ⍝ Set the trap[2] ⎕TRAP←11 'E' '→ERR1'[3] ⍝ Do the work; if it results in error 11,[4] ⍝ execute the trap[5] R←A÷B[6] ⍝ All OK if we got to here, so exit[7] →0[8] ⍝ Will get here only if error 11 occurred[9] ERR1:'Please give a non-zero right arg'
 ∇
 Running the function with good and bad arguments has the desired effect:
 10 DIV 25
 10 DIV 0Please give a non-zero right arg
 ⎕TRAP is a variable like any other, and since it is localised in DIV, it is only effec-tive in DIV and any other functions that may be called by DIV. So....
 10÷0DOMAIN ERROR
 10÷0^
 still gives an error, since there is no trap set in the global environment.
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 Other ErrorsWhat happens to our function if we run it with other duff arguments:
 1 2 3 DIV 4 5LENGTH ERRORDIV [4] R←A÷B
 ^
 Here is an error that we have taken no account of.
 Change DIV to take this new error into account:
 ∇ R←A DIV B;⎕TRAP[1] ⍝ Set the trap[2] ⎕TRAP←(11 'E' '→ERR1')(5 'E' '→ERR2')[3] ⍝ Do the work; if it results in error 11,[4] ⍝ execute the trap[5] R←A ÷ B[6] ⍝ All OK if we got to here, so exit[7] →0[8] ⍝ Will get here only if error 11 occurred[9] ERR1:'Please give a non-zero right arg'⋄→0[10] ⍝ Will get here only if error 5 occurred[11] ERR2:'Arguments must be same length'
 ∇
 )RESET
 1 2 3 DIV 4 5Arguments must be the same length
 But here's yet another problem that we didn't think of:
 (2 3⍴⍳6) DIV (2 3 4⍴⍳24)RANK ERRORDIV [4] R←A÷B
 ^
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 Global TrapsOften when we are writing a system, we can't think of everything that may go wrongahead of time; so we need a way of catching "everything else that I may not havethought of". The error number used for "everything else" is zero:
 )RESET
 Set a global trap:
 ⎕TRAP ← 0 'E' ' ''Invalid arguments'' '
 And run the function:
 (2 3⍴⍳6) DIV (2 3 4⍴⍳24)Invalid arguments
 In this case, when APL executed line 4 of our function DIV, it encountered an errornumber 4 (RANK ERROR). It searched the local trap table, found nothing relating toerror 4, so searched further up the stack to see if the error was mentioned anywhereelse. It found an entry with an associated Execute code, so executed the appropriateaction AT THE POINT THAT THE ERROR OCCURRED. Let's see what's in thestack:
 )SIDIV[4]*
 ↑⎕DMRANK ERRORDIV[4] R←A÷B
 ^
 So although our action has been taken, execution has stopped where it normallywould after a RANK ERROR.
 DangersWe must be careful when we set global traps; let's call the non-existent functionBUG whenever we get an unexpected error:
 )RESET⎕TRAP ← 0 'E' 'BUG'(2 3⍴⍳6) DIV (2 3 4⍴⍳24)
 Nothing happens, since APL traps a RANK ERROR on line 4 of DIV, so executes thetrap statement, which causes a VALUE ERROR, which activates the trap action,which causes a VALUE ERROR, which .... etc. etc. If we had also chosen to trap on1000 (ALL INTERRUPTS), then we'd be in trouble!
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 Let's define a function BUG:
 ∇ BUG[1] ⍝ Called whenever there is an unexpected error[2] '*** UNEXPECTED ERROR OCCURRED IN: ',⊃1↓⎕SI[3] '*** PLEASE CALL YOUR SYSTEM ADMINISTRATOR'[4] '*** WORKSPACE SAVED AS BUG.',⊃1↓⎕SI[5] ⍝ Tidy up ... reset ⎕LX, untie files ... etc[6] ⎕SAVE 'BUG.',⊃1↓⎕SI[7] '*** LOGGING YOU OFF THE SYSTEM'[8] ⎕OFF
 ∇
 Now, whenever we run our system and an unexpected error occurs, our BUG functionwill be called.
 10 DIV 0Please give non-zero right arg
 (2 3⍴⍳6) DIV (2 3 4⍴⍳12)
 *** UNEXPECTED ERROR OCCURRED IN: DIV*** PLEASE CALL YOUR SYSTEM ADMINISTRATOR'*** WORKSPACE SAVED AS BUG.DIV*** LOGGING YOU OFF THE SYSTEM'
 The system administrator can then load BUG.DIV, look at the SI stack, discover theproblem, and fix it.
 Looking out for Specific ProblemsIn many cases, you can of course achieve the same effect of a trap by using APL codeto detect the problem before it happens. Consider the function TIE∆FILE, whichchecks to see if a file already exists before it tries to access it:
 ∇ R←TIE∆FILE FILE;FILES[1] ⍝ Tie file FILE with next available tie number[2] ⍝[3] ⍝ All files in my directory[4] FILES←⎕FLIB 'mydir'[5] ⍝ Remove trailing blanks[6] FILES←dbr¨↓FILES[7] ⍝ Required file in list?[8] →ERR×⍳~(⊂FILE)∊FILES[9] ⍝ Tie file with next number[10] FILE ⎕FTIE R←1+⌈/0,⎕FNUMS[11] ⍝ ... and exit[12] →0[13] ⍝ Error message[14] ERR:R←'File does not exist'
 ∇
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 This function executes the same code whether the file name is right or wrong, and itcould take a while to get all the file names in your directory. It would be neater, andmore efficient to take action ONLY when the file name is wrong:
 ∇ R←TIE∆FILE FILE;⎕TRAP[1] ⍝ Tie file FILE with next available tie number[2] ⍝[3] ⍝ Set trap[4] ⎕TRAP←22 'E' '→ERR'[5] ⍝ Tie file with next number[6] FILE ⎕FTIE R←1+⌈/0,⎕FNUMS[7] ⍝ ... and exit if OK[8] →0[9] ⍝ Error message[10] ERR:R←'File does not exist'
 Cut-Back versus ExecuteLet us consider the effect of using Cut-Back instead of Execute. Consider the systemillustrated below, in which the function REPORT gives the user the option of 4reports to be generated:
 REPORT|
 .-------------------------.|          |      |       |
 REP1      REP2    REP3    REP4|
 .----.----.|    |    |
 ...  DIV  ...
 where REPORT looks something like this:
 ∇  REPORT;OPTIONS;OPTION;⎕TRAP[1] ⍝ Driver functions for report sub-system. If an[2] ⍝ unexpected error occurs, take action in the[3] ⍝ function where the error occurred[4] ⍝[5] ⍝ Set global trap[6] ⎕TRAP←0 'E' 'BUG'[7] ⍝ Available options[8] OPTIONS←'REP1' 'REP2' 'REP3' 'REP4'[9] ⍝ Ask user to choose[10] LOOP:→END×⍳0=⍴OPTION←MENU OPTIONS[11] ⍝ Execute relevant function[12] ⍎OPTION[13] ⍝ Repeat until EXIT[14] →LOOP[15] ⍝ Now end[16] END:
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 Suppose the user chooses REP3, and an unexpected error occurs in DIV. The goodnews is that the System Administrator gets a snapshot copy of the workspace that hecan play about with:
 )LOAD BUG.DIV  ⍝ Load workspacesaved ......
 )SI            ⍝ Where did error occur?DIV[4]*REP3[6]⍎REPORT[7]
 ↑⎕DM           ⍝ What happened?RANK ERRORDIV[4] R←A÷B
 ^∇              ⍝ Edit function on top of stack
 [0]R←A DIV B.........
 The bad news is, our user is locked out of the whole system, even though it may onlybe REP3 that has a problem.We can get around this by making use of the CUT-BACK action code.
 ∇ REPORT;OPTIONS;OPTION;⎕TRAP[1] ⍝ Driver functions for report sub-system. If an[2] ⍝ unexpected error occurs, cut the stack back[3] ⍝ to this function, then take action[4] ⍝[5] ⍝ Set global trap[6] ⎕TRAP←0 'C' '→ERR'[7] ⍝ Available options[8] OPTIONS←'REP1' 'REP2' 'REP3' 'REP4'[9] ⍝ Ask user to choose
 [10] LOOP:→END×⍳0=⍴OPTION←MENU OPTIONS[11] ⍝ Execute relevant function[12] ⍎OPTION[13] ⍝ Repeat until EXIT[14] →LOOP[15] ⍝ Tell user ...[16] ERR:MESSAGE'Unexpected error in',OPTION[17] ⍝ ... what's happening[18] MESSAGE'Removing from list'[19] ⍝ Remove option from list[20] OPTIONS←OPTIONS~⊂OPTION[21] ⍝ And repeat[22] →LOOP[23] ⍝ End[24] END:
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 Suppose the user runs this version of REPORT and chooses REP3. When theunexpected error occurs in DIV, APL will check its trap specifications, and see thatthe relevant trap was set in REPORT with a cut-back code. APL therefore cuts backthe stack to the function in which the trap was localised, THEN takes the specifiedaction. Looking at the SI stack above, we can see that APL must jump out of DIV,then REP3, then ⍎, to return to line 7 of REPORT; THEN it takes the specifiedaction.
 Signalling EventsIt would be useful to be able to employ the idea of cutting back the stack and takingan alternative route through the code, when a condition other than an APL erroroccurs. To achieve this, we must be able to trap on errors other than APL errors, andwe must be able to define these errors to APL.We do the former by using error codesin the range 500 to 999, and the latter by using ⎕SIGNAL.
 Consider our system; ideally, when an unexpected error occurs, we want to save asnapshot copy of our workspace (execute BUG in place), then immediately jump backto REPORT and reduce our options. We can achieve this by changing our functions alittle, and using ⎕SIGNAL:
 ∇ REPORT;OPTIONS;OPTION;⎕TRAP[1] ⍝ Driver functions for report sub-system. If an[2] ⍝ unexpected error occurs, make a snapshot copy[3] ⍝ of the workspace, then cutback the stack to[4] ⍝ this function, reduce the option list & resume[5] ⍝ Set global trap[6] ⎕TRAP←(500 'C' '→ERR')(0 'E' 'BUG')[7] ⍝ Available options[8] OPTIONS←'REP1' 'REP2' 'REP3' 'REP4'[9] ⍝ Ask user to choose
 [10] LOOP:→END×⍳0=⍴OPTION←MENU OPTIONS[11] ⍝ Execute relevant function[12] ⍎OPTION[13] ⍝ Repeat until EXIT[14] →LOOP[15] ⍝ Tell user ...[16] ERR:MESSAGE'Unexpected error in',OPTION[17] ⍝ ... what's happening[18] MESSAGE'Removing from list'[19] ⍝ Remove option from list[20] OPTIONS←OPTIONS~⊂OPTION[21] ⍝ And repeat[22] →LOOP[23] ⍝ End[24] END:

Page 307
                        

Chapter 4: Error Trapping 303
 ∇ BUG[1] ⍝ Called whenever there is an unexpected error[2] '*** UNEXPECTED ERROR OCCURRED IN: ',⊃1↓⎕SI[3] '*** PLEASE CALL YOUR SYSTEM ADMINISTRATOR'[4] '*** WORKSPACE SAVED AS BUG.',⊃1↓⎕SI[5] ⍝ Tidy up ... reset ⎕LX, untie files ... etc[6] ⎕SAVE 'BUG.',⊃1↓⎕SI[7] '*** RETURNING TO DRIVER FOR RESELECTION'[8] ⎕SIGNAL 500
 ∇
 Now when the unexpected error occurs, the first trap specification catches it, and theBUG function is executed in place. Instead of logging the user off as before, anerror 500 is signalled to APL. APL checks its trap specifications, sees that 500has been set in REPORT as a cut-back, so cuts back to REPORT before branching toERR.
 Flow ControlError handling, which employs a combination of all the system functions and var-iables described, allows us to dynamically alter the flow of control through our sys-tem, as well as allow us to handle errors gracefully. It is a very powerful facility,which is simple to use, but is often neglected.
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